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ΕΙΣΑΓΩΓΗ 
 
Το πρώτο κεφάλαιο της πτυχιακής εργασίας αναφέρεται στα εικονικά μουσεία 
που έχουν δημιουργηθεί ως τώρα. Αναλύει τι ορίζεται ως εικονικό μουσείο και 
ποια ανάγκη οδήγησε στη δημιουργία του. Γίνεται μια σύγκριση των ήδη 
υπαρχόντων εικονικών μουσείων, των μεθόδων με τις οποίες έχουν 
δημιουργηθεί και της αποτελεσματικότητας των μεθόδων αυτών. Μέσα από τη 
σύγκριση και την κατηγοριοποίηση των διάφορων μεθόδων, παρατηρούνται οι 
αιτίες οι οποίες κάνουν ένα μουσείο ελκυστικό στο κοινό.  

 

Στο δεύτερο κεφάλαιο της εργασίας περιγράφονται αναλυτικά τα βήματα και οι 
λειτουργίες του λογισμικού 3d Som που προτείνονται από τον κατασκευαστή. 
Το πρόγραμμα αυτό αναφέρεται στην διαδικασία που πρέπει να ακολουθηθεί 
για την τρισδιάστατη μοντελοποίηση ενός αντικειμένου, πανομοιότυπου με το 
πραγματικό. 

 

Στη συνέχεια αναλύονται τα προγράμματα Panoweaver και Tourweaver που 
χρησιμοποιήθηκαν για την δημιουργία πανοραμικών εικόνων και για την 
ολοκλήρωση της εικονικής περιήγησης του χώρου που έχει επιλεχθεί. Έτσι 
γίνεται αντιληπτό ότι η χρήση ηλεκτρονικού υπολογιστή θεωρείται απαραίτητη 
καθώς απαιτείται η λήψη, και η επεξεργασία ψηφιακών φωτογραφιών.  

 

Στο τελευταίο κεφάλαιο της εργασίας περιγράφονται τα βήματα τα οποία 
ακολουθήθηκαν για την εφαρμογή της προσομοίωσης του Βυζαντινού 
Μουσείου Χανίων ενώ παράλληλα παρουσιάζεται το αποτέλεσμα της 
εικονικής περιήγησης που δημιουργήθηκε.   
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ΚΕΦΑΛΑΙΟ 1: 

ΕΙΚΟΝΙΚΟ ΜΟΥΣΕΙΟ 
 

1.1. Εικονική πραγματικότητα (virtual reality) 
 
Μία από τις σημαντικότερες αισθήσεις του ανθρώπου θεωρείται ότι είναι αυτή 
της όρασης. Από την πρώτη στιγμή της γέννησής του ο άνθρωπος μπορεί να 
αντιλαμβάνεται τον κόσμο γύρω του μέσω της όρασης. Χρόνια τώρα 
χρησιμοποιούσαμε την όρασή μας για να παρακολουθήσουμε και να 
βιώσουμε τα αντικείμενα που βρίσκονταν στον “πραγματικό”, υλικό κόσμο 
στον οποίο ζούμε. Με την εξέλιξη όμως της επιστήμης αυτό άρχισε να 
αλλάζει. Ένας νέος κόσμος γεννιέται σιγά σιγά . Μέσα σε αυτόν τον κόσμο 
μπορούμε να περπατήσουμε, να δούμε πράγματα, ακόμη και να 
αλληλεπιδράσουμε(interactivity) με αυτά. Αυτή τη φορά όμως ο κόσμος αυτός 
δεν είναι απτός, υλικός είναι εικονικός. 

Ο εικονικός κόσμος ή εικονική πραγματικότητα όπως συχνότερα αποκαλείται 
το φαινόμενο αυτό, δημιουργήθηκε  και εξελίσσεται συνεχώς με τη βοήθεια 
των ηλεκτρονικών υπολογιστών, οι οποίοι τα τελευταία χρόνια έχουν 
αλματώδη ανάπτυξη και τρομακτικές υπολογιστικές δυνατότητες. Η εικονική 
πραγματικότητα μπορεί να οριστεί ως ένας τρισδιάστατος χώρος στον οποίο 
βιώνει κάποιος διάφορες καταστάσεις ή αλληλεπιδράει με κάποια αντικείμενα 
μέσω ενός Η/Υ. Ολόκληρο το περιβάλλον που βιώνει ο χρήστης είναι 
κατασκευασμένο στον Η/Υ μέσα από διάφορα προγράμματα και μεταφέρεται 
στο χρήστη με τη βοήθεια οπτικών μέσων όπως ειδικές οθόνες, τρισδιάστατα 
γυαλιά, ειδικά γάντια και άλλες συσκευές. 

Η εικονική πραγματικότητα έχει πολλές χρήσεις στις μέρες μας. Μπορεί να 
ψυχαγωγήσει, να πληροφορήσει, να εκπαιδεύσει, ανάλογα πάντα με το 
λογισμικό που χρησιμοποιείται. Με τον τελευταίο ρόλο της, αυτού της 
εκπαίδευσης, θα ασχοληθούμε στην παρούσα εργασία. 

 

Σχήμα .11

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Παράδειγμα 
εικονικής 

πραγματικότητας
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1.2. Εικονικό μουσείο 
 
Το μουσείο όπως το ξέρουμε ως τώρα, είναι ένας χώρος έκθεσης συλλογών 
αντικειμένων αρχαιολογικής ή άλλης καλλιτεχνικής φύσεως με σκοπό την 
εκπαίδευση, τη μόρφωση και την καλλιτεχνική τέρψη του επισκέπτη. 
Δυστυχώς όμως δεν είναι όλα τα μουσεία το ίδιο ελκυστικά για τον καθένα μας 
είτε λόγω της στατικότητας των εκθεμάτων είτε λόγω της απόστασής μας από 
αυτά ή τέλος εξαιτίας του γεγονότος ότι τα μουσεία λόγω περιορισμένου 
χώρου εκθέτουν ένα μικρό μόνο μέρος των συχνά τεράστιων συλλογών τους 
(περίπου ένα 15-20%). Για το λόγο αυτό πολλοί οργανισμοί μουσείων 
παράλληλα και με την εξάπλωση του διαδικτύου και την εξέλιξη της εικονικής 
πραγματικότητας αποφάσισαν να ψηφιοποιήσουν ένα μέρος των συλλογών 
τους και να το διαθέσουν προς έκθεση στις ιστοσελίδες τους με στόχο την 
καλύτερη ενημέρωση του κοινού, την μεγαλύτερη διαφήμιση του μουσείου, 
την ευαισθητοποίηση του κοινού σε πολιτιστικά θέματα ή για εκπαιδευτικούς 
λόγους. Έτσι δημιουργείται το εικονικό μουσείο το οποίο δεν είναι τίποτε άλλο 
παρά η έκθεση αντικειμένων και πληροφοριών σε ένα εικονικό τρισδιάστατο ή 
ψευδό-τρισδιάστατο περιβάλλον. 

1.3. Παραδείγματα εικονικών μουσείων 
 
Μέσα από την έρευνά μας στο διαδίκτυο, συναντήσαμε πολλές ιστοσελίδες 
εικονικών μουσείων δημιουργημένων από γνωστά ή μη συμβατικά μουσεία. 
Σε πολλά όμως από αυτά τα αποκαλούμενα εικονικά μουσεία συγχέεται ο 
ορισμός για το εικονικό μουσείο που δώσαμε παραπάνω αφού πολλά από 
αυτά δεν αποτελούν τίποτα περισσότερο από μία συλλογή πληροφοριών και 
φωτογραφιών των εκθεμάτων που παρουσιάζονται σε αυτά. Αναλυτικότερα 
παρουσιάζουμε τις ιστοσελίδες μερικών από αυτά.  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα α1.3.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΜουσείο 

Μεξικό
DIEGO RIVERA 

 
                http://www.diegorivera.com/index.php 
Αν και στις μηχανές αναζήτησης αναφέρεται ως virtual μουσείο, στην ουσία 
χρησιμοποιεί μία ψευδό-τρισδιάστατη τεχνική απεικόνισης των έργων του 
ζωγράφου Diego Rivera κάνοντας χρήση των προγραμμάτων quicktime και 
flash. Με τα προγράμματα αυτά τα έργα απεικονίζονται ως συνεχόμενες 
φωτογραφίες ιδωμένες από ένα σταθερό σημείο πράγμα το οποίο αφήνει 
στον επισκέπτη μία αίσθηση του τρισδιάστατου. 
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 1.3.β

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΜουσείο σύγχρονης τέχνης,

Ιαπωνία
 

http://www.haramuseum.or.jp 
Και αυτό το μουσείο ενώ αναφέρεται ως virtual, χρησιμοποιεί το πρόγραμμα 
flash μέσω του browser μας ώστε να δώσει μια κινητικότητα στην ιστοσελίδα 
παρά για την απόδοση κάποιων τρισδιάστατων γραφικών. 

 

Λούβρο, Γαλλία 
http://mistral.culture.fr/louvre/louvrea.htm 
Το γνωστό αυτό μουσείο χρησιμοποιεί τεχνική ψευδό-απεικόνισης μέσω του 
προγράμματος quicktime για την προβολή ενός αρκετά μεγάλου αριθμού 
εκθεμάτων από χαρακτηριστικές ιστορικές περιόδους. Ο επισκέπτης 
παρακολουθεί μια ενιαία φωτογραφία με προοπτική 360 μοιρών. Το αρνητικό 
και εδώ είναι ότι παρακολουθούμε τα δρώμενα από ένα σταθερό, 
καθορισμένο σημείο αφού το πρόγραμμα quicktime δε μας αφήνει τη 
δυνατότητα κίνησης αλλά μόνο περιστροφής κατά 360 μοίρες. 

 

Μουσείο επιστημών Da Vinci, Ιταλία 
http://www.museoscienza.org/english/index.html 
Στο μουσείο αυτό γίνεται πραγματική χρήση τρισδιάστατου περιβάλλοντος 
αφού παρουσιάζεται μία ιδεατή πόλη της Αναγέννησης σύμφωνα με σχέδια 
του Ιταλού επιστήμονα της Αναγέννησης Leonardo Da Vinci. Ο επισκέπτης 
καλείται να πλοηγηθεί σε πραγματικό χρόνο στους δρόμους του 
τρισδιάστατου μοντέλου της πόλης, να συνομιλήσει με άλλους επισκέπτες, 
ακόμη και να ξεναγηθεί από ειδικούς τρισδιάστατους ξεναγούς. Το project 
αυτό έχει υλοποιηθεί από το μουσείο σε συνεργασία με το Πολυτεχνείο του 
Μιλάνου ενώ κάνει χρήση της Virtual Reality Modeling Language (VRML). Η 
VRML είναι μία ευρέως διαδεδομένη γλώσσα η οποία κωδικοποιεί 
τρισδιάστατα δεδομένα αρκετά εύκολα και τα παρουσιάζει με τη βοήθεια 
κατάλληλου plug-in στον επισκέπτη μέσω του Internet browser του. Κατά την 
πλοήγησή μας σε χώρους ή αντικείμενα κατασκευασμένα με VRML έχουμε 
πλήρη ελευθερία κινήσεως κατά το καρτεσιανό σύστημα συντεταγμένων που 
ορίζει το χώρο, το οποίο σημαίνει στη συγκεκριμένη περίπτωσή ότι έχουμε τη 
δυνατότητα να ‘’περπατήσουμε’’ μέσα στην ιδεατή πόλη του Da Vinci ή να την 
παρατηρήσουμε “πετώντας” πάνω από αυτή. Ως αυτή τη στιγμή που γράφεται 
αυτή η εργασία η VRML είναι ο πιο διαδεδομένος τρόπος παρουσίασης 
τρισδιάστατων γραφικών σε πραγματικό χρόνο στο Internet. 
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Σχήμα1.3.γ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αεροπλάνο 
και 

γραφομηχανή

 
                         

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα δ1.3.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΜουσείο θεωρητικού 

Αγγλία
H.M.S

Belfast, 
 

 
    http://www.hmsbelfasttours.org.uk 
Το μουσείο αυτό θεωρείται ως ζωντανό εφόσον βρίσκεται πάνω στο πολεμικό 
πλοίο του Δευτέρου Παγκοσμίου Πολέμου το οποίο έχει πια παροπλιστεί και 
είναι ανοιχτό στο κοινό. Η καταχώρησή του ως virtual μουσείου έγκειται στο 
γεγονός ότι παρουσιάζει στο χρήστη με τη βοήθεια των προγραμμάτων flash 
και java χώρους από το εσωτερικό του πλοίου, παρόμοια με το πρόγραμμα 
quicktime στο μουσείο του Λούβρου. Εδώ ο επισκέπτης καλείται να επιλέξει 
ένα κατάστρωμα του πλοίου καθώς και ένα τμήμα σε αυτό και στη συνέχεια 
περιεργάζεται το χώρο αυτό σε ένα ισομετρικό περιβάλλον αλλά παρόλα αυτά 
καθηλωμένος σε ένα δεδομένο σημείο. Η αίσθηση του τρισδιάστατου χώρου 
που δίνεται είναι αρκετά καλή σε αυτό το virtual μουσείο. 

              
Σχήμα1.3.ε

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

  Κορεατικό 
ίδρυμα τεχνών 
και πολιτισμού, 

Κορέα 
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             http://www.kcaf.or.kr/ehome3/english/vrml/index.html 
Στην ιστοσελίδα αυτού του ιδρύματος έχουμε την δυνατότητα να 
παρακολουθήσουμε μία αναπαράσταση ενός κινεζικού τάφου του 550 μ.Χ. 
δημιουργημένου με VRML. Ο επισκέπτης μπορεί να περπατήσει εικονικά 
μέσα στον τάφο καθώς και να περιεργαστεί τις textured τοιχογραφίες που 
βρίσκονται σε αυτόν. Παράλληλα στην υπόλοιπη ιστοσελίδα μαθαίνει για την 
ιστορία του τάφου και των τοιχογραφιών που βρέθηκαν σε αυτόν. 
Παρατηρούμε ότι η VRML χρησιμοποιείται όχι μόνο για την αναπαράσταση 
ολόκληρων πόλεων αλλά και για εργασίες σαν και αυτήν που είδαμε 
παραπάνω. 

                                                                                                                                          

            
Σχήμα1.3.ζ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

  Μουσείο 
φυσικής ιστορίας 

Βερολίνου, 
Γερμανία

       
        
            http://www.museum.hu-berlin.de 

 
Στο virtual μέρος του μουσείου αυτού μπορούμε να παρατηρήσουμε 
τρισδιάστατες αναπαραστάσεις ζώων και απολιθωμάτων που έχουν 
εξαφανιστεί εδώ και χιλιετίες. Η γλώσσα που χρησιμοποιείται είναι και εδώ η 
VRML. Η διαφορά είναι ότι ο επισκέπτης παρατηρεί τα αντικείμενα όχι μέσα 
σε κάποιον τρισδιάστατα κατασκευασμένο χώρο αλλά μέσα στο “κενό” ώστε 
να έχει μια πιο άμεση εποπτεία αυτών. Το project αυτό έγινε με τη συνεργασία 
του Πανεπιστημίου Humboldt του Βερολίνου. 
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Σχήμα1.3.η

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

α)Απολιθωμένος 

β) Απολιθωμένος 
Τριλοβίτης

«Αρχιμήδης»
α

β

 
Τέλος, εκτός από τα γνωστά συμβατικά μουσεία, εικονικές συλλογές 
παρουσιάζονται και αυτόνομα στο Internet, με τη μορφή virtual εκθέσεων 
όπως στην ιστοσελίδα “Trenches on the web” (www.worldwar1.com/vrml.htm) 
όπου παρουσιάζονται με τη βοήθεια VRML αναπαραστάσεις πολεμικών 
μηχανών και πλοίων του Πρώτου και του Δευτέρου Παγκοσμίου Πολέμου, 
στην ιστοσελίδα του Μητροπολιτικού Πανεπιστημίου του Manchester (MMU) 
 
(www.doc.mmu.ac.uk/RESEARCH/virtual-museum) 
όπου παρουσιάζεται μία αναπαράσταση ενός αιγυπτιακού τάφου και μία μίας 
αρχαίας αιγυπτιακής πόλης, πάλι σε μορφή VRML αρχαίας αιγυπτιακής 
πόλης όπως επίσης και σε ιστοσελίδες εταιρειών όπως η ιαπωνική Toucan 

Σχήμα1.3.θ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

α)Αναπαράσταση 
με τη μορφή 
β)Αιγυπτιακός 

τάφος

VRML

α

β

 
  
(www.toucan.co.jp/indexE.html) με τη συλλογή της από αντικείμενα σε VRML 
και η IBM η οποία παρουσιάζει το virtual μουσείο της σε ψευδο-τρισδιάστατο 
περιβάλλον κάνοντας χρήση του προγράμματός της IBM Hotmedia. 
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Σχήμα .ι1.3

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Εικονικό μουσείο

 
 
Ιστοσελίδες εικονικών μουσείων και τεχνικές τρισδιάστατης απεικόνισης που 

χρησιμοποιούν 

Ιστοσελίδα χώρα 
τεχνική 

απεικόνισης
www.ieee-virtual-museum.org 
  ΗΠΑ 

quicktime, 
flash 

http://talent.csufresno.edu/VR 
  ΗΠΑ quicktime 
http://mistral.culture.fr/louvre/louvrea.htm 
  Γαλλία quicktime 
http://www.museoscienza.org/english/index.html 
  Ιταλία VRML 
http://www.uni-
kassel.de/hrz/anwendungen/matthias/hrz-
info/vrml/museum.html 
  Γερμανία VRML 
http://www.kcaf.or.kr/ehome3/english/vrml/index.html
  Κορέα VRML 
http://www.olgafilippova.com 
  Ρωσσία VRML 
http://www.museum.hu-berlin.de vrml 
  Γερμανία VRML 
http://www.worldwar1.com/vrml.htm 
  Γερμανία VRML 
http://www.nhm.ac.uk/interactive/vrml 
  Αγγλία VRML 
http://www.hmsbelfasttours.org.uk 
  Αγγλία java, flash 
http://www.metmuseum.org 
  ΗΠΑ 

IBM 
Hotmedia 

http://www.doc.mmu.ac.uk/RESEARCH/virtual-
museum 
  Αγγλία VRML 
http://www.haramuseum.or.jp 
  Ιαπωνία flash 
 http://www.diegorivera.com/index.php 
  Μεξικό 

quicktime, 
flash 
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1.4. Δημιουργία εκθεμάτων εικονικού μουσείου 
 
Σε ένα εικονικό μουσείο γίνεται συνήθως παρουσίαση κάποιας συλλογής 
ψηφιοποιημένων αρχαιοτήτων ή καλλιτεχνημάτων ή γενικότερα αντικειμένων 
της πολιτιστικής μας κληρονομιάς, τα οποία εκθέτονται προς προβολή και 
ανάδειξή τους. 

Ψηφιοποίηση ενός μνημείου μπορεί να οριστεί η ακριβής αποτύπωση και 
καταγραφή των γεωμετρικών χαρακτηριστικών του µε τρόπο ώστε να 
αναπαρίσταται αξιόπιστα η γεωμετρική μορφή και θέση του στο χώρο µε τη 
χρήση διαγραμμάτων και δισδιάστατων απεικονίσεων αλλά και τρισδιάστατων 
εικονικών μοντέλων στη μνήμη αλλά και στη οθόνη ενός Η/Υ. Η ψηφιοποίηση 
της πολιτιστικής μας κληρονομιάς παίζει σημαντικότατο ρόλο στην εποχή μας 
τόσο από την άποψη της ανάδειξής τους παγκοσμίως όσο και για τη μελέτη 
και αποκατάσταση αυτών σε περιπτώσεις φυσικών καταστροφών ή 
διαβρώσεων τους. Ένας άλλος σημαντικότατος τομέας στον οποίο συμβάλλει 
η ψηφιοποίηση αυτών των αντικειμένων είναι η εκπαίδευση αφού με τη 
βοήθεια του διαδικτύου φέρνουμε πιο κοντά όσο ποτέ τα διάφορα μουσεία 
στα σχολεία όλης της χώρας, όσο απομακρυσμένα και αν είναι αυτά. 

 

Η πολιτιστική μας κληρονομιά μπορεί να χωριστεί χονδρικά σε δύο τμήματα 
ανάλογα με το μέγεθος και τη δυνατότητα ψηφιοποίησής τους. Έτσι 
διακρίνουμε τα κινητά και τα ακίνητα αντικείμενα. Στη δεύτερη κατηγορία 
ανήκουν τα διάφορα μνημεία όπως για παράδειγμα ο Παρθενώνας, τα οποία 
δεν είναι δυνατόν να μετακινηθούν με αποτέλεσμα να πρέπει να 
ψηφιοποιηθούν επιτόπου. Η κατηγορία αυτή απαιτεί κοπιαστικές, χρονοβόρες 
και πολυδάπανες εργασίες για την όσο το δυνατόν ακριβέστερη τρισδιάστατη 
αποτύπωσή τους. Στην πρώτη κατηγορία με την οποία και θα ασχοληθούμε, 
ανήκει οποιοδήποτε αντικείμενο συνήθως ανθρώπινης δημιουργίας, το οποίο 
μπορεί να μετακινηθεί στο εργαστήριο με σκοπό τη μελέτη και την εκεί 
ψηφιοποίησή του. Τα αντικείμενα αυτά σαρώνονται με τη βοήθεια ειδικών 
συσκευών με στόχο τη δημιουργία ενός αυθαίρετα μεγάλου νέφους σημείων 
τα οποία αναπαριστούν σε ηλεκτρονική μορφή τις επιφάνειες του αντικειμένου 
(α). Το νέφος αυτό στη συνέχεια περνάει από ειδικά φίλτρα ώστε να 
εξαλειφθούν τυχόν πλεονάζοντα ή εσφαλμένα σημεία και τέλος επεξεργάζεται 
στον Η/Υ με τη βοήθεια κατάλληλων προγραμμάτων τρισδιάστατης 
μοντελοποίησης. 

 

Κατά την επεξεργασία του νέφους στον Η/Υ, αυτό μετατρέπεται συνήθως από 
σημεία στο χώρο σε ένα πλέγμα από πολύγωνα, τα οποία αποτελούνται από 
μικρά τρίγωνα σχηματιζόμενα το καθένα από τρία σημεία του νέφους (β). 
Πάνω στο πολυγωνικό πλέγμα τοποθετείται τέλος ένα στρώμα το οποίο 
περιέχει την χρωματική πληροφορία (πληροφορία υφής) εάν αυτό θεωρηθεί 
απαραίτητο (γ), (δ), όπως για παράδειγμα σε ένα μελανόμορφο αγγείο. 
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Σχήμα1.4

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗ ΜΑ

ΦΥΣΙΚ ΩΝ  Π Ο ΡΩΝ  &  Π ΕΡΙΒ Α ΛΛΟ Ν ΤΟ Σ
ΕΡΓΑ ΣΤΗ ΡΙΟ

ΣΧΕΔ ΙΟ ΜΕΛΕΤΗ Σ  &  Κ ΑΤΕΡΓΑ Σ ΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

1)
2)
3)

4)

νέφος σημείων
 πολυγωνικό πλέγμα
τεχνητή φωτοσκίαση 

πλέγματος 
Πολυγωνικό πλέγμα 

με πληροφορίες υφής

1

2

3

4
 

  
 

1.4.1. Τρόποι σάρωσης αντικειμένων 
 
Υπάρχουν πάρα πολλές μέθοδοι για να σαρωθεί ένα κινητό αντικείμενο όπως 
υπάρχουν και πολλοί τρόποι διαχωρισμών αυτών των μεθόδων. Ο πρώτος 
και κύριος τρόπος διαχωρισμού τους είναι η διάκρισή τους σε: 

 Παθητικές μέθοδοι τρισδιάστατης ψηφιοποίησης: γίνεται συνήθως 
χρήση του περιβάλλοντος φωτισμού και τα μόνα χαρακτηριστικά τα 
οποία αποτυπώνονται είναι αυτά που είναι εμφανή σε ψηφιακές 
εικόνες.  

 Ενεργητικές μέθοδοι τρισδιάστατης ψηφιοποίησης: οι μέθοδοι αυτοί 
κάνουν χρήση της τεχνολογίας των ακτινών λέιζερ κοντινών 
αποστάσεων αποτυπώνοντας τις παραμορφώσεις που δέχεται η 
δέσμη φωτός καθώς ανακλάται πάνω σε επιφάνειες. Με τον τρόπο 
αυτό δημιουργείται ένα πυκνό νέφος σημείων. Στην εικόνα 
παρουσιάζονται οι επικρατέστερες τεχνικές σάρωσης οι περισσότερες 
από τις οποίες έχουν εφαρμοστεί στην αποτύπωση κινητών 
πολιτιστικών αντικειμένων. 

 Ένας άλλος τρόπος διαχωρισμού τεχνικών ψηφιοποίησης είναι το 
μέγεθος του προς ψηφιοποίηση αντικειμένου. Μιλάμε πάντα για κινητά 
αντικείμενα αλλά στην ουσία αυτά χωρίζονται σε μικροσκοπικά, μικρά, 
μεσαία και μεγάλα και με αυτό το διαχωρισμό κατηγοριοποιούμε και τις 
τεχνικές ψηφιοποίησης.  

  

1.4.2. Τεχνικές ψηφιοποίησης μικροσκοπικών αντικειμένων 
 
Με την εξέλιξη της τεχνολογίας είναι πλέον δυνατόν να εξάγουμε πληροφορία 
από αντικείμενα πολύ μικρά σε μέγεθος. Έτσι με μεθόδους όπως η “Atomic 
Force Microscopy” και η “Stereo Scanning Electron Microscopy” μας 
επιτρέπεται η αναγνώριση και η καταγραφή χαρακτηριστικών σε κλίμακα 
μερικών δεκάδων νανόμετρων. Επιπλέον αν θέλουμε ακόμη μεγαλύτερη 
ακρίβεια, τεχνικές όπως η “Confocal Microscopy” και η “White Light Scanning 
Interferometry”. Το μειονέκτημα τέτοιων μεθόδων είναι πως οι συσκευές που 
χρησιμοποιούνται έχουν κατασκευαστεί ειδικά για τόσο μικρές διαστάσεις και 
δεν έχουν δυνατότητα σάρωσης μεγαλύτερων επιφανειών. Στην 
πραγματικότητα βέβαια τέτοιου βαθμός ακρίβειας έχει αμφιλεγόμενη χρήση 
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αλλά σε περιπτώσεις που χρειαζόμαστε πραγματικά μεγάλη ακρίβεια, 
κάνουμε χρήση αυτών των τεχνικών. 

Από τις τεχνικές που αναφέρθηκαν, η τεχνική της Stereo Scanning Electron 
Microscopy είναι µάλλον περιορισμένης εφαρμογής αφού τα δείγματα πρέπει 
να εισαχθούν σε ειδικούς χώρους υπό συνθήκες κενού και απαιτείται ειδική 
προετοιμασία, συνήθως επικάλυψη µε μέταλλο, πράγμα απαγορευτικό γιατί 
τα αντικείμενα που μελετούμε είναι ανεκτίμητης αξίας και δε θα πρέπει να 
πάθουν το παραμικρό.  

 

Η τεχνική Confocal Microscopy είναι κυρίως «βιολογική τεχνική» και δίνει το 
καλύτερο αποτέλεσμα όταν χρησιμοποιείται σε συνδυασμό µε τεχνικές όπως 
φθορισμός. Δίνει ικανοποιητικά αποτελέσματα για ημιδιάφανα αντικείμενα και 
επιτρέπει την καταγραφή εσωτερικής πληροφορίας. Θα μπορούσε να είναι 

περιορισμένης χρήσης στην παρατήρηση διάφανων αντικειμένων. Επίσης, 
είναι δυνατή η σκιαγράφηση επιφάνειας π.χ. για την ψηφιοποίηση 
επιφανειακής υφής, έχοντας το πλεονέκτημα ότι είναι μια τεχνική που δε 
στηρίζεται σε επαφή µε τα αντικείμενα. 

Τη σκιαγράφηση επιφάνειας μπορεί επίσης να παρέχει και η τεχνική White 
Light Scanning Interferometry και μάλιστα µε σημαντικά μικρότερο κόστος. 
Συστήματα όπως το Veeco RST επιτρέπουν τη μέτρηση τρισδιάστατων 
επιφανειών σε κλίμακα κάτω του μικρομέτρου και θα μπορούσαν να 
χαρακτηριστούν ιδιαίτερα χρήσιμα για την επισταμένη μελέτη επιφανειών. Η 

τεχνική είναι χωρίς επαφή και δεν απαιτείται κάποια ιδιαίτερη επιφανειακή 
προετοιμασία. 

Η τεχνική Atomic Force Microscopy είναι η νεότερη στην κατηγορία των 
τεχνικών μικροσκοπικής κλίμακας και, ενώ υπάρχουν διαθέσιμα εμπορικά 
συστήματα, είναι ακόμη στη φάση σημαντικής ανάπτυξης. Η βασική αρχή 
είναι στη χρήση ενός πάρα πολύ μικρού μετρητικού συστήματος µε μέγεθος 
που δεν ξεπερνά τα δέκα άτομα το οποίο φέρεται πάρα πολύ κοντά στην 
επιφάνεια προς μέτρηση χωρίς όμως να υπάρχει επαφή. Ενδο-ατομικές 
δυνάμεις έλκουν το σύστημα προς την επιφάνεια. Το μικροσκόπιο μπορεί να 
ανιχνεύσει το σύστημα μέτρησης στην κίνησή του κατά μήκος και πλάτος 
πάνω στην επιφάνεια που μετράται και να ρυθμίσει την απόστασή του από 
αυτήν µέσω της μέτρησης της δύναμης έλξης που ασκείται. Με τον τρόπο 
αυτό μετράται μια επιφάνεια µέσω της μέτρησης της ελκτικής δύναμης. Η 
μέθοδος μπορεί να παρέχει πολύ μεγάλη ακρίβεια (απαιτώντας, βέβαια, 
ιδιαίτερη επιδεξιότητα χειρισμού) που μπορεί να φτάσει κάτω του ενός 
νανόμετρου σε ειδικές περιπτώσεις.  

Τέλος, συνοπτικά τα μειονεκτήματα των παραπάνω μεθόδων είναι τα εξής: 

 μετράνε πολύ μικρές επιφάνειες ή μικρά δείγματα από τα αντικείμενα 

  είναι αρκετά σύνθετες και απαιτούν γνώσεις, εξειδίκευση και 

  ενώ ο εξοπλισμός είναι μεταφερόμενος απαιτούνται ιδιαίτερα ελεγχόμενες 
συνθήκες μέτρησης (π.χ. θερμοκρασία, υγρασία). 
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1.4.3. Τεχνικές ψηφιοποίησης μικρών αντικειμένων 
 
Ως μικρά αντικείμενα χαρακτηρίζουμε εδώ αντικείμενα έως 100x100 χιλιοστών 
(10x10 εκατοστά). Στην κατηγορία αυτή οι αδιαμφισβήτητα προτιμητέες 
τεχνικές είναι αυτές που βασίζονται σε συστήματα τριγωνοποίησης ακτίνων 
laser ενώ υπάρχει σήμερα πληθώρα τέτοιων εμπορικά διαθέσιμων 
συστημάτων. Η βασική αρχή λειτουργίας είναι σχετικά απλή: μια σημειακή 
πηγή laser στοχεύει την επιφάνεια προς μέτρηση και ανιχνεύεται από έναν 
οπτικό αισθητήρα. Καθώς το laser μετακινείται πάνω στην επιφάνεια, συναντά 
διαφορετικά ύψη. Αυτά τα μεταβαλλόμενα ύψη αλλάζουν την ανάκλαση του 
laser στον οπτικό αισθητήρα. Η βαθμονόμηση µε χρήση προ-τυποποιημένων 
διαβαθμίσεων ύψους για την αναγνώριση της σχέσης μεταξύ της μεταβολής 
στο επιφανειακό ύψος και της θέσης της ακτίνας είναι συνήθως εμπειρική. Με 
δεδομένο ότι η προς μέτρηση περιοχή περιορίζεται σε 100x100mm τα 
συστήματα αυτά επιτυγχάνουν μια ακρίβεια μέτρησης της τάξης μερικών 
μικρομέτρων. Παρόλα αυτά, εάν η επιφάνεια του αντικειμένου είναι 
μεγαλύτερη, τότε η ακρίβεια μέτρησης μειώνεται, και μάλιστα πολλές φορές 
σημαντικά. Τέτοια συστήματα είναι χρήσιμα για τη μέτρηση αντικειμένων 
όπως νομίσματα, εγχάρακτες ή ανάγλυφες ταμπέλες και μικρά αντικείμενα 
χρυσοχοΐας. Είναι συνήθως φορητά, σχετικώς φθηνά και ευρέως διαθέσιμα. 

1.4.4. Τεχνικές ψηφιοποίησης αντικειμένων μεσαίου μεγέθους 
 
Στην κατηγορία αυτή έχουμε τα πιο ενδιαφέροντα πολιτιστικά αντικείμενα, και 
τις περισσότερες μεθόδους ψηφιοποίησης. Τα αντικείμενα είναι διαστάσεων 
άνω των 10 εκατοστών και μπορεί να φτάνουν έως και 1 µε 2 μέτρα. Εδώ 
περιλαμβάνονται και αγάλματα φυσικού μεγέθους. 

Τα πλέον χρησιμοποιούμενα συστήματα στην κατηγορία αυτή χρησιμοποιούν 
τεχνικές «δομημένου φωτισμού». Η λειτουργίας τους βασίζεται σε μια 
επέκταση της αρχής της τριγωνοποίησης. Η διαφορά είναι ότι η σημειακή 
πηγή έχει πλέον αντικατασταθεί από ένα δισδιάστατο μοτίβο φωτός το οποίο 
προβάλλεται στην προς μέτρηση επιφάνεια. Διάφορες είναι οι μέθοδοι 
παραγωγής αυτού του μοτίβου φωτός, άλλοτε µε τη συμβολή φωτός από 
πηγή laser και άλλοτε µε απλή προβολή του μοτίβου µε φωτογραφική μέθοδο. 

Συνήθως γίνεται χρήση ενός μοτίβου, το οποίο μετακινείται πάνω στην 
επιφάνεια του αντικειμένου για να επιτευχθεί η συνολική μέτρησή του. 
Υπάρχουν όμως και τεχνικές που χρησιμοποιούν πολλαπλά μοτίβα καθώς και 
τεχνικές Moiré. Το σημαντικό όμως σημείο εδώ είναι ότι µε οποιονδήποτε 
τρόπο και εάν παράγονται τα μοτίβα φωτός η διαδικασία ανίχνευσης και 
ανάλυσής τους είναι η ίδια. Ένα σύνηθες μοτίβο δεν αποτελείται από δύο 
απλές καταστάσεις τύπου on/off αλλά, τις περισσότερες φορές, από 
ημιτονοειδείς μεταβάσεις. Το σημαντικό εδώ είναι ότι καθίσταται δυνατός ο 
καθορισμός της θέσης όπου παρατηρούνται τα μέγιστα των μοτίβων 
οδηγώντας σε βελτίωση της ακρίβειας της μέτρησης, παρέχοντας τη 
δυνατότητα εντοπισμού σε τμήμα μικρότερο ενός κροσσού συμβολής του 
μοτίβου. Εμπορικά, τα συστήματα αυτά είναι ικανά να επιτύχουν ακρίβεια 
μέτρησης περί το 1/100 των διαστημάτων μεταξύ των κροσσών του μοτίβου. 
Έτσι εάν το διάκενο αυτό είναι για παράδειγμα 1 cm τότε η αναμενόμενη 
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ακρίβεια μέτρησης είναι της τάξης του 0,1 mm. Τα συστήματα αυτά βασίζονται 
συνήθως σε µία από δύο βασικές αρχές λειτουργίας: είτε µε χρήση 
μετασχηματισμού Fourier, είτε µε χρονική μετατόπιση φάσης. Κάθε 
προσέγγιση έχει τα πλεονεκτήματα και τους υποστηρικτές της. Τα 
περισσότερα εμπορικά συστήματα αυτής της κατηγορίας βασίζονται στη 
χρονική μετατόπιση φάσης, καθώς η τεχνική αυτή έχει αναλυθεί σημαντικά σε 
ερευνητικό επίπεδο και είναι σε μερικές περιπτώσεις ευκολότερη στην 
εφαρμογή της έναντι της άλλης μεθόδου. Ένα από τα σημαντικότερα 
χαρακτηριστικά των τεχνικών στην κατηγορία αυτή είναι ότι σε γενικές 
γραμμές η ακρίβειά τους είναι κλιμακούμενη. Αυτό σημαίνει ότι τείνουν να 
μετρούν µε μεγαλύτερη ακρίβεια τα μικρά από ότι τα μεγάλα αντικείμενα. Για 
τα περισσότερα συστήματα το χαρακτηριστικό αυτό είναι συνυφασμένο µε τον 
τρόπο που σχεδιάστηκαν. Περιορισμοί στην ακρίβειά τους πηγάζουν από το 
γεγονός ότι μια ψηφιακή εικόνα του μοτίβου φωτός έχει περιορισμένο εύρος 
ζώνης. Το εύρος αυτό ορίζεται από την ανάλυση που παρέχει το οπτικό 
αισθητήριο που χρησιμοποιεί το εκάστοτε σύστημα και το βάθος χρώματος µε 
το οποίο ψηφιοποιείται η εικόνα. Βασικά, όσο μεγαλύτερο το πλήθος των 
εικονοστοιχείων στον οπτικό αισθητήρα τόσο καλύτερη η ανάλυση και τόσο 
μικρότερο μπορεί να είναι το διάκενο μεταξύ των κροσσών του μοτίβου για 
δεδομένο μέγεθος αντικειμένων. Καθώς η ακρίβεια των συστημάτων είναι 
στενά δεμένη µε το μέγεθος των κροσσών του μοτίβου, μικρότεροι κροσσοί 
οδηγούν σε μεγαλύτερη ακρίβεια. επίσης καθώς το βάθος χρώματος 
ψηφιοποίησης μεγαλώνει γίνεται όλο και μεγαλύτερη η ικανότητα 
διαχωρισμού σημείων εντός του κροσσού μοτίβου οδηγώντας σε περαιτέρω 
αύξηση της ακρίβειας. Πολλά από τα συστήματα της κατηγορίας εφαρμόζουν 
την τεχνική τμηματικής ψηφιοποίησης για μεγάλες επιφάνειες (για μεγαλύτερη 
ακρίβεια) και στη συνέχεια χρησιμοποιούν λογισμικά για συνένωση των 
τμηματικών σαρώσεων. Φυσικά και εδώ υπάρχουν όρια και η διαδικασία 
απαιτεί περισσότερο χρόνο ψηφιοποίησης. Άλλοι σημαντικοί περιορισμοί 
αυτών καθώς και κάθε οπτικού συστήματος που βασίζεται σε διασκορπισμό 
φωτός από μια επιφάνεια είναι: 

 

 Συνήθως αποτυγχάνουν στη μέτρηση σκούρων ή µαύρων αντικειμένων. 
Η απολύτως συμβατή προς αυτά επιφάνεια μέτρησης είναι μια ομαλή 
λευκή επιφάνεια χωρίς αντανακλάσεις. Έτσι καθίστανται καλή επιλογή για 
τα περισσότερα από τα έργα γλυπτικής. 

 Τις περισσότερες φορές, τα γυαλιστερά αντικείμενα µε ανακλαστικές 
επιφάνειες αποτελούν σημαντικό πρόβλημα. Σήμερα, βέβαια, υπάρχουν 
ειδικές τεχνικές που αντιμετωπίζουν και το πρόβλημα αυτό. Στη γενικό 
όμως περίπτωση, δεν είναι δυνατή η μέτρηση αντικειμένων µε υψηλή 
ανακλαστικότητα ή διάφανων αντικειμένων. 

 Η ύπαρξη μοτίβων ή σημαδιών στην επιφάνεια όπως για παράδειγμα 
ζωγραφική πάνω σε κεραμικά μπορεί να δημιουργήσει προβλήματα στο 
σύστημα οδηγώντας σε καταστάσεις ασάφειας εντοπισμού των 
προβαλλόμενων μοτίβων. 

 Επιφάνειες µε μεγάλη γκάμα καμπυλοτήτων μπορεί να δημιουργήσουν 
πρόβλημα. Πολύ απότομες ακμές μπορεί επίσης να εισάγουν δυσκολίες.  
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 Ένα σημαντικό χαρακτηριστικό των συστημάτων είναι ότι παράγουν αυτό 
που καλείται «νέφος σημείων» και όχι ολοκληρωμένες επιφάνειες. Στα 
παραγόμενα δεδομένα δεν υπάρχει κάποιου είδους πληροφορία 
αποκλειστικής σύνδεσης μεταξύ των σημείων, η οποία πρέπει να οριστεί 
στη συνέχεια. 

Στην κατηγορία αυτή μπορούν να ενσωματωθούν και άλλες τεχνικές, µία εκ 
των οποίων γνωρίζει σημαντική άνθηση τα τελευταία χρόνια και δεν είναι άλλη 
από την ολογραφία µε χρήση υπολογιστών. Η ολογραφία είναι ήδη ώριμη 
(φτάνει τα 50 περίπου χρόνια), αλλά δεν έχει ακόμη καταφέρει να αποδώσει 
τους καρπούς της τουλάχιστον σε εμπορικό επίπεδο. Έτσι η ολογραφία 
παραμένει ακόμη σε επίπεδο ερευνητικής ή πολύ ειδικής χρήσης. 
Παρουσιάζεται ως μια πολύ ακριβή, τεχνικά πολύπλοκη μέθοδος µε µη 
σημαντικά αποτελέσματα για τον κόσμο του πολιτισμού. Αυτό όμως αρχίζει να 
αλλάζει. Μερικά από τα προβλήματα που σχετίζονται µε την ολογραφία είναι η 
απαίτηση για χρήση υγρών χημικών για την έκθεση των εικόνων και οι 
σημαντικοί περιορισμοί στη δυνατότητα απεικόνισης. Η ολογραφία µε χρήση 
υπολογιστών δίνει μια παράπλευρη λύση σε όλα αυτά τα προβλήματα. Αλλά 
ας πάρουμε τα πράγματα από την αρχή: ο λόγος για τον οποίο βλέπουμε 
αντικείμενα είναι γιατί το φως ανακλάται πάνω τους. Το φως έχει τρεις 
σημαντικές ιδιότητας: ένταση, συχνότητα και φάση. Μια ασπρόμαυρη εικόνα 
αναπαριστά µόνο την ένταση. Μια έγχρωμη εικόνα αναπαριστά τις δύο 
πρώτες ιδιότητες, ένταση και συχνότητα. Μόνο το ολόγραμμα μπορεί να 
συλλάβει και να αναπαραστήσει και τις τρεις ιδιότητες. Το φως που 
προέρχεται από διαφορετικά σημεία του αντικειμένου έχει διανύσει 
διαφορετικό μήκος αποστάσεων και έχει, συνεπώς, διαφορετική φάση. Έτσι, η 
πληροφορία της τρισδιάστατης δομής του αντικειμένου βρίσκεται στη φάση. 
Με έλεγχο της φάσης του φωτός που προσπίπτει στο αντικείμενο μπορούμε 
να εξασφαλίσουμε ότι όλη η πληροφορία φάσης στο ολόγραμμα προέρχεται 
από το αντικείμενο, που σημαίνει ότι θα έχουμε καταγράψει τη συνολική 
πληροφορία τρισδιάστατης μορφής του αντικειμένου. Κατά την απεικόνιση, το 
ολόγραμμα εμφανίζει παράλλαξη, δηλαδή βλέπουμε ένα τρισδιάστατο 
αντικείμενο και εάν μετακινήσουμε τη θέση όρασής του φέρνουμε άλλα 
τμήματα της επιφάνειάς του στο οπτικό µας πεδίο. Ακριβώς όπως θα γινόταν 
εάν το αντικείμενο είχε φυσική παρουσία. Δύο είναι οι προσεγγίσεις στην 
ολογραφία µε υπολογιστές: 

 η ψηφιακή ολογραφία και 

 η τεχνητά δημιουργημένη ολογραφία (µέσω υπολογιστή) 

Και οι δύο έχουν σημαντικές προοπτικές στη σύλληψη και απεικόνιση 
τρισδιάστατων πολιτιστικών αντικειμένων. 

Ψηφιακή ολογραφία (digital holography) είναι η διαδικασία της καταγραφής 
ολογράμματος µε οπτικά αισθητήρια και η αποθήκευσή του σε υπολογιστή. 
Στη διαδικασία δεν εμπλέκεται πλέον κάποιο υγρό χημικό. Η προοπτική της 
μεθόδου είναι πολύ μεγάλη. Επειδή η εικόνα μπορεί να αποκατασταθεί µέσω 
λογισμικού είναι δυνατή η εξαγωγή του τρισδιάστατου σχήματος µε 
μαθηματικές μεθόδους. Τα ψηφιακά ολογράμματα είναι δυνατό να 
απεικονιστούν µε δύο τρόπους: 
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 Ως πραγματικά ολογράμματα µε όλες τις ιδιότητες παράλλαξης των 
τυπικών ολογραμμάτων, µέσω της «εγγραφής» των δεδομένων των 
ολογραμμάτων σε μια συσκευή που ονομάζεται χωρικός διαμορφωτής 
φωτός (spatial light modulator) και µε τον φωτισμό τους είτε µε φως από 
laser είτε µε φως από σημειακή πηγή λευκού φωτός. 

 Μέσω του υπολογισμού της κυματομορφής από το ολόγραμμα εντός του 
υπολογιστή και στη συνέχεια υπολογισμού της εικονικής αναπαράστασής 
του σε οθόνη υπολογιστή µε τυπικές μεθόδους απεικόνισης 
τρισδιάστατων γραφικών. Πέραν του σημαντικού πλεονεκτήματος της 
μαθηματικής αναπαράστασης των δεδομένων ενός ψηφιακού 
ολογράμματος, άλλα σημαντικά πλεονεκτήματα είναι η μεγάλη διάρκεια 
ζωής του και η δυνατότητα αντιγραφής και αναπαραγωγής του. Από τη 
στιγμή που ένα ολόγραμμα κατασκευάζεται έχει πλέον τη μορφή 
ψηφιακών δεδομένων. Στη γενική περίπτωση είναι δυνατή η μετάδοσή 
του ή ακόμη και η επεξεργασία του (π.χ. κλιμάκωση). Ένα ακόμη 
πλεονέκτημα των ψηφιακών ολογραμμάτων είναι ότι βασίζεται στη χρήση 
φωτός laser, το οποίο αποτελεί πρότυπο. Αυτό σημαίνει ότι από τη στιγμή 
που αποθηκευθεί ένα ψηφιακό ολόγραμμα πολιτιστικού αντικειμένου 
σήμερα και η διαδικασία επαναληφθεί αργότερα, είναι δυνατή η απόλυτη 
σύγκριση μεταξύ των ολογραμμάτων. Το μήκος κύματος του 
χρησιμοποιούμενου laser HeNe δεν πρόκειται να μεταβληθεί µε το 
πέρασμα του χρόνου (παρέχοντας µε τον τρόπο αυτό μέθοδο συγκριτικής 
μελέτης αντικειμένων στο πέρασμα του χρόνου). Τα τεχνητά 
δημιουργημένα ολογράμματα (µε χρήση υπολογιστών) (Computer 
generated holograms) είναι στην ουσία η άλλη όψη του ίδιου νομίσματος. 
Για τη δημιουργία τους γίνεται σύλληψη τρισδιάστατων δεδομένων και στη 
συνέχεια ακολουθεί προσομοίωση της διαδικασίας δημιουργίας 
ολογράμματος εντός ενός υπολογιστή. Έχοντας υπολογίσει πώς θα είναι 
το ολόγραμμα, η διαδικασία προχωρά στην τελική κατασκευή του 
ολογράμματος. Πρόσφατες πρόοδοι στην τελευταία αυτή διαδικασία, 
ειδικότερα στη λιθογραφία ηλεκτρονίων, δίνουν πλέον αυτή τη δυνατότητα 
και σε αρκετά μεγάλη κλίμακα– έως και αρκετά μέτρα. Με τον τρόπο αυτό 
μπορούμε να δημιουργήσουμε το ολόγραμμα ενός αντικειμένου που δεν 
έχει, µε την τυπική έννοια, ολογραφηθεί. Η ποιότητα αποκατάστασης είναι 
εξαιρετική καθώς τα τεχνητά δημιουργημένα ολογράμματα μπορούν να 
έχουν πλήρη πληροφορία χρώματος. Γιατί, λοιπόν, δεν είναι γεμάτος ο 
κόσμος µας µε τεχνητά ολογράμματα; 

Υπάρχουν, βέβαια, μερικά αλλά στην πλειοψηφία τους είναι ειδικές εφαρμογές 
και ειδικευμένες τεχνικές υλοποιήσεις. Η συγκεκριμένη επιστήμη είναι ακόμη 
σε πρώιμο στάδιο εξέλιξης. Οι οπτικοί αισθητήρες (CCD) δεν είναι ακόμη 
ικανοποιητικά μεγάλης ανάλυσης για την πραγματική σύλληψη του τεράστιου 

όγκου οπτικών δεδομένων που απαιτούνται. Αυτό, βέβαια, πρόκειται να 
αλλάξει. Όλη η εμπορική πίεση στην περαιτέρω ανάπτυξη µε χρήση πυριτίου 
(silicon κατά τα γνωστά) οδηγεί σε όλο και μεγαλύτερης κλίμακας σμίκρυνση 
των ηλεκτρονικών υλικών. Και όχι µόνο για παρόμοιες εφαρμογές αλλά σε 
όλη την κλίμακα των βιομηχανικών κατασκευών. Προφανώς και η 
συγκεκριμένη εφαρμογή θα έχει σημαντικά οφέλη από την ανάπτυξη αυτή. 
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Εάν εξετάσουμε τη μέθοδο σε μεγάλο βάθος χρόνου μπορούμε να πούμε ότι 
η ολογραφία τεχνητά δημιουργημένων ολογραμμάτων είναι αδιαμφισβήτητα η 

απόλυτη λύση στην ψηφιοποίηση, αποθήκευση και απεικόνιση τρισδιάστατων 
πολιτιστικών αντικειμένων. Τέλος, µία ακόμη τεχνική που μπορεί να 
αποτελέσει αντικείμενο μελέτης για τα αντικείμενα της κλίμακας που 
μελετούμε στη συγκεκριμένη παράγραφο είναι η τομογραφία. Τομογραφία 
είναι η διαδικασία συλλογής τρισδιάστατων ογκομετρικών δεδομένων από 
σειρά δισδιάστατων εικόνων τομών. Η μέθοδος βρίσκει σήμερα μεγαλύτερη 
εφαρμογή στην ιατρική και την αεροδιαστημική. Είναι ικανή για υψηλή 
ακρίβεια, ειδικά για μικρά αντικείμενα. Το βασικό πλεονέκτημά της έγκειται 
στην ικανότητα σύλληψης και αναδημιουργίας εσωτερικής πληροφορίας. Η 
πλέον διαδεδομένη μορφή της εκφράζεται µε τη χρήση ακτίνων X, όπου 
γίνεται χρήση ενός πομπού ακτίνων X χαμηλής ενέργειας. Στην κατηγορία 
αυτή ανήκουν επίσης και μέθοδοι οπτικής και ακουστικής τομογραφίας, αλλά 
είναι ακόμη σε πρώιμο στάδιο εξέλιξης σε σχέση µε την τομογραφία ακτίνων 
X. Η τομογραφία όταν εφαρμόζεται σε ανθρώπους βασίζεται στο ότι το σώμα 
των ανθρώπων παρουσιάζει διαφοροποίηση ως προς το υλικά, π.χ. κόκαλα, 
μύες, υγρά, αέρια, κλπ. Καθένα από τα υλικά αυτά απορροφά μέρος των 
ακτίνων X σε διαφορετικό ποσοστό, και, συνεπώς, καθώς οι ακτίνες 
διατρέχουν το σώμα προκύπτει εικόνα χαρακτηριστική της διαδρομής που 
διανύθηκε και των υλικών που συναντήθηκαν. Για το λόγο αυτό η τομογραφία 
ακτίνων Χ ανθρώπινου σώματος θεωρείται πλούσια σε πληροφορία. Γενικά, 
όμως, δεν μπορεί να λεχθεί το ίδιο και για τα πολιτιστικά αντικείμενα. 
Υπάρχουν εξαιρέσεις, αλλά παίρνοντας για παράδειγμα τα αγάλματα, υπάρχει 
πολύ μικρή διαφοροποίηση στα εσωτερικά υλικά και, έτσι, η τομογραφία 
μπορεί να συλλάβει μικρά ποσοστά πληροφορίας. Φυσικά υπάρχουν και 
εξαιρέσεις, όπως για παράδειγμα σε εφαρμογές ανοίγματος σαρκοφάγων. 

1.4.5. Τεχνικές ψηφιοποίησης αντικειμένων μεγάλου μεγέθους 
 
Στην κατηγορία αυτή αναφερόμαστε σε αντικείμενα μεγαλύτερα από 2 μέτρα 
(μπορεί να φτάνουν τα 100 μέτρα). Ενώ υπάρχουν πολλές τεχνικές για τη 
μέτρηση μεσαίων αντικειμένων στην εν λόγω κλίμακα, υπάρχει γενικά μια 
έλλειψη μεθόδων στην κατηγορία αυτή. Στο τέλος της κλίμακας το πρόβλημα 
ανάγεται σε τεχνικές ψηφιοποίησης χώρων. Εδώ υπάρχουν δύο βασικές 
οικογένειες μεθόδων: 

 Στην πρώτη οικογένεια, οι μέθοδοι βασίζονται στην ιδέα του «οπτικού 
radar». Στην απλούστερη περίπτωση μια πηγή εκπέμπει ακτίνες laser οι 
οποίες είναι διαμορφωμένες είτε κατά πλάτος είτε κατά συχνότητα. Η 
ακτίνα ανακλάται από το στόχο προς μέτρηση και ανιχνεύεται από το 
σύστημα μέτρησης. Με εξέταση της κατάστασης διαμόρφωσης της 
ακτίνας που ανιχνεύεται είναι δυνατός ο υπολογισμός του χρόνου που 
χρειάστηκε για να διανυθεί η αντίστοιχη απόσταση της ακτίνας από τον 
πομπό στο αντικείμενο και πίσω στο δέκτη. Γνωρίζοντας την ταχύτητα του 
φωτός στον αέρα είναι δυνατός ο υπολογισμός της απόστασης που 
διανύθηκε. Τα συστήματα αυτά είναι γνωστά ως συστήματα «χρόνου 
πτήσης» (“time of flight”). Στην κατηγορία αυτή υπάρχουν διαθέσιμες 
εμπορικές συσκευές µε δυνατότητα μέτρησης πολλαπλών σημείων και 
ακολουθιακής σύνθεσης μιας ολοκληρωμένης τρισδιάστατης σκηνής. Οι 
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καλύτερες τεχνικές έχουν ακρίβεια περί τα 5 χιλιοστά για αποστάσεις 
λειτουργίας περί τα 30 μέτρα και άνω. Το προφανές μειονέκτημα είναι ότι 
πρόκειται για σύστημα που βασίζεται σε σημεία, δηλαδή αποτελούν μια 
μεγέθυνση των συστημάτων τριγωνοποίησης και συνεπώς απαιτείται 
σημαντικός χρόνος για τη συλλογή του συνόλου των απαιτούμενων 
δεδομένων.  

 Στη δεύτερη οικογένεια μέτρησης μεγάλων αντικειμένων ανήκουν τεχνικές 
φωτογραμμετρίας. Η βασικότερη των τεχνικών αυτών είναι η γνωστή 
«καθοδηγούμενη στέρεο-φωτογραμμετρία». Στην τεχνική αυτή 
χρησιμοποιούνται σημεία αναφοράς, τα οποία ορίζονται στην επιφάνεια 
των προς μέτρηση αντικειμένων και λαμβάνεται τουλάχιστον ένα ζεύγος 
φωτογραφιών από διαφορετικές γωνίες. Μέσω της ταύτισης των σημείων 
αναφοράς, είτε αυτόματα είτε όχι, καθίσταται δυνατή η ανάκτηση 
πληροφορίας τρισδιάστατης γεωμετρίας µε τη μέτρηση απόστασης από 
το επίπεδο λήψης των φωτογραφιών. Η μέθοδος δίνει, προφανώς, 
καλύτερα αποτελέσματα όταν στα αντικείμενα ή, γενικά, στη σκηνή 
υπάρχουν επίπεδες επιφάνειες µε λίγα σημεία αναφοράς. Είναι, 
γενικότερα, μέθοδος που ενδείκνυται περισσότερο για την ψηφιοποίηση 
μνημείων ή χώρων. 

Ας παρατηρήσουμε τώρα μερικές από τις πιο διαδεδομένες μεθόδους 
ψηφιοποίησης αντικειμένων… 

1.4.6. Σαρωτές τριγωνοποίησης µε ακτίνες laser κοντινών 
αποστάσεων 
 
Από τις πιο διαδεδομένες μεθόδους ψηφιοποίησης, είναι και η παραπάνω 
μέθοδος. Χρησιμοποιεί έναν πομπό που εκπέμπει μία ή περισσότερες δέσμες 
φωτός laser οι οποίες κατευθύνονται στο αντικείμενο και αναπηδούν στην 
επιφάνειά του. Στη συνέχεια, ένας αισθητήρας συλλέγει την πληροφορία με τη 
μορφή νέφους σημείων. Υπάρχουν πολλών ειδών σαρωτές laser οι οποίοι 
διαφοροποιούνται ως προς: 

 τη δομή του φωτισμού (απλό σημείο, ακτίνα λέιζερ, πολλαπλός πίνακας) 

 τη μορφή του αισθητήρα (γραμμικός πίνακας ή πλέγμα CCD ή CMOS). Τα 
CCD και CMOS είναι τα πλέον διαδεδομένα είδη ηλεκτρονικών οπτικών 
αισθητήρων. Είναι ηλεκτρονικά κυκλώματα μεγάλης κλίμακας 
ολοκλήρωσης µε χιλιάδες ή εκατομμύρια εικονοστοιχεία ανά μονάδα 
επιφάνειας, τα οποία μετατρέπουν την ενέργεια του φωτός σε ηλεκτρονικά 
σήματα. 

 τη μέθοδο σάρωσης (μετακίνηση του αντικειμένου μπροστά από την πηγή 
φωτός ή μετακίνηση του ίδιου του συστήματος γύρω από το αντικείμενο.  
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Σχήμα 1.4.6 Απλοποιημένο διάγραμμα σαρωτή 
με ακτίνες laser

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΑΡΤΖΗ ΗΡΩ

 
Αξίζει τέλος να σημειωθεί ότι η ακρίβεια στη σάρωση με ακτίνες laser 
προϋποθέτει την σωστή εστίαση της ακτίνας στο αντικείμενο προκειμένου να 
μην έχουμε ένα πολύ διεσπαρμένο νέφος σημείων και την ελαχιστοποίηση 
του “θορύβου” που προκύπτει εξαιτίας της διάχυσης του φωτός της ακτίνας 
στην επιφάνεια του αντικειμένου. Για την ελαχιστοποίηση του θορύβου αυτού 
μελετούνται ακόμα και σήμερα τεχνικές χωρίς ωστόσο να έχει  επιτευχθεί η 
εξάλειψή του, αφού η κύρια αιτία που τον δημιουργεί είναι η τραχύτητα της 
επιφάνειας του εκάστοτε αντικειμένου. Πάντως σε ένα μεγάλο βαθμό ο 
θόρυβος μειώνεται κατά την επεξεργασία του νέφους σημείων στον Η/Υ. 

1.4.7. Σχήμα από σιλουέτες 
 
Η τεχνική Σχήµα-Από-Σιλουέτες ανήκει στην κατηγορία παθητικών τεχνικών 
και βασίζεται µόνο στην πληροφορία που προσφέρει ένα σύνολο από 
δισδιάστατες φωτογραφίες. Στην ίδια κατηγορία µε την τεχνική αυτή 
συναντάμε και την μεθοδολογία Σχήμα-Από-Στερεοσκοπική-Φωτογράφηση, 
καθώς και άλλες γνωστές τεχνικές, όπως οι Σχήμα-Από-Κίνηση, Σχήμα-Από-
Σκίαση, Σχήμα-Από-Μεταβολή-Εστίασης, οι οποίες βρίσκονται ακόμα σε 
ερευνητικό επίπεδο, καθώς οι υπάρχουσες υλικοτεχνικές λύσεις δεν έχουν 
ξεπεράσει τα σύνορα των ερευνητικών εργαστηρίων. 

Η βασική ιδέα της τεχνικής αυτής είναι ότι φωτογραφίζουμε το αντικείμενο 
περιμετρικά με προσοχή ώστε να υπάρχει μερική επικάλυψη των 
φωτογραφιών με τη βοήθεια ειδικής βαθμονομημένης κάμερας. Στη συνέχεια 
από τις δισδιάστατες φωτογραφίες εξάγεται η σιλουέτα του αντικειμένου και με 
τη βοήθεια αυτών ανακατασκευάζεται το αντικείμενο στον Η/Υ σύμφωνα με τη 
λογική του τριγωνικού πλέγματος. Η υφή του αντικειμένου ανακατασκευάζεται 
και αυτή στον Η/Υ ενώ όπου υπάρχει διαφορετικότητα, αυτή διορθώνεται με 
αλγόριθμους ανάμειξης. 

 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  23

Σχήμα1.4.7

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗ ΜΑ

ΦΥΣΙΚ ΩΝ  Π Ο ΡΩΝ  &  Π ΕΡΙΒ Α ΛΛΟ Ν ΤΟ Σ
ΕΡΓΑ ΣΤΗ ΡΙΟ

ΣΧΕΔ ΙΟ ΜΕΛΕΤΗ Σ  &  Κ ΑΤΕΡΓΑ Σ ΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Ανάμειξη 
διαφορετικής 

υφής ανάμεσα σε 
γειτονικές 
περιοχές

 
Μειονεκτήματα αυτής της μεθόδου είναι τα παρακάτω: 

Το τελικό τρισδιάστατο μοντέλο φέρει µόνο την πληροφορία που περιέχουν οι 
σιλουέτες. Όποιες τυχών καμπυλότητες δεν είναι εμφανείς σε αυτές δεν 
εμφανίζονται ούτε στο τελικό τρισδιάστατο μοντέλο. Το αποτέλεσμα δεν 
αποτελεί πιστό αντίγραφο του πραγματικού αντικειμένου 

Το πλήθος των σιλουετών που χρησιμοποιούνται για την παραγωγή του 
τρισδιάστατου μοντέλου παίζει σημαντικό ρόλο στην πιστότητά του. 
Θεωρητικά, όσο αυξάνεται το πλήθος των σιλουετών τόσο μικρότερο είναι το 
γεωμετρικό σφάλμα ανάμεσα στο πραγματικό και το ψηφιακό αντικείμενο. 
Παρακάτω φαίνεται η απεικόνιση ενός αμφορέα με α)έξι, β)δώδεκα, 
γ)δεκαοχτώ και δ)εικοσιτέσσερις φωτογραφίες. Εύκολα βλέπει κανείς ότι ο μη 
σωστός αριθμός φωτογραφήσεων οδηγεί σε γεωμετρικό σφάλμα του 
αντικειμένου. 

 

Σχήμα α1.4.7

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αμφορέας με α)έξι
Β)δώδεκα
γ)δεκαοκτώ

δ)εικοσιτέσσερις 
φωτογραφίες
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Παρόλα αυτά, μία σωστή φωτογράφηση και επεξεργασία δίνει αρκετά καλά 
αποτελέσματα όπως βλέπουμε στην παρακάτω εικόνα. 

Σχήμα 1.4.7β

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

1) Πραγματικό 
αντικείμενο

2)Ανακατασκευασμένο 
αντικείμενο

 

1.4.8. Σχήμα από δομημένο Φως 
 
Η αρχή λειτουργίας της συγκεκριμένης μεθόδου είναι απλή. Η ανάκτηση της 
πληροφορίας βάθους πραγματοποιείται µε την προβολή ενός μοτίβου φωτός 
πάνω σε ένα αντικείμενο, από γνωστή οπτική γωνία. Η Σχήμα-από-δομημένο-
Φως βασίζεται στην τριγωνοποίηση, όπως και η σάρωση µε ακτίνες λέιζερ 
κοντινών αποστάσεων. Οι δύο μεθοδολογίες έχουν παρεμφερή 
χαρακτηριστικά ενώ οι εμπορικές υλικοτεχνικές κατασκευές πολλές φορές 
ταυτίζονται μεταξύ τους. Εξαίρεση αποτελεί η αντικατάσταση της πηγής λέιζερ 
από μια συσκευή προβολής εικόνας. Για την τρισδιάστατη αποτύπωση 
πραγματοποιούνται προβολές από φωτεινά μοτίβα που περιέχουν πολλαπλές 
ρίγες, πλέγματα ή ακόμα και ελλείψεις. Σε κάποιες περιπτώσεις συναντούμε 
και χρωματικά κωδικοποιημένα μοτίβα. Η χρωματική κωδικοποίηση βοηθά 
τον σαρωτή να ξεχωρίσει ευκολότερα τις μεταβολές που δέχεται το μοτίβο, 
καθώς προβάλλεται πάνω στην επιφάνεια του αντικειμένου. Η κωδικοποίηση 
μπορεί να γίνει µε ποικίλες μεθόδους. Δημοφιλέστερες είναι η μεταβλητή 
φωτεινότητα χρωμάτων και η μεταβλητή πυκνότητα των σχημάτων που φέρει 
ένα μοτίβο. Ο κύριος στόχος της προβολής των κωδικοποιημένων μοτίβων 
είναι ο εύκολος διαχωρισμός του εικονοστοιχείων. 

Από τη στιγμή λοιπόν που το μοτίβο είναι κωδικοποιημένο, οι αντιστοιχίες 
ανάμεσα στις θέσεις των εικονοστοιχείων που αποτυπώνει ο σαρωτής και των 
αρχικών σημείων του μοτίβου μπορούν να συγκριθούν. Με την σύγκριση 
υπολογίζονται όλες οι αποκλίσεις στα αντίστοιχα σημεία και μπορεί, µε τον 
έμμεσο αυτό τρόπο, να ανακτηθεί η τρίτη διάσταση. 

1.4.9. Σχήμα από Στερεοσκοπική Φωτογράφηση 
(Στερεοφωτογράφηση) 
 
Η συγκεκριμένη τεχνική βασίζεται σε ζεύγος φωτογραφιών που παρουσιάζουν 
ένα αντικείμενο από διαφορετικές οπτικές γωνίες, προσεγγίζοντας τις εικόνες 
που λαμβάνονται από τα ανθρώπινα µάτια. Συγκεκριμένα τμήματα του 
αντικειμένου είναι εμφανή και στις δύο φωτογραφίες. Οι εσωτερικές και 
εξωτερικές παράμετροι των οπτικών συστημάτων χρησιμοποιούνται για την 
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διαδικασία βαθμονόμησης. Η βαθμονόμηση επιτρέπει την ανάκτηση της 
τρίτης διάστασης ενός σημείου που είναι κοινό ανάμεσα στις δύο 
φωτογραφίες. Η αναγνώριση των κοινών σημείων πάνω στις εικόνες 
πραγματοποιείται µε μεθόδους αυτόματες ή χειροκίνητες. Η ανάκτηση του 
βάθους γίνεται µε μαθηματικούς αλγορίθμους που χρησιμοποιούν 
παραμέτρους από τη βαθμονόμηση και τη διαφορά θέσης των κοινών 
σημείων ανάμεσα στις δύο εικόνες.  

 

1.4.10. Σχήμα από Κίνηση - Σχήμα από ακολουθία εικόνων (βίντεο) 
 
Η μέθοδος αυτή αποτελεί μια παραλλαγή της Σχήμα-Από-
Στερεοφωτογράφηση, κατά την οποία οι δύο φωτογραφικές μηχανές έχουν 
αντικατασταθεί από μια μηχανή λήψης κινούμενης εικόνας που καταγράφει το 
αντικείμενο από διαφορετικές οπτικές γωνίες. Βασική προϋπόθεση για την 
εφαρμογή της μεθόδου είναι η απόλυτη ακινησία του αντικειμένου ενώ 
θεωρείται δεδομένο ότι δεν υπάρχουν κινητά μέρη πάνω του. 
 

1.4.11. Σχήμα από Φωτοσκίαση 
 
Η φωτοσκίαση παίζει πολύ σημαντικό ρόλο στην αντίληψη του βάθους. 
Πολλοί ερευνητές προσπάθησαν να εξομοιώσουν τον τρόπο που λειτουργεί 
το ανθρώπινο σύστημα όρασης για να ανακτήσουν το βάθος µε τη βοήθεια 
των φωτοσκιάσεων. 

Η ανάκτηση βάθους µε τη μέθοδο Σχήμα-Από-Φωτοσκίαση απαιτεί µία µόνο 
οπτική γωνία λήψης. Φυσικά για την πλήρη αποτύπωση του αντικειμένου 
απαιτούνται περισσότερες. Η τεχνική αυτή είναι ακόμα σε πειραματικό στάδιο 
και τα αποτελέσματά της ως τώρα θεωρούνται ως μη αποδεκτά ποιοτικώς. 
 

1.4.12. Σχήμα από υφή 
 
Η βασική αρχή πίσω από την τεχνική αυτή είναι οι παραμορφώσεις που 
δέχονται μεμονωμένα τα εικονοστοιχεία υφής (texels). Οι μεταβολές της υφής 
πάνω στην εικόνα επιτρέπουν την εκτίμηση του τρισδιάστατου σχήματος της 
επιφάνειας που βρίσκεται υπό μελέτη. Η ανακατασκευή βασίζεται σε 
παραμορφώσεις προοπτικής βάθους αλλά και σε προοπτική σμίκρυνσης 
(καθώς τα αντικείμενα πλησιάζουν το επίπεδο της εικόνας παύουν να είναι 
παράλληλα προς αυτό). Το ποσοστό αυτών των παραμορφώσεων μπορεί να 
υπολογισθεί από την ίδια την εικόνα. Ο υπολογισμός των καμπύλων της 
επιφάνειας σε οποιοδήποτε σημείο είναι κάθε άλλο παρά τετριμμένο. Για το 
λόγο αυτό ο υπολογισμός της επιφάνειας γίνεται από τον προσανατολισμό 
της εκάστοτε επιφάνειας. Ένας χάρτης καθέτων ευθειών σε επιφάνεια 
προσδιορίζει τον προσανατολισμό της επιφάνειας στα σημεία όπου οι κάθετες 
υπολογίζονται. Αν υποθέσουμε ότι οι κάθετες είναι αρκετά πυκνές και η 
επιφάνεια είναι ομαλή, τότε ο χάρτης αυτός μπορεί να χρησιμοποιηθεί για την 
τρισδιάστατη ανακατασκευή του αντικειμένου. Η τεχνική αυτή χρησιμοποιείται 
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κυρίως για την ανακατασκευή επιφανειών από ύφασμα ή για το ανθρώπινο 
δέρμα. 

1.4.13. Σχήμα από φωτομετρική στερεοσκοπική φωτογράφηση 
 
Η Σχήμα-από-φωτομετρική-Στερεογράφηση βασίζεται σε μια παραλλαγή της 
τεχνικής Σχήμα-Από-Φωτοσκίαση. Η διαφορά τους βρίσκεται στο πλήθος 
φωτογραφιών που χρησιμοποιούνται για την ανακατασκευή του βάθους. Στην 
παρούσα μεθοδολογία οι εικόνες εμφανίζουν το αντικείμενο από την ίδια 
οπτική γωνία αλλά υπό μεταβλητές συνθήκες φωτισμού. Η φωτομετρική 
μέθοδος δύναται να ανακτήσει γρήγορα τον προσανατολισμό της επιφάνειας 
του αντικειμένου από εικόνες φωτεινότητας (διαβαθμίσεις του γκρι). Για να 
πετύχει κάτι τέτοιο χρησιμοποιεί άλλοτε βαθμονομημένες πηγές φωτός και 
άλλοτε όχι. Η επιλογή γίνεται ανάλογα µε την πολυπλοκότητα του αλγορίθμου 
που εφαρμόζεται. Οι βαθμονομημένες συνθήκες φωτισμού είναι εφικτές μονό 
σε περιβάλλον εργαστηρίου. Ερευνητικές προσπάθειες γίνονται, ώστε να 
μπορεί να λειτουργήσει η τεχνική σε περιβάλλον µε γενικό φωτισμό. 

1.4.14. Σχήμα από μεταβαλλόμενη εστίαση 
 
Τα τελευταία χρόνια το ενδιαφέρον πολλών ερευνητών έχει επικεντρωθεί σε 
μια τεχνική που ανακτά την τρίτη διάσταση από μια εικόνα χρησιμοποιώντας 
το βάθος πεδίου. Το αντικείμενο κινείται προς ένα φακό εστίασης από τον 
οποίο με βοήθεια κατάλληλων αισθητήρων παίρνουμε το βάθος του 
αντικειμένου στο χώρο. Οι ακόλουθες παρατηρήσεις είναι κοινά αποδεκτές 
από όλους τους ερευνητές που έχουν συμμετάσχει στη μελέτη και ανάπτυξη 
τέτοιων σαρωτών. Η ανάλυση και η ακρίβεια των τεχνικών Σχήμα-Από-
Μεταβαλλόμενη-Εστίαση είναι περιορισμένες σε σύγκριση µε τις τεχνικές 
τριγωνοποίησης. Αντίθετα µε τις μεθόδους τριγωνοποίησης, αποφεύγουν την 
τεχνική ταιριάσματος και αντιστοίχισης σημείων. Τα αποτελέσματα της 
χαρακτηρίζονται, γενικά, αξιόπιστα. 

1.4.15. Σχήμα από σκιά 
 
Η μέθοδος Σχήμα-Από-Σκιά ανήκει στην κατηγορία των παθητικών 
μεθοδολογιών ανακατασκευής τρισδιάστατων επιφανειών. Το τρισδιάστατο 
μοντέλο δημιουργείται από τη μελέτη της πληροφορίας που περιέχει η 
διάχυση της σκιάς που δημιουργεί το ίδιο το αντικείμενο, καθώς αυτό 
φωτίζεται από μια κινούμενη πηγή φωτός. Φανταστείτε για παράδειγμα τις 
μεταβολές στη σκιά ενός στύλου καθώς ο ήλιος κινείται. Με την παρατήρηση 
των μεταβολών που δέχεται το σχήμα των σκιών μπορούμε να 
συμπεράνουμε την γεωμετρία της επιφάνειας του αντικειμένου. Μια 
απλοποιημένη μορφή συστήματος που υλοποιεί τη μέθοδο φαίνεται στην 
παρακάτω εικόνα. Καθώς η πηγή φωτός μετακινείται, η φωτογραφική μηχανή 
καταγράφει τις μεταβολές που δέχεται η σκιά, όπως προβάλλεται πάνω στις 
επιφάνειες του κύβου. Το βασικό πλεονέκτημα της μεθόδου έγκειται στο 
χαμηλό κόστος του τεχνολογικού εξοπλισμού: απαιτείται µία ψηφιακή 
φωτογραφική μηχανή και µία τυπική πηγή φωτός ικανή να δημιουργήσει 
έντονες σκιές. Επίσης χαμηλή είναι και η απαιτούμενη υπολογιστική ισχύς. Η 
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μέθοδος λειτουργεί βάση κάποιων απλοϊκών υποθέσεων που αφορούν στην 
επιφάνεια των αντικειμένων. Επί πλέον, έχει αποδειχθεί πως η μέθοδος 
μπορεί να ανακατασκευάσει περιοχές της επιφάνειας του αντικειμένου που 
δεν είναι ορατές στην ψηφιακή φωτογραφική μηχανή. Στην πραγματικότητα, η 
τεχνική δεν έχει ξεφύγει ποτέ τα σύνορα των ερευνητικών εργαστηριών. Στο 
διαδίκτυο μπορεί να εντοπιστεί λογισμικό ανοικτού κώδικα που υλοποιεί τη 
μέθοδο.  Η δυσκολία που παρουσιάζει η τεχνική εντοπίζεται στο σημείο 
αυτόματης αναγνώρισης των σκιών μέσα στις φωτογραφίες. 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 1.4.15

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Σάρωση επιφάνειας και αποτύπωση
επιφάνειας με την τεχνική 

σχήμα-από-σκιά
 

1.4.16. Συστήματα μέτρησης συντεταγμένων 
 
Πολύ συχνά συναντούμε συστήματα ψηφιοποίησης µε ακτίνες λέιζερ κοντινών 
αποστάσεων να συνεργάζονται µε κάποιον μηχανικό βραχίονα, ο οποίος έχει 
έναν υψηλό βαθμό ελευθερίας κινήσεων. Ο βραχίονας τις περισσότερες 
φορές είναι χειροκίνητος, και µέσω δικού του, υψηλής ακρίβειας, καρτεσιανού 
συστήματος συντεταγμένων μεταφέρει πληροφορία θέσης προς το λογισμικό 
που διαχειρίζεται την όλη διαδικασία για να ανακτήσει τη θέση της πηγής του 
λέιζερ στον πραγματικό χώρο. Η επίσημη ονομασία των βραχιόνων είναι 
Συστήματα Μέτρησης Συντεταγμένων (Coordinate Measuring Machines-
CMM). Εκτός από την συνδυαστική τους 

χρήση µε σαρωτές λέιζερ, λειτουργούν και αυτόνομα. Σαν σημείο μέτρησης 
έχουν την κορυφή μιας ακίδας ή ενός αισθητήρα αφής που τοποθετείται στην 
άκρη του βραχίονα. Εφαρμογές βρίσκουν κυρίως στην επιθεώρηση 
βιομηχανοποιημένων μηχανικών εξαρτημάτων. Η επιθεώρηση των 
διαστάσεων αποσκοπεί στην μέτρηση της γεωμετρίας του αντικειμένου και 
των χαρακτηριστικών της επιφάνειάς του. Η εφαρμογή τους περιορίζεται στο 
χώρο της βιομηχανίας και της αντίστροφης μηχανικής. Για τη λειτουργία των 
συστημάτων αυτών απαιτείται η επαφή του αισθητήρα ή της ακίδας µε την 
επιφάνεια του αντικειμένου που εξετάζεται. Η ακρίβεια τους αγγίζει την τάξη 
των 25 µm. Η διαδικασία συλλογής δεδομένων είναι πολύ αργή. Ένας μέσος 
όρος ρυθμού αποτύπωσης συντεταγμένων αγγίζει μόλις ένα σημείο ανά 
δευτερόλεπτο. Τα συστήματα αυτά δε χρησιμοποιούνται για τη συλλογή 
μεγάλου όγκου πληροφορίας κάτι που τα καθιστά, σε γενικές γραμμές, μια όχι 
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και τόσο ελκυστική επιλογή για εργασίες αποτύπωσης αντικειμένων 
πολιτισμικής κληρονομιάς. Επίσης επίφοβη είναι και η επαφή του αισθητήρα 
με το αντικείμενο εφόσον υπάρχει πιθανότητα να του προκαλέσει κάποια 
βλάβη-παραμόρφωση. 

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα .4.161

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αποτύπωση τρισδιαστατης 
γεωμετρίας

 με χρήση αισθητήρα αφής
 

         
Περιληπτικά συγκρίσεις μεταξύ των μεθόδων απέδωσαν τις παρακάτω 
παρατηρήσεις: 

Η μέθοδος ψηφιοποίησης µε ακτίνες λέιζερ κοντινών αποστάσεων αποφέρει 
τα ακριβέστερα γεωμετρικά αποτελέσματα. Από την άλλη, η μέθοδος 
προβολής δομημένου φωτισμού αποδίδει καλύτερη γεωμετρία από τη μέθοδο 
Σχήµα-Από-Σιλουέτες αλλά όχι καλύτερη από τα συστήματα λέιζερ. Τα 
αποτελέσματα της Σχήμα-Από-Δομημένο-Φως είναι ανώτερα από αυτά της 
μεθόδου Σχήµα-Από-Σιλουέτες αφού καταφέρνει να ανακτήσει γεωμετρία από 
κοίλες επιφάνειες. Θα μπορούσαμε να πούμε πως η μέθοδος Σχήµα-Από-
Δομηµένο-Φως είναι η τεχνική που συνδυάζει κάποια από τα στοιχεία 
αυτοματισμού της Σχήµα-Από-Σιλουέτες µε τη δυνατότητα αποδεκτής 
ακρίβειας γεωμετρικών αποτελεσμάτων. Επίσης, «συμπεριφέρεται» καλύτερα 
από τους σαρωτές λέιζερ σε ημιδιαφανή και χρωματιστά αντικείμενα άλλα όχι 
καλύτερα από ότι η Σχήµα-Από-Σιλουέτες. 

Η μέθοδος της Στερεοφωτογράφησης (Stereo-Close Range Photogrammetry) 
αποτελεί το κύριο εργαλείο, εδώ και αρκετές δεκαετίες, στο χώρο της 
αρχαιολογικής τεκμηρίωσης. Έχει αποδεχτεί αποτελεσματική όταν υπάρχει 
περιορισμένος χρόνος πρόσβασης στο αντικείμενο. Είναι μια παθητική 
μέθοδος, η οποία βασίζεται περισσότερο σε λογισμικό παρά σε υλικοτεχνικό 
εξοπλισμό. Ο όγκος της γεωμετρικής πληροφορίας που θα εξαχθεί από τις 
φωτογραφίες σχετίζεται µε τις σωστές οπτικές γωνίες που έχουν επιλεγεί. Η 
στερεοφωτογράφηση προσφέρει ένα γρήγορο τρόπο «αντίστροφης 
μοντελοποίησης» αντικειμένων από φωτογραφίες, όπου, όμως, η πυκνότητα 
των σημείων του τελικού τρισδιάστατου μοντέλου δεν είναι συνήθως μεγάλη, 
µε αποτέλεσμα να µην αποφέρει τα αποτέλεσμα που φέρει η σάρωση µε 
δομημένο φως. Βασικό πλεονέκτημα της τεχνικής είναι η απόκρυψη της 
χαμηλής ποιότητας γεωμετρικής πληροφορίας μετά τη χρήση πληροφορίας 
υφής. Αυτό το συναντούμε και στη Σχήµα-Από-Σιλουέτες. Οι Park, Shin και 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  29

Chang σε μια μελέτη προσδιορισμού της φθοράς λίθινων αρχαίων μνημείων 
συγκρίνουν τη δυνατότητα εφαρμογής της αποτύπωσης µε λέιζερ και της 
ψηφιακής Στερεοφωτογράφησης. Ο βασικός τους προβληματισμός είναι ότι, 
ενώ η Στερεοφωτογράφηση είναι γρήγορη και εύκολη κατά την διαδικασία 
συγκέντρωσης δεδομένων, η επεξεργασία για την απόκτηση της τρίτης 
διάστασης είναι αρκετά δύσκολη. Πόσο µάλλον, στη συγκεκριμένη 
περίπτωση, όπου η επιφάνεια των λίθων είναι τρομερά πολύπλοκη. Στην 
πραγματικότητα τα χαρακτηριστικά της επιφάνειας των λίθων δεν αφήνουν και 
πολλά περιθώρια επιλογής. Η ψηφιοποίηση µε ακτίνες λέιζερ απαιτεί πολύ 
περισσότερο χρόνο για τη συλλογή των δεδομένων αλλά σε αντίθεση µε τη 
Στερεοφωτογράφηση δεν χρειάζεται τόσο μεγάλο χρόνο μετά-επεξεργασίας. 
Αυτό την κάνει πιο «συμβατή» µε την ακανόνιστη και τραχιά επιφάνεια των 
λίθων. Οι Bohler et al αναφέρουν σε μια δημοσίευση τους πως η 
Στερεοφωτογράφηση δε λειτουργεί µε αποδεκτά αποτελέσματα σε 
περιπτώσεις ανάγλυφων σε λευκό μάρμαρο, καθώς δεν ανακτούν μεγάλη 
ποσότητα πληροφορίας υφής. Οι ορθογραφικές φωτογραφίες από 
Στερεοφωτογράφηση μπορούν να φανούν χρήσιμες για κάποιους σκοπούς 
αλλά όχι για την τρισδιάστατη ψηφιακή αποτύπωση του μοντέλου. Oι Bohler 
et al επισημαίνουν επίσης το γεγονός ότι η ψηφιοποίηση µε ακτίνες λέιζερ 
είναι χρονοβόρα αλλά είναι και η μοναδική µε τόσο καλά αποτελέσματα. 
Πολλές φορές συναντούμε και συνδυασμούς δύο μεθόδων για τη βελτίωση 
των αποτελεσμάτων. Ένας συνδυασμός, ο οποίος αποφέρει πολύ 
ικανοποιητικά αποτελέσματα καλύπτοντας υψηλής ανάλυσης γεωμετρία και 
πληροφορίας υφής είναι η μέθοδος που προτείνουν οι Hernandez και Schmitt. 
Η μέθοδος συνδυάζει τον αυτοματισμό της Σχήµα-Από-Σιλουέτες και την 
ποιότητα τρισδιάστατης γεωμετρίας που προσφέρει η Στερεοφωτογράφηση. 
Η μέθοδος ξεχωρίζει από τις υπόλοιπες, καθώς προσφέρει σχεδόν 
αυτοματοποιημένα αποτελέσματα χωρίς την ανάγκη μετά-επεξεργασίας του 
τρισδιάστατου μοντέλου. 

 Ο συνδυασμός των δύο μεθόδων έρχεται να δώσει απάντηση στο πρόβλημα 
της Σχήµα-Από-Σιλουέτες στη μοντελοποίηση κοίλων επιφανειών. Ίσως είναι 
η μοναδική μέθοδος που ξεχωρίζει για την ποιότητα των αποτελεσμάτων της 
και της αυτοματοποιημένης διαδικασίας αποτύπωσης. Δυστυχώς δεν υπάρχει 
ακόμα κάποιο εμπορικό σύστημα που να βασίζεται στην συγκεκριμένη 
τεχνική. Στην Εικόνα 82 μπορείτε να διακρίνετε τη βελτίωση των 
αποτελεσμάτων µε το συνδυασμό των δύο τεχνικών. Γενικότερα, οι 
υπάρχουσες μέθοδοι τρισδιάστατης αποτύπωσης υποφέρουν από πολλούς 
περιορισμούς. Ακόμα και µε τη χρήση των πιο σύγχρονων υπολογιστικών 
συστημάτων και λογισμικού, συγκεκριμένα βήματα επεξεργασίας γίνονται 
µόνο όταν ο όγκος πληροφορίας δεν ξεπερνά κάποια συγκεκριμένα όρια. Αν η 
ανάπτυξη του εξοπλισμού και του λογισμικού συνεχίσουν στους ρυθμούς των 
προηγούμενων χρόνων τότε αρκετά προβλήματα θα έχουν ξεπεραστεί μέσα 
στα επόμενα χρόνια. Ίσως ακόμα επιτευχθεί και ο συνδυασμός της 
ψηφιοποίησης ακτίνων λέιζερ µε φωτογραμμετρικά δεδομένα υφής για 
αποτύπωση μεγάλων και πολύπλοκων πολιτιστικών αντικειμένων που οι 
διαστάσεις τους ξεπερνάνε τα 5 m. Ο συνδυασμός των δύο μεθόδων μπορεί 
να αποφέρει πολλά πλεονεκτήματα. 
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Τέλος παρατηρούμε πως υπάρχουν πάρα πολλές τεχνικές ψηφιοποίησης 
αντικειμένων και εναποτίθεται πλέον στον αποφασίζοντα ειδικό η κρίση για το 
ποια τεχνική σάρωσης θα χρησιμοποιηθεί κάθε φορά, ανάλογα πάντα με 

 το εκάστοτε αντικείμενο (υλικό, δυνατότητα μετακίνησης, μέγεθος) 

 το προβλεπόμενο κόστος  

 τις συνθήκες που επικρατούν στο ευρύτερο περιβάλλον (φωτισμός, 
υγρασία) 

 την επιθυμητή ταχύτητα σάρωσης 

 την ακρίβεια που θέλουμε να επιτύχουμε και άλλα 

Ειδικότερα παρατίθεται παρακάτω ένας κατάλογος με τα βασικά κριτήρια 
επιλογής σαρωτή και άρα και τεχνικής σάρωσης 

. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Πάντως με τα όσα είπαμε παραπάνω, η αποτύπωση ενός αντικειμένου 
ακολουθεί γενικώς τα παρακάτω βήματα: 

 

 Σύλληψη γεωμετρικών δεδομένων 

 Προ-επεξεργασία γεωμετρικής πληροφορίας 

 Φιλτράρισμα του θορύβου στο νέφους σημείων 

 Ομαδοποίηση και οργάνωση των δεδομένων 

 Ευθυγράμμιση και ενοποίηση των τμηματικών σαρώσεων 
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 Δημιουργία πολυγωνικού πλέγματος (meshing) 

 Απλοποίηση του πολυγωνικού πλέγματος 

 Απαλοιφή γεωμετρικών ασυνεχειών 

 Δημιουργία υφής 

 

1.5. Τρόποι προβολής αντικειμένων 
 
Η προβολή τρισδιάστατων εικόνων μπορεί να πραγματοποιηθεί πλέον με τη 
βοήθεια της τεχνολογίας. Έτσι εκτός τις κλασικές οθόνες CRT ή καθοδικών 
σωλήνων που είναι στις μέρες μας οι πιο διαδεδομένες, έχουμε τις οθόνες 
LCD και TFT  οι οποίες λειτουργούν με την τεχνολογία υγρών κρυστάλλων 
καθώς και τις οθόνες Plasma που κάνουν χρήση θαλάμων με ευγενές αέριο 
το οποίο όταν ιονίζεται εκπέμπει ενέργεια με αποτέλεσμα τη λειτουργία της 
οθόνης. Παράλληλα με τις παραπάνω οθόνες έχουμε και τους λεγόμενους 
Projectors ή Προβολικά συστήματα οι οποίοι μεγεθύνουν, εστιάζουν και 
μεταδίδουν την εικόνα συνήθως πάνω σε μία ειδική οθόνη προβολής. 
Τα παραπάνω μέσα προβολής της πληροφορίας χρησιμοποιούνται κατά 
κόρον για την προβολή δισδιάστατων κυρίως εικόνων. Τι γίνεται όμως όταν 
θέλουμε να παρουσιάσουμε στον χρήστη τρισδιάστατες εικόνες; Στην 
περίπτωση αυτή κάνουμε χρήση ειδικών συσκευών όπως 
 

 Γυαλιά μπλε - κόκκινων φακών 
Βασίζονται στο γεγονός ότι αν κάνουμε την εικόνα του ενός ματιού αόρατη για 
το άλλο δημιουργείται μία αίσθηση τρισδιάστατης στερεοσκοπικής 
απεικόνισης του αντικειμένου 

 

   
Σχήμα 1.5Γυαλιά μπλέ-κόκκινων φακών 

και αντίστοιχη ειδική εικόνα
Τ.Ε.Ι ΚΡΗΤΗΣ

ΤΜΗΜΑ
ΦΥΣΙΚΩΝ ΠΟ ΡΩΝ & ΠΕΡΙΒΑΛΛΟ ΝΤΟ Σ

ΕΡΓΑΣΤΗΡΙΟ
ΣΧΕΔΙΟ ΜΕΛΕΤΗΣ  & ΚΑΤΕΡΓΑΣ ΙΩΝ

ΒΕΖΥΡΑΚΗ  ΕΥΑΓΓΕΛΙΑ
ΚΑΝΑΡΤΖΗ  ΗΡΩ

 
 

 
 Γυαλιά με αντίθετα πολωμένους φακούς 

Έτσι ώστε για άλλη μια φορά να απομονώσουμε την εικόνα του ενός ματιού 
από το άλλο 

 Γυαλιά ηλεκτρονικού διαφράγματος υγρών κρυστάλλων (LCD shutter 
glasses) 
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Με δύο οθόνες LCD, μία για κάθε μάτι ώστε με τον συγχρονισμό καθεμίας 
από αυτές με μια οθόνη να βιώνει ο χρήστης ένα τρισδιάστατο περιβάλλον 

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 5.11.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΓυαλιά διαφράγματος υγρών 

κρυστάλλων και αντίστοιχη εικόνα
 

 
 Προσαρτημένες επί της κεφαλής οθόνες (HMD – Head Mounted Display). 

Συσκευές με δύο μικρές οθόνες, μια για κάθε μάτι ώστε να απομονώνονται 
μεταξύ τους και να βιώνεται το τρισδιάστατο περιβάλλον. 

 Επίπεδες οθόνες πλάσματος ή TFT µε ειδικές μεμβράνες. 

Παρόμοιες με τις απλές οθόνες Plasma και TFT με την προσθήκη πλαστικών 
ραβδώσεων που ανακλούν την εικόνα που προβάλουν και δίνουν αίσθηση 
βάθους. 

 Οθόνες ογκομετρικής απεικόνισης. 

Βασίζονται σε τεχνικές πολλαπλής και ταχύτατης προβολής δισδιάστατων 
εικόνων, πάνω σε ημιδιαφανείς ταχύτατα περιστρεφόμενες επιφάνειες. Η 
τεχνική αυτή δημιουργεί την ψευδαίσθηση μιας ημιδιαφανή, ωστόσο 
σταθερής, τρισδιάστατης εικόνας την οποία ο χρήστης μπορεί να την 
περιεργαστεί από διάφορες θέσης, όπως ακριβώς θα έκανε και µε ένα 
πραγματικό τρισδιάστατο αντικείμενο. 
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ΚΕΦΑΛΑΙΟ :2 ΑΠΟΤΥΠΩΣΗ ΤΗΣ ΓΕΩΜΕΤΡΙΑΣ ΚΑΙ 
ΥΦΗΣ ΕΚΘΕΜΑΤΩΝ ΜΕ ΤΟ ΛΟΓΙΣΜΙΚΟ 3DSOM. 

 

2.1. Παράμετροι για τη σωστή λήψη των εικόνων ενός εικονικού 
εκθέματος. 
2.1.1. Ο απαιτούμενος εξοπλισμός. 
 
 Τα στοιχεία που χρειάζονται είναι τα ακόλουθα:    

 Ένα αντικείμενο-μοντέλο   

 Μια βάση για το αντικείμενο   

 Ένα φόντο σαν σκηνικό   

 Ένας 3DSOM pro δίσκος βαθμονόμησης με σημεία ακριβείας 

 

Το αντικείμενο  
Το 3DSOM λειτουργεί καλά, με πολλά είδη αντικειμένων αλλά ίσως έχει 
πρόβλημα να αποτυπώσει τα διαφανή αντικείμενα (π.χ. μη-χρωματισμένο 
γυαλί), τις εξαιρετικά περίπλοκες μορφές (π.χ. μια βούρτσα για τα μαλλιά), τα 
αντανακλώμενα αντικείμενα και τα αντικείμενα με τις βαθιές τρύπες (π.χ. ένα 
φλιτζάνι).   

 
3DSOM pro δίσκος βαθμονόμησης με σημεία ακριβείας 
Ο 3DSOM pro δίσκος βαθμονόμησης είναι ένα επίπεδο φύλλο χαρτιού με 
ειδικά σημάδια τα οποία το πρόγραμμα 3DSOM χρησιμοποιεί για να 
καθορίσει τη γωνία από την οποία κάθε φωτογραφία λήφθηκε.   

Ο 3DSOM δίσκος βαθμονόμησης μπορεί να τυπωθεί μέσα από το λογισμικό 
του συστήματος 3DSOM, χρησιμοποιώντας την εντολή Print mat στην κύρια 
στήλη εργαλείων των WINDOWS.   

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.1.1

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Δίσκος βαθμονόμησης 
με σημεία ακριβείας 
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Ο δίσκος πρέπει να είναι τέλεια επίπεδος και συνιστάται να είναι 
σταθερά τοποθετημένος επάνω σε μια στερεά επίπεδη επιφάνεια.   

 

Ο δίσκος είναι τυπικά τυπωμένος σε μια λευκή κόλλα Α4 αλλά αυτό φυσικά 
εξαρτάται από το μέγεθος του προς διαμόρφωση αντικειμένου. Μπορεί να 
ρυθμιστεί το αντίστοιχο μέγεθος καθώς και το έγγραφο επιλέγοντας την 
εντολή FILE> PAGE SETUP... Όλα τα σημεία ακριβείας βρίσκονται τυπωμένα 
στον εξωτερικό κύκλο του δίσκου. 

Σημείωση: Κατά την τοποθέτηση του δίσκου θα πρέπει να είναι βέβαιο ότι 
βρίσκεται σε οριζόντια θέση (χωρίς να διπλώνει επάνω στις άκρες), και εάν 
είναι απαραίτητο, να κολληθεί σε ένα επίπεδο φύλλο από σκληρό χαρτόνι.  

 
Η βάση 
Η βάση είναι χρησιμεύει για να ανυψώσει το αντικείμενο μακριά από τα σημεία 
του δίσκου και να μειώσει τις σκιές που εμφανίζονται επάνω σ’ αυτόν. Βοηθά 
επίσης στην ενσωμάτωση του αντικειμένου με το σκηνικό.   
Η ιδανική βάση πρέπει να είναι:   

1. Στενότερη από το αντικείμενο (έτσι ώστε το κάτω μέρος του 
αντικειμένου να μην δημιουργεί σκίαση).   

2. Αδιαφανής και το ίδιο χρώμα με το σκηνικό (για να βοηθήσει τον 
αυτόματο εντοπισμό του φόντου).   

3. Ικανή να στηρίξει το αντικείμενο.   

4. Αρκετά σταθερή ώστε να επιτρέπει την περιστροφή της σκηνής (εάν 
αυτό είναι απαραίτητο η βάση θα πρέπει να κολληθεί επάνω στο 
δίσκο).   

Σημείωση: Εάν το αντικείμενο  είναι πάρα πολύ μεγάλο και επικαλύπτει τα 
σημεία στο δίσκο, θα πρέπει να χρησιμοποιηθεί ένας μεγαλύτερος δίσκος.  

 

Το σκηνικό  
Το σκηνικό είναι ένα ματ, απλό χρωματισμένο φύλλο χαρτιού, το οποίο 
παρέχει ένα σταθερό φόντο πίσω από το αντικείμενο. Αυτό επιτρέπει στο 
3DSOM Pro να καθορίσει ποια μέρη της εικόνας αντιστοιχούν στο αντικείμενο. 
Εάν δεν είναι δυνατή η χρησιμοποίηση ενός κατάλληλου σκηνικού θα 
χρειαστεί περισσότερος χρόνος ώστε ο εντοπισμός του φόντου να 
πραγματοποιηθεί με το χέρι (βλ. εντοπισμός φόντου). 

 
Το σκηνικό θα πρέπει...   

1. να είναι ματ, απλά χρωματισμένο ή άσπρο. Συνιστάται η επιλογή ενός 
χρώματος που αντιπαραβάλλει το αντικείμενο, για παράδειγμα  τα 
ανοιχτά χρώματα δουλεύουν καλύτερα από τα σκούρα. 

2. να είναι ομαλό επιφανειακό και απαλλαγμένο από σημάδια ή ζάρες.   

3. να περιβάλλει το αντικείμενο. 
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 Το 3DSOM Pro υποθέτει τα χαρακτηριστικά γνωρίσματα του αντικειμένου και 
πραγματοποιεί τον εντοπισμό φόντου γύρω από αυτά. Εάν το 3DSOM Pro 
δεν έχει την ικανότητα να το κάνει  αυτό αυτόματα, θα πρέπει να καλυφτούν οι 
εικόνες με το χέρι χρησιμοποιώντας τα αντίστοιχα εργαλεία εντοπισμού 
φόντου.   

Σημείωση: Σημείωση εάν επιλεγεί ένα έντονο χρώμα τότε δεν πρέπει να 
χρησιμοποιηθεί ένα πάρα πολύ μεγάλο σκηνικό καθώς το χρώμα μπορεί να 
απεικονιστεί επάνω στις πλευρές του αντικειμένου.   

2.1.2. Φωτισμός και στήσιμο φωτογραφικών μηχανών  

2.1.2.1. Φωτισμός  
 
Το 3DSOM Pro μπορεί να χειριστεί τις φωτογραφίες που λαμβάνονται κάτω 
από ποικίλες συνθήκες. Δύο χαρακτηριστικές διαμορφώσεις εμφανίζονται 
παρακάτω: μια χαμηλού προϋπολογισμού φωτογραφία και ενός 
επαγγελματικού στησίματος σε στούντιο.   
Το 3DSOM Pro θα διορθώσει αυτόματα πολλά προβλήματα φωτισμού, αν και 
τα ακόλουθα σημεία πρέπει ακόμα να προσεχθούν:   

 Θα πρέπει να αποφευχθούν οι έντονες σκιές στο σκηνικό, στο δίσκο 
βαθμονόμησης ή στο αντικείμενο.   

 Εάν είναι δυνατόν, σιγουρευτείτε ότι υπάρχει αρκετό φως για να 
ληφθούν οι φωτογραφίες χωρίς να πρέπει να χρησιμοποιηθεί η λάμψη 
φωτογραφικών μηχανών (φλάς).   

 

Συμβουλές φωτισμού για τα επαγγελματικά στούντιο: 

 Συνιστάται η χρήση διασκορπισμένου φωτισμού για να πλημμυρίσει η 
σκηνή με ισόποσο φως.   

 Η χρήση ενός ανακλαστήρα πάνω από το αντικείμενο   

 Η ελαχιστοποίηση των σκιών από το αντικείμενο   

 2.1.2.2. Στήσιμο φωτογραφικών μηχανών  
 
 Βασικά σημεία   
 Απαιτείται η... 

 Χρήση μιας ψηφιακής φωτογραφικής μηχανής.   

 Τοποθέτηση ψηλά σε ένα άκαμπτο τρίποδο στο τοπίο ή σε τεχνική 
πορτραίτου. 

 Απενεργοποίηση του φλας για την αποφυγή έντονων σκιών.   

 

Σημείωση: Το αντικείμενο και ο δίσκος βαθμονόμησης θα πρέπει να γεμίζουν 
την εικόνα της φωτογραφικής μηχανής (δηλ., καλή χρήση του διαστήματος της 
φωτογραφικής μηχανής) για την βελτίωση της ποιότητας των αποτελεσμάτων.  
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2.1.3. Λήψη των φωτογραφιών  
 
Το 3DSOM Pro, απαιτεί τη λήψη περίπου 20 φωτογραφιών από διάφορες 
γωνίες, για να δημιουργηθεί ένα τρισδιάστατο μοντέλο ενός αντικειμένου. 
(Μπορεί επίσης να χρειαστεί να ληφθούν πρόσθετες φωτογραφίες για να 
βαθμονομηθεί ο φακός της φωτογραφικής μηχανής –( βλ. καλιμπράρισμα των 
φακών.)   

Γενικά σημεία που πρέπει να υπογραμμιστούν:  

 Να γίνεται έλεγχος, ότι η βάση και το αντικείμενο είναι σταθερά και δεν 
θα ταλαντεύονται ή δεν θα πέσουν όταν ο δίσκος γυρίσει(να κολληθεί 
αν χρειαστεί).   

 Κατά τη λήψη των φωτογραφιών το αντικείμενο δεν θα πρέπει να 
μετακινηθεί από τον δίσκο..   

 Σωστή ρύθμιση του ζουμ ώστε το αντικείμενο να μην ξεφεύγει από τα 
άκρα της εικόνας  

 Δεν πειράζει εάν η βάση κρύβει μερικά από τα σημάδια στο δίσκο εφ' 
όσον το μπροστινό μισό του δίσκου είναι ορατό.   

 Εάν χρησιμοποιηθεί φακός ζουμ πρέπει να διατηρηθεί η ίδια ρύθμιση 
για όλες τις εικόνες που πρόκειται να ληφθούν.  

 Μετά τη λήψη των φωτογραφιών δεν πρέπει να γίνει καμία 
επαναταξινόμηση . Όλες οι εικόνες πρέπει να έχουν το ίδιο μέγεθος 
ειδάλλως  το 3DSOM Pro θα τις απορρίψει κατά την εισαγωγή τους.   

Σημείωση: Ο δίσκος βαθμονόμησης  θα πρέπει να λαμβάνει το 1/3 περίπου 
της συνολικής εικόνας. 

Υποστήριξη των πλάγιων όψεων: 

 

Αρχικά θα πρέπει να ληφθούν περίπου 15 φωτογραφίες πλαγίων όψεων του 
αντικειμένου από διαφορετικές γωνίες. Η φωτογραφική μηχανή πρέπει να 
είναι  ελαφρώς στραμμένη προς τα κάτω για να εξασφαλιστεί ότι ο δίσκος 
βαθμονόμησης  θα είναι ορατός. Οι δεκαπέντε, ή οι περισσότερες, 
φωτογραφίες πρέπει να ληφθούν από διαφορετικές γωνίες με την περιστροφή 
του δίσκου είτε δεξιόστροφα είτε αντίθετα προς την φορά των δεικτών του 
ρολογιού σε περίπου 15 διαφορετικές θέσεις.  Απαιτείται προσοχή έτσι ώστε 
το αντικείμενο να μην ξεφεύγει από τα όρια της εικόνας.  
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.1.3

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ14 διαφορετικές εικόνες από 

διαφορετικές γωνίες λήψης

 
 

 Λήψη  πρόσθετων φωτογραφιών. 

  

Κατόπιν θα πρέπει να ληφθούν τέσσερις ή περισσότερες φωτογραφίες από 
υψηλότερο σημείο. 

Η ανύψωση της φωτογραφικής μηχανής πρέπει να είναι αρκετά μεγάλη ώστε 
να κοιτάζει το αντικείμενο.  Οι τέσσερις ή περισσότερες, φωτογραφίες πρέπει 
να ληφθούν από διαφορετικές θέσεις με την περιστροφή του δίσκου 
βαθμονόμησης είτε δεξιόστροφα είτε αντίθετα προς την φορά των δεικτών του 
ρολογιού σε περίπου τέσσερις διαφορετικές θέσεις. 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.1.3α

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΦωτογραφία από την πάνω 

όψη του αντικειμένου

 
 

Λήψη μιας φωτογραφίας από μεγάλη γωνία: 
 
Αντιστοιχεί στη λήψη μιας μονής (από πάνω προς τα κάτω) φωτογραφίας. 
Είναι σημαντικό να εξασφαλιστεί ότι το αντικείμενο δεν επικαλύπτει 
υπερβολικά οποιοδήποτε από τα σημεία του δίσκου βαθμονόμησης. Εάν αυτό 
συμβαίνει τότε είναι δυνατό να ληφθεί η εικόνα από μικρότερη γωνία ώστε 
περισσότερα σημεία να φαίνονται στη φωτογραφία.   
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2.1.4. Αποθήκευση των φωτογραφιών. 
 
Αφού ληφθούν οι απαραίτητες φωτογραφίες, πρέπει να αποθηκευτούν σε 
έναν φάκελο για την περαιτέρω χρήση τους με 3DSOM Pro.  Συνίσταται όλες 
οι φωτογραφίες να αποθηκεύονται στον ίδιο φάκελο: έτσι θα είναι ευκολότερο 
να τις επιλέξουμε κατά τη δημιουργία ενός project 3DSOM, αν και αυτό δεν 
είναι απαραίτητο.   

To 3DSOM Pro δέχεται τις εικόνες με τις μορφές JPEG, PNG, PPM ή bmp.   

Για μερικά αντικείμενα μπορεί να υπάρξει η ανάγκη λήψης πρόσθετων 
φωτογραφιών στις οποίες δεν συμπεριλαμβάνεται ο δίσκος βαθμονόμησης. 
Παραδείγματος χάριν, μια φωτογραφία που λαμβάνεται από το κάτω μέρος 
ενός αντικειμένου μπορεί να χρησιμοποιηθεί για να προστεθεί ως επιπλέον 
υφή σε ένα μοντέλο. Αυτές μπορούν είτε να συμπεριληφθούν με τις 
υπόλοιπες εικόνες κατά τη δημιουργία του μοντέλου ή να προστεθούν 
αργότερα (οπότε σ' αυτή την περίπτωση είναι χρήσιμο να γραφτούν τα 
ονόματά τους ευκόλως κατανοητά).   
 

2.2 Βασικές λειτουργίες του προγράμματος.  

2.2.1. Περιήγηση του χρήστη στο πρόγραμμα 3DSOM Pro. 
 
Για την επεξεργασία των βασικών σημείων του προγράμματος: σε πρώτο 
στάδιο, θα πρέπει να ανοίξει το πρόγραμμα του 3DSOM Pro και έπειτα να 
επιλεχθεί η εντολή FILE>Open… και το project doll.som project από την 
εφαρμογή Examples/doll. 
Το πάνω μέρος του παραθύρου περιλαμβάνει τα τυποποιημένα παράθυρα 
menubar, την κύρια ράβδο εργαλείων και το Thumbnail Window. Το κάτω 
μέρος του παραθύρου επιδεικνύει είτε το παράθυρο εντοπισμού φόντου Edit 
είτε το παράθυρο υφής του μοντέλου ενώ στο αριστερό μέρος τα σχετικά 
εργαλεία και οι τοποθετήσεις τους. Κατά μήκος της βάσης, μια ράβδος 
«κατάστασης»δίνει πληροφορίες για το επιλεγμένο εργαλείο και για το τρέχον 
πρόγραμμα. Κάθε ένα από αυτά τα στοιχεία περιγράφεται παρακάτω. 

  

2.2.2. Η στήλη της κατάστασης  
 
Η στήλη  κατάστασης παρουσιάζεται κατά μήκος της βάσης του παράθυρου 
του 3DSOM Pro. Εάν αυτό είναι ενεργοποιημένο ή όχι μπορεί να εντοπιστεί 
από το μενού View > Status Bar. Στα αριστερά της στήλης κατάστασης είναι 
μια σειρά από πεδία που περιγράφουν το τρέχον project τα οποία 
αναφέρονται στα εξής:  

 Ποια εικόνα φορτώνεται στο Edit παράθυρο φόντου ή ποία είναι η πιο 
κοντινή εικόνα στην τρέχουσα υφή στο View model.   

 Πόσες εικόνες είναι στο πρόγραμμα και σε χρήση.  

 Πόσα τρίγωνα περιλαμβάνουν το μοντέλο που εκτίθεται.  
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 Ποιο είδος επεξεργασίας υφής, εάν υπάρχει, έχει δημιουργηθεί.  

 

2.2.3. Η κύρια στήλη εργαλείων  
 
Αυτή η στήλη εργαλείων χρησιμοποιείται για να εκτελέσει όλες τις σημαντικές 
λειτουργίες στο πρόγραμμα 3DSOM Pro. Η λειτουργία του είναι δυνατό να 
ελεγχθεί μέσω των εντολών View > Toolbar. Πατώντας το κουμπί Make all 
θα προκύψει μία ακολουθία εντολών για τη δημιουργία ενός νέου project. 
Κάθε ένα από τα κουμπιά στη στήλη εργαλείων περιγράφονται 
λεπτομερέστερα στο κύριο τμήμα αναφοράς της στήλης εργαλείων.  
 

 2.2.4. Το παράθυρο Thumbnail Window. 
 
Αυτή η περιοχή  χρησιμοποιείται για να χειριστεί τις εικόνες που σχετίζονται με 
το τρέχον πρόγραμμα 3DSOM. Οι εικόνες επιδεικνύονται εξ ορισμού ως 
Thumbnail Window(σε μικρογραφία),αλλά μπορούν να παρουσιαστούν 
λεπτομερέστερα μέσω ενός καταλόγου πληροφοριών για κάθε εικόνα 
επιλέγοντας την εντολή View Images Details.  

 
Σημείωση: Στο Thumbnail Window, οι αναλυτικές πληροφορίες για μια εικόνα 
επιδεικνύονται ως συμβουλή εργαλείων(tooltip) κατά το πέρασμα του 
ποντικιού πάνω από το αντίστοιχο Thumbnail Window.  

Οι περισσότερες λειτουργίες από το Main Menu > Images, όπως το 
Images > Delete Images (σβήσιμο εικόνων), εκτελούνται στο ήδη υπάρχον 
επιλεγμένο σύνολο εικόνων στο Thumbnail Window. Οι εικόνες μπορούν να 
επιλεγούν με click ή το σύρσιμο ενός ορθογωνίου επιλογής και τα κλειδιά 
SHIFT και CTRL.τα οποία μπορούν να χρησιμοποιηθούν για να προσθέσουν 
ή να αφαιρέσουν την τρέχουσα επιλογή όπως συνήθως.   

 

Σημείωση: Το διπλό κλικ στο Thumbnail Window είναι ο πιο σύντομος δρόμος 
για τις Images > Edit Mask ώστε να φορτώσει την εικόνα στο παράθυρο Edit 
Masks. 
Όλες οι λειτουργές που είναι διαθέσιμες στο παράθυρο Thumbnail Window 
μαζί με τις περιγραφές των πληροφοριών που υπάρχουν για κάθε εικόνα, 
περιγράφονται πλήρως στο τμήμα αναφοράς του Thumbnail Window. 
 
2.2.5. Το παράθυρο εντοπισμού φόντου.   
 
Με το παράθυρο αυτό είναι δυνατή η επεξεργασία και η δημιουργία  του  
εντοπισμού φόντου μιας εικόνας για μια εξωτερική εφαρμογή. Επιπλέον είναι 
δυνατή η μεγέθυνση της εικόνας που εισάγεται από το παράθυρο Thumbnail 
για την λεπτομερέστερη επεξεργασία της χρησιμοποιώντας τα αντίστοιχα 
εργαλεία της στήλης Edit. Τα εργαλεία αυτά βοηθούν τόσο στον αυτόματο 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  40

εντοπισμό φόντου όσο και στον εντοπισμό φόντου που πραγματοποιείται με 
το χέρι. 
 
2.2.6. Το παράθυρο παρατήρησης μοντέλου.   
 
Αυτό το παράθυρο χρησιμοποιείται για την παρουσίαση του τρισδιάστατου 
μοντέλου που παράγεται από το 3DSOM Pro. Μπορούν να χρησιμοποιηθούν 
τα εργαλεία του παράθυρου View Model για την περιστροφή και την 
μεγέθυνση του μοντέλου. Οι πρόσθετες εικόνες(για παράδειγμα η εικόνα της 
βάσης του αντικειμένου)μπορούν να ευθυγραμμιστούν μέσω της εντολής 
align,όπου με τη βοήθεια των εργαλείων αυτών η εικόνα μπορεί να 
μεγεθυνθεί για τον  περισσότερο ακριβή προσδιορισμό της θέσης του 
μοντέλου. 
 

Σημείωση: Μέσω της εντολής Reset view το πρόγραμμα θα επιστρέψει στην 
προηγούμενη θέση επεξεργασίας του μοντέλου. 

Μπορεί επίσης να αλλάξει ο τρόπος με τον οποίο το μοντέλο επιδεικνύεται. 
Είναι δυνατός ο έλεγχος όσον αφορά την παρουσίαση της γεωμετρίας του 
μοντέλου, συμπεριλαμβανομένου της αλλαγής του αριθμού τριγώνων που 
χρησιμοποιούνται για να το επιδείξουν, της απομάκρυνσης της μη επιθυμητής 
γεωμετρίας καθώς επίσης της επεξεργασίας της υφής του μοντέλου.    

 

Σημείωση: Οι επιλογές επίδειξης είναι διαθέσιμες κάτω από το Main 
Menu > Model Tools, από τον κύριο μενού επιλογών ή από το πάτημα του 
ποντικιού πάνω στο View Model.  
Λεπτομερή περιγραφή όλων των εργαλείων και των διαθέσιμων λειτουργιών 
σε αυτό το παράθυρο γίνεται στο παράθυρο αναφοράς View Model. 
 
2.2.7. Δημιουργία ενός project  3DSOM Pro.  
 
Η δημιουργία ενός νέου project 3DSOM,πραγματοποιείται με την επιλογή των 
εντολών  File > New ή New project... Ένα παράθυρο διαλόγου θα εμφανιστεί 
μέσω του οποίου θα πρέπει να επιλεγούν οι εικόνες που θα προστεθούν στο 
νέο project.  
  
Σημείωση:    

1. Περισσότερες από μία εικόνες μπορούν να επιλεγούν κρατώντας 
πατημένο το Shift. Το κουμπί Control μπορεί επίσης να 
χρησιμοποιηθεί για να προσθέσει επιλεκτικά ή να αφαιρέσει εικόνες.  

2. Μόλις δημιουργηθεί το νέο project μπορούν να προστεθούν σ’ αυτό οι 
επιλεγμένες εικόνες μέσω του Windows Explorer του 3DSOM Pro. 
Εναλλακτικά μπορούν να χρησιμοποιηθούν οι εντολές Images > Add 
Images... menu. 
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Μόλις πραγματοποιηθεί η επιλογή των εικόνων, αυτές θα φορτωθούν στο 
project και το 3DSOM Pro θα προσπαθήσει να καθορίσει τη θέση της 
φωτογραφικής μηχανής για κάθε μία από αυτές. Μόλις υπολογιστούν οι 
πληροφορίες της φωτογραφικής μηχανής, κάθε εικόνα παρουσιάζεται από την 
σωστή θέση και γωνία λήψης.  

 

Σημείωση: Οι εικόνες στις οποίες φαίνεται ο δίσκος βαθμονόμησης πρέπει να 
έχουν τον ίδιο προσανατολισμό (τοπίο ή πορτρέτο) και τον ίδιο αριθμό pixels.  

 

Εάν ο δίσκος βαθμονόμησης δεν είναι ορατός στην εικόνα, ή εάν τα σημεία 
ακριβείας του δίσκου παρουσιάζονται παραμορφωμένα ώστε το 3DSOM Pro 
να μην μπορεί να τα εντοπίσει, τότε η εικόνα αυτή  θα χαρακτηριστεί ως 
"απορριπτέα" και ένα μήνυμα λάθους θα εμφανιστεί.  

 

Κάτι τέτοιο είναι δυνατόν να διορθωθεί ελέγχοντας τον φωτισμό  
χρησιμοποιώντας μερικές δοκιμαστικές φωτογραφίες. Εάν οι εικόνες 
χαρακτηριστούν ως ‘’απορριπτέες’’ τότε η λήψη των φωτογραφιών θα πρέπει 
να γίνει από μια ελαφρώς υψηλότερη γωνία ώστε να επιτευχθεί μια καλή όψη 
του δίσκου βαθμονόμησης. 

 
2.2.8. Εντοπισμός  του φόντου των εικόνων. 
 
Μετά την εισαγωγή των εικόνων στο πρόγραμμα 3DSOM Pro, το επόμενο 
βήμα είναι να πραγματοποιηθεί ο εντοπισμός φόντου για κάθε μία από αυτές. 
Ο εντοπισμός φόντου αναφέρεται στη διαδικασία δημιουργίας του φόντου 
γύρω από το αντικείμενο, έτσι ώστε το 3DSOM Pro να μπορεί να αναγνωρίσει 
το αντικείμενο μέσα στις εικόνες.  

Η περιοχή του Edit Masks Window διαθέτει όλα τα απαραίτητα εργαλεία με 
τη βοήθεια των οποίων μπορεί να επιτευχθεί ο εντοπισμός φόντου είτε 
αυτόματα είτε με το χέρι. 

Σημείωση: Αφού η διαδικασία ολοκληρωθεί είναι χρήσιμο οι εικόνες αυτές να 
αποθηκευτούν προκειμένου να χρησιμοποιηθούν σε μία εξωτερική εφαρμογή 
και να φορτωθούν εύκολα πίσω σε ένα νέο πρόγραμμα. Κάθε εικόνα με 
εντοπισμό φόντου αποθηκεύεται χρησιμοποιώντας το ίδιο όνομα αρχείου με 
την αντίστοιχη εικόνα (αλλά με μια διαφορετική επέκταση αρχείων).Η 
αποθήκευσή των μπορεί να γίνει μέσω των εντολών  Masking > Save 
Masks.. 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  42

Βήμα 1  

Για τον αυτόματο εντοπισμό φόντου όλων των εικόνων, επιλέγεται η εντολή  
Mask all images... όπου με το παράθυρο εντοπισμού φόντου Mask Wizard 
θα ξεκινήσει η διαδικασία.   

Η εφαρμογή αυτή μπορεί να χρησιμοποιηθεί και ένα συγκεκριμένο σύνολο 
εικόνων. Μέσω της εντολής Masking > Mask Images... θα ανοίξει το ίδιο 
παράθυρο διαλόγου με τη διαφορά ότι πλέον θα επηρεαστούν μόνο οι 
επιλεγμένες εικόνες. 

Βήμα 2  

Πριν ξεκινήσει η λειτουργία του εντοπισμού φόντου, μπορούν να  αλλάξουν οι 
χρησιμοποιούμενες παράμετροι ως εξής:  

Σχήμα 2.2.8

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αλλαγή ρυθμίσεων 
από το παράθυρο 
Mask Generation

 

 Είναι εφικτό να αναιρεθεί ή να αντικατασταθεί ο εντοπισμός φόντου μίας 
εικόνας απλά επιλέγοντας την εντολή "Replace any existing masks".  

 Εάν σε κάποιες εικόνες έχει ολοκληρωθεί η διαδικασία εντοπισμού,  με 
την επιλογή Unselect η συγκεκριμένη εικόνα δεν θα επηρεαστεί από 
νέες καταχωρήσεις  

 Μέσω της εντολής "Use colour normalisation"  θα αντισταθμιστούν 
πιθανές σκιάσεις ή άλλες μικρές παραλλαγές του φωτισμού στο 
σκηνικό έτσι ώστε να μην ληφθούν υπόψη κατά τη τρισδιάστατη 
μοντελοποίηση του αντικειμένου.  

 Ο τομέας "Background detection threshold" επιτρέπει την αλλαγή 
του κατώτατου ορίου κατωφλίου που χρησιμοποιείται για να χωρίσει το 
πρώτο πλάνο από το φόντο.   

Βήμα 3  

Επιλέγοντας την εντολή  Next> θα  ξεκινήσει  η διαδικασία εντοπισμού 
φόντου.  
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Σημείωση: Κατά τον εντοπισμό φόντου των εικόνων, στο παράθυρο του Edit 
Masks είναι δυνατή η παρατήρηση και ο έλεγχος της διαδικασίας για κάθε μία 
από τις εικόνες που βρίσκεται υπό μορφή  μικρογραφίας στο παράθυρο 
Thumbnail. 

Βήμα 4  

Στο στάδιο αυτό γίνεται λεπτομερής έλεγχος της παραπάνω διαδικασίας 
φορτώνοντας κάθε μία εικόνα που χρησιμοποιήθηκε στο παράθυρο Edit 
Masks.Είναι σημαντικό να μην καλύπτονται τμήματα του αντικειμένου σε 
οποιαδήποτε από τις εικόνες, ώστε να μην αλλοιωθούν αυτά αργότερα κατά 
τη δημιουργία της γεωμετρία του. Εάν δεν έχουν καλυφθεί σημεία που δεν 
αντιστοιχούν στην περιοχή του αντικειμένου, είναι λιγότερο ανησυχητικό αφού 
το 3DSOM Pro έχει την δυνατότητα να χρησιμοποιεί πληροφορίες από άλλες 
εικόνες για να καθορίσει τη μορφή του.   

 
Σημείωση: Ο αυτόματος εντοπισμός φόντου απαιτεί μια καλή αντίθεση μεταξύ 
του φόντου και του αντικειμένου. Ο φωτισμός μπορεί επίσης να έχει 
επιπτώσεις στα αποτελέσματα της παραπάνω διαδικασίας.  

Εάν ο εντοπισμός φόντου που θα προκύψει μετά το τέλος της διαδικασίας δεν 
είναι το καλύτερο δυνατό, επιλέγοντας την εντολή Back,είναι δυνατή η αλλαγή 
των αντίστοιχων παραμέτρων για την βελτίωση του τελικού αποτελέσματος. 

Εάν οι περιοχές του φόντου δεν καλύπτονται θα πρέπει να αυξηθεί  ο αριθμός 
του "Background detection threshold". Εάν ωστόσο καλύπτονται περιοχές 
του αντικειμένου τότε ο αριθμός αυτός θα πρέπει να μειωθεί. 

Βήμα 5  

Όταν επιτευχθεί το επιθυμητό αποτέλεσμα, το παράθυρο διαλόγου Mask 
Wizard θα κλείσει επιλέγοντας την εντολή τερματισμού. 

Σε μερικές περιπτώσεις ο αυτόματος εντοπισμός φόντου μιας εικόνας μπορεί 
να μην έχει καλή ακρίβεια, ωστόσο αυτό δεν αποτελεί πρόβλημα καθώς οι 
υπάρχει δυνατότητα βελτίωσης της τελικής εικόνας μέσω των παρακάτω 
επιλογών:Fine tuning the auto-masking και Manual masking with the 
shrink-wrap tool tutorials. 

 
2.2.9. Δημιουργία της επιφάνειας του μοντέλου. 
 
Το μοντέλο συρματοπλέγματος είναι το δεύτερο στάδιο στην παραγωγή ενός 
3DSOM Pro μοντέλου. Το μοντέλο συρματοπλέγματος αντιπροσωπεύει το 
σχήμα του μοντέλου σαν ένα τριγωνικό πλέγμα. Το 3DSOMPro χρησιμοποιεί 
τον εντοπισμό φόντου που σχετίζεται  με κάθε μια από τις εικόνες για να 
ενσωματώσει τη μορφή του αντικειμένου από τις σκιαγραφήσεις του.   

Οι βασικές διαδικασίες για το μοντέλο συρματοπλέγματος είναι:   
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1. Παραγωγή του μοντέλου συρματοπλέγματος.  

2. Ρύθμιση των συνολικών τριγώνων της επιφανείας.   

3. Τομή του μοντέλου με ένα επίπεδο παράλληλο με την βάση και 
ψαλιδισμός. 

 

2.2.9.1. Δημιουργία του μοντέλου συρματοπλέγματος. 
  
Πρέπει να έχει ολοκληρωθεί ο εντοπισμός φόντου για έναν ικανοποιητικό 
αριθμό εικόνων προτού ξεκινήσει αυτή τη λειτουργία. Η ελάχιστη απαίτηση 
είναι τρεις εικόνες αλλά συνήθως χρειάζονται περίπου 10 έως 30 για να 
δημιουργηθεί η ολοκληρωμένη μορφή του αντικειμένου.  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.2.9.1

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΤο αντικείμενο με την 

μορφή συρματοπλέγματος

 

Βήμα 1 

Το μοντέλο συρματοπλέγματος του αντικειμένου, παράγεται με τη βοήθεια του 
παράθυρου επιλογής Generate surface...  ή του Processing > Generate 
Surface... menu. 

Όταν ανοίξει το παράθυρο διαλόγου επιλέγεται η πρώτη επιλογή, "Generate 
wireframe", ώστε να δημιουργηθεί η αρχική επιφάνεια και έπειτα το Next > 
για να προχωρήσει. Οι άλλες επιλογές περιγράφονται στο εγχειρίδιο 
Optimising the surface geometry και Compressing the geometry with 
subdivision surfaces. 

Βήμα 2  

Είναι δυνατό να αλλάξουν οι διάφορες παράμετροι που σχετίζονται με αυτήν 
την λειτουργία πριν ξεκινήσει η δημιουργία του μοντέλου συρματοπλέγματος. 
Το αποτέλεσμα θα είναι ικανοποιητικό στις περισσότερες περιπτώσεις (οι 
επιλογές περιγράφονται λεπτομερώς στο  εγχειρίδιο 3DSOM Pro Settings 
Window).   
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Βήμα 3   

Επιλέγοντας Next> θα αρχίσει η διαδικασία δημιουργίας του μοντέλου 
συρματοπλέγματος.   

Δεν θα είναι ορατό οποιοδήποτε αποτέλεσμα έως ότου ολοκληρωθεί η 
διαδικασία, αλλά είναι δυνατό να διακοπεί εάν παίρνει πολύ ώρα. Επιλέγοντας 
την εντολή <Back το πρόγραμμα θα επιστρέψει στο προηγούμενο στάδιο 
όπου μπορεί να αυξηθεί ή να μειωθεί ο αριθμός των εικόνων που θα 
χρησιμοποιηθούν(και κατ’ επέκταση ο χρόνος ολοκλήρωσης της 
διαδικασίας),μέσω της παραμέτρου "Silluette decimation thershold" . 

Σημείωση: Aν αυτό είναι επιθυμητό, το πρόγραμμα μπορεί να επιστρέψει στο 
τελευταίο μοντέλο συρματοπλέγματος που έχει δημιουργηθεί 
χρησιμοποιώντας το Undo κουμπί, αναιρώντας οποιαδήποτε ενέργεια 
αλλαγής των παραπάνω παραμέτρων. 

2.2.9.2. Ρύθμιση των συνολικών τριγώνων της επιφανείας.  
 
Το μοντέλο αποθηκεύεται υπό μορφή πλέγματος τριγώνων < glossary.html >, 
όπου πλέον ο αριθμός τριγώνων του πλέγματος μπορεί να χρησιμοποιηθεί 
αμφίδρομα.   

Είναι δυνατό να ρυθμιστεί ο συνολικός αριθμός τριγώνων του μοντέλου 
συρματοπλέγματος μεταβάλλοντας την αντίστοιχη παράμετρο View Model 
που υπάρχει στη ράβδο εργαλείων. Έτσι μετακινώντας τον ολισθαίνοντα 
ρυθμιστή προς τ’  αριστερά θα μειωθεί η αρίθμηση πολυγώνων του μοντέλου, 
ενώ με την κίνηση του ολισθαίνοντος ρυθμιστή προς τα δεξιά θα αυξηθεί 
(μεγαλύτερος αριθμός τριγώνων της επιφάνειας αποδίδει καλύτερα 
αποτελέσματα όσον αφορά στην συσχέτισή του με την πραγματική μορφή του 
αντικειμένου).   

 Σημείωση: Εάν ένα Decimate κουμπί επιδεικνύεται στη θέση του 
ολισθαίνοντος ρυθμιστή, θα πρέπει να επιλεγεί και να περιμένετε έως ότου οι 
πληροφορίες να υπολογιστούν. Αυτό μπορεί να συμβεί μετά το τέλος 
συγκεκριμένων λειτουργιών.  

Το 3DSOM Pro έχει αποθηκεύσει τον συνολικό αριθμό τριγώνων, έτσι μπορεί 
να μεταβληθεί ο αριθμός που χρησιμοποιείται σε αυτό το στάδιο για την 
μετέπειτα επίδειξη (ακόμα και αν έχει δημιουργηθεί η υφή του μοντέλου), 
παρόλο που οι ακόλουθες διαδικασίες θα χρησιμοποιήσουν ακριβώς τον 
αριθμό τριγώνων  που επιδεικνύονται σε αυτό το στάδιο στο πλέγμα:   

 Κατά την επεξεργασία του μοντέλου θα χρησιμοποιηθούν μόνο ο 
συγκεκριμένος αριθμός τριγώνων που έχει προεπιλεγεί (εκτός από το 
3DSOM Viewer format).   
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 Η δημιουργία υφής του μοντέλου θα περιοριστεί στον αριθμό 
τριγώνων που επιδεικνύονται σε αυτό το στάδιο.   

Σημείωση:Δεν θα πρέπει να χρησιμοποιηθεί μεγαλύτερος αριθμός τριγώνων 
από αυτόν που απαιτείται για την δημιουργία του τρισδιάστατου μοντέλου . Ο 
καλύτερος τρόπος για να επιλεγεί ο κατάλληλος αριθμός τριγώνων είναι να 
παρουσιάσετε το μοντέλο επιλέγοντας F7 ή F6 και να μειωθεί έπειτα ο 
αριθμός τριγώνων έως ότου είναι ορατά τα μη αποδεκτά κομμάτια.  

2.2.9.3. Απομάκρυνση της βάσης. 
  
Μερικές φορές είναι πιθανό η γεωμετρία στη βάση του αντικειμένου να μην 
έχει διαμορφωθεί σωστά. Αυτό μπορεί να οφείλεται στο ότι δεν έχουν ληφθεί 
φωτογραφίες από μία σχετικά μικρή γωνία ή πιθανόν το φόντο στο σημείο 
αυτό να χρησιμοποιήθηκε από το πρόγραμμα ως τμήμα του αντικειμένου κατά 
τη διαδικασία εντοπισμού φόντου. 

Βήμα 1   

Σε πρώτο στάδιο επιλέγεται μια πλάγια όψη του αντικειμένου ώστε να είναι 
εμφανή τα σημεία της γεωμετρίας που θα αφαιρεθούν. 

Βήμα 2  

Επιλέγοντας το εργαλείο  Move clip plane  θα επιδειχθεί  ένα επίπεδο 
πλαίσιο κάτω από το μοντέλο. Με τη βοήθεια του ποντικιού μετακινείται το 
πλαίσιο αυτό προς τα πάνω έως ότου τοποθετηθεί στην επιθυμητή θέση. Όλη 
η γεωμετρία κάτω από το επίπεδο πλαίσιο θα αφαιρεθεί.   

Σημείωση: Σε αυτό το σημείο, ένας γρήγορος τρόπος για να περιστραφεί το 
μοντέλο και να αφαιρεθεί η γεωμετρία από διαφορετική γωνία είναι να επιλεγεί 
το CTRL ώστε να επανέρθει προσωρινά στο εργαλείο περιστροφής μοντέλου.   

Βήμα 3  

Επιλέγοντας Clip model ,το 3DSOM Pro θα δημιουργήσει ξανά το μοντέλο 
συρματοπλέγματος γύρω από το αντικείμενο χωρίς την γεωμετρία που 
αφαιρέθηκε.   

Μπορεί να χρησιμοποιηθεί η εντολή Undo για να επιστρέψει το πρόγραμμα 
στην προηγούμενη γεωμετρία.  

Είναι εφικτό να μην προχωρήσει η λειτουργία αφαίρεσης γεωμετρίας, 
κρύβοντας το επίπεδο πλαίσιο με τη βοήθεια του κέρσορα. 
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2.3. Προσθήκη της επιφάνειας υφής. 
 
Σε αυτό το εγχειρίδιο γίνεται επεξήγηση του τρόπου με τον οποίο μπορεί να 
δημιουργηθεί ένας χάρτη υφής για το μοντέλο με τη βοήθεια του 
προγράμματος 3DSOM Pro.   
Η δημιουργία του χάρτη υφής χρησιμοποιεί το μοντέλο συρματοπλέγματος και 
κάθε μια από τις αρχικές εικόνες προκειμένου να καθορίσει πώς πρέπει να 
χρωματιστεί κάθε τρίγωνο. Οι πληροφορίες από όλες αυτές τις εικόνες 
συνδυάζονται μαζί για να παρέχουν μια ομοιόμορφη υφή (χωρίς σημάδια). 

 

Οι πιο προηγμένες λειτουργίες ύφανσης περιγράφονται παρακάτω:   

 Επεξεργασία της υφής.  

 Προηγμένη επεξεργασία υφής.  

 Προσθήκη υφής στη βάση ενός αντικειμένου. 

  

2.3.1. Χρήση του προγράμματος υφής. 
 
Θα πρέπει να έχει δημιουργηθεί ένα μοντέλο συρματοπλέγματος από τις 
εικόνες με εντοπισμό φόντου σαν ένα τριγωνικό πλέγμα.   

Βήμα 1  

Επιλέγεται η εντολή Generate texture maps... ώστε να ανοίξει το παράθυρο 
διαλόγου. 

Βήμα 2  

Προτού να αρχίσει η διαδικασία, μπορούν να αλλάξουν μερικές παράμετροι 
(αυτές οι επιλογές περιγράφονται λεπτομερέστερα στο  3DSOM Pro Settings 
Window). 

 Μεταβάλλοντας τη παράμετρο "Texture map size" είναι δυνατό 
μεγαλώσει το μέγεθος των χαρτών υφής μέχρι 4096, χρησιμοποιώντας 
συνολικό αριθμό pixels 512 για ένα αντικείμενο με λίγες λεπτομέρειες ή 
1024 για ένα αντικείμενο με περισσότερες λεπτομέρειες.   

 Η επιλογή "Tone correct textures" μπορεί να χρησιμοποιηθεί για να 
ενισχύσει το χρώμα των εικόνων και να αντισταθμίσει τον ανώμαλο 
φωτισμό.   

 Η επιλογή "Texture boosting" υπογραμμίζει ένα μικρό σύνολο 
βασικών εικόνων κατά την δημιουργία των χαρτών υφής.  

Μετά τη ρύθμιση των παραπάνω επιλογών, επιλέγεται Next > ώστε να αρχίσει 
η διαδικασία δημιουργίας.  
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Σημείωση: Το 3DSOM Pro αυτόματα επιλέγει τις βασικές εικόνες 
χρησιμοποιώντας τη διαταγή εικόνας. Μπορεί με το χέρι να επιλεγεί μια εικόνα 
ως υψηλή προτεραιότητα και να αγνοηθεί η αυτόματη εικόνα λέγοντας του να 
τη μεταπηδήσει στο Thumbnail Window και να χρησιμοποιήσει από το μενού 
Images > Image Order.  

Βήμα 3   

Δεδομένου ότι κάθε εικόνα υποβάλλεται σε επεξεργασία, το μοντέλο 
ενημερώνεται συνεχώς για να απεικονίσει το χάρτη υφής. Μπορεί να 
σταματήσει η δημιουργία υφής σε οποιοδήποτε στάδιο όταν επιτευχθεί το 
επιθυμητό αποτέλεσμα, ή το αφήνετε για να τελειώσει όλες τις εικόνες.   

Επιλέγοντας την εντολή Undo το πρόγραμμα θα επιστρέψει στο προηγούμενο 
στάδιο υφής του μοντέλου ενώ με την εντολή < Back θα αλλάξει τις 
τοποθετήσεις  ή θα αρχίσει τη διαδικασία ξανά.  

Σημείωση: Το 3DSOM Pro αποκλείει τις περιοχές που έχουν καλυφθεί(φόντο) 
στις εικόνες από την υφή του μοντέλου. Εάν υπάρχουν σημεία ή άλλα μη 
επιθυμητά χαρακτηριστικά στο αντικείμενο σε οποιαδήποτε εικόνα, μπορούν 
να καλύφθούν με το χέρι πριν από την δημιουργία υφής  αλλά μετά από τη 
δημιουργία του μοντέλου συρματοπλέγματος. Μπορεί επίσης να 
δημιουργηθούν δύο αντίγραφα μιας  εικόνας ώστε η μία να χρησιμοποιηθεί 
για την δημιουργία μοντέλου συρματοπλέγματος και μια για την δημιουργία 
υφής μεσω της επιλογής του στοιχείου από το μενού Image 
Type > Geometry Only και του Image Type > Texture Only από το the 
Main Menu > Images. 

2.3.2.Εξαγωγή του ολοκληρωμένου μοντέλου. 
 
Σε αυτό το εγχειρίδιο εξηγείται πώς ένα μοντέλο μπορεί να χρησιμοποιηθεί και 
σε εξωτερικές εφαρμογές. 

Τα μοντέλα μπορούν να εξαχθούν στα ακόλουθα σχήματα χρησιμοποιώντας 
τις εντολές Export model... ή από το File > Export...  

 

 Ο θεατής 3DSOM Java ορθός σχηματισμός του πλέγματος 
χρησιμοποιώντας ένα Java applet παρά ζητώντας οποιαδήποτε για 
αστική κάλυψη - δείτε Export for 3DSOM Java Viewer.  

 3DS - αρχείο αντικειμένου για το 3d Studio Max - βλέπε την εξαγωγή 
για 3DS - 3d Studio Max.  

 W3D - shockwave Macromedia w3d φάκελος - βλέπει την εξαγωγή 
W3D - shockwave Macromedia τρισδιάστατο.    

 WRL - VRML 2,0 - βλέπει την εξαγωγή για WRL - VRML 2,0.   

 BAC, TRA - MascotCapsule - βλέπει την εξαγωγή για MascotCapsule. 
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Πολλά από τα σχήματα παραγωγής δημιουργούν διάφορα αρχεία. Κατά τη 
διάρκεια της εξαγωγής, εσείς θα καθοδηγηθείτε πριν επικαλύψετε 
οποιαδήποτε υπάρχοντα αρχεία. Η ακύρωση θα αναιρέσει την εξαγωγή αλλά 
μπορεί να αφήσει μερικά ήδη εξαγόμενα αρχεία στον επιλεγμένο κατάλογο. 

2.3.2.1. Εξαγωγή για το 3DSOM Java Viewer.  
 
Αυτή η επιλογή εξάγει το μοντέλο με ένα ορθολογικό σχήμα μαζί με ένα Java 
applet που μπορεί να ενσωματωθεί στην ιστοσελίδα για την εξέταση του 
μοντέλου. Διάφορα αρχεία παράγονται από αυτήν την επιλογή εξαγωγής:   

 Ένα ή περισσότερα αρχεία JAR που περιέχουν τα πρότυπα στοιχεία 
γεωμετρίας και υφής.   

 Αρχείο JAR που περιέχει το viewer applet (ίδιο για όλα τα εξαγόμενα 
μοντέλα).   

 Αρχείο HTML που περιέχει τη σήμανση παραδείγματος για το πως να 
χρησιμοποιήσει το θεατή στην ιστοσελίδα.   

Το 3DSOM Java Viewer είναι ένα Java applet που χρησιμοποιείται για να 
επιτρέψει στα μοντέλα που παράγονται από το 3DSOM Pro να 
ενσωματωθούν στην ιστοσελίδα. ‘’Ο θεατής’’ (viewer) μπορεί να κάνει 
ανακατανομή στο ίντερνετ του εξαγόμενου μοντέλου. Μέσα από το browser ‘’ο 
θεατής’’ δείχνει το μοντέλο και επιτρέπει στο χρήστη να εξετάσει το μοντέλο με 
την περιστροφή, τη μεγέθυνση και τη μετάφραση. Οι τελικοί χρήστες δεν 
πρέπει να φορτώσουν και να εγκαταστήσουν μια σύνδεση εφ' όσον 
χρησιμοποιούν έναν browser που περιέχει ένα Java Virtual Machine (JVM).   

Το παρασκευαστικό εργαλείο, Web Optimizer περιγράφει πώς να 
χρησιμοποιηθεί το 3DSOM Viewer Web Optimizer Window για να βελτιώσει 
το εξαγόμενο αρχείο.  

Σημείωση: Η σελίδα HTML παράγεται από ένα αρχείο προτύπων,                   
"viewer.htm "που αποθηκεύεται μέσα στο 3DSOM Pro. Οι πεπειραμένοι 
χρήστες μπορούν να τροποποιήσουν αυτό το αρχείο για να αλλάξουν την 
εμφάνιση προεπιλογής όλων των εξαγόμενων αρχείων. 

2.3.2.2. Εξαγωγή ως 3DS – 3D STUDIO MAX.  
 
Αυτή η επιλογή εξάγει το μοντέλο σε ένα αρχείο κατάλληλο για διάβασμα από 
το 3d Studio Max. Τα ακόλουθα αρχεία παράγονται από την παρακάτω 
επιλογή εξαγωγής:   

 ένα 3DS αρχείο που περιέχει το μοντέλο.  

 για τα κατασκευασμένα πλέγματα, ένα αρχείο JPG που περιέχει το 
χάρτη υφής.   
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Μπορείτε να εξαγάγετε ένα μοντέλο συρματοπλέγματος και να το εκδώσετε 
χρησιμοποιώντας 3d Studio Max και πριν το εισάγετε για την ύφανση. 

2.3.2.3. Εξαγωγή ως W3D - Macromedia Shockwave.   
 
Αυτή η επιλογή εξάγει το μοντέλο στο Macromedia shockwave 3d format. 
Διάφορα αρχεία παράγονται από αυτήν την επιλογή εξαγωγής όπως:   

 W3D αρχείο που περιέχει το ίδιο το μοντέλο (συμπεριλαμβανομένου 
του χάρτη υφής).   

Αυτό το αρχείο μπορεί να φορτωθεί απ’ ευθείας από το Macromedia Director 
8,5 (ή υψηλότερο) για να δημιουργήσει ένα παράθυρο διαλόγου.   

Εκτός από το W3D αρχείο, διάφορα άλλα αρχεία παράγονται από αυτήν την 
επιλογή εξαγωγής που επιτρέπουν σε σας να δείτε το εξαγόμενο μοντέλο 
κατευθείαν σε ένα web browser (χωρίς να πρέπει να χρησιμοποιηθεί το 
Macromedia Director): 

 Η ιστοσελίδα προτύπων HTML επιδεικνύει το μοντέλο 
χρησιμοποιώντας το ‘’θεατή’’. Αυτό θα φορτωθεί στο Macromedia 
Shockwave Player εάν αυτό είναι απαραίτητο. Είναι κατάλληλο για τη 
χρήση με Netscape και Internet Explorer.  

 Δύο αρχεία DCR (αντιγραμμένα από τον κατάλογο εγκατάστασης στον 
κατάλογο που περιέχει το μοντέλο) που περιέχουν μια στήλη προόδου 
και ένα 3DInspector, ένας ‘’θεατής’’ κατάλληλος για το μοντέλο 
χρησιμοποιώντας Macromedia Shockwave Player.  

Αυτά τα αρχεία μπορούν να διανεμηθούν ελεύθερα στο διαδίκτυο με το 
εξαγόμενο μοντέλο. Ο τελευταίος χρήστης που βλέπει την ιστοσελίδα θα 
πρέπει να εγκαταστήσει στο browser πριν αυτός να μπορεί να δει το μοντέλο. 
Εάν δεν το έχουν εγκαταστήσει το πρόγραμμα, το HTML προεπιλογής πρέπει 
να προτρέψει τον χρήστη να κατεβάσει και να εγκαταστήσει το πρόγραμμα.  

Χρησιμοποίηση του 3DInspector Shockwave Viewer. 

Με τη βοήθεια του κέρσορα θα περιστραφεί το μοντέλο και κρατώντας το 
SHIFT θα κινηθεί το μοντέλο μακριά από ή προς το χρήστη.   

Το πάτημα του σωστού κουμπιού του κέρσορα θα δείξει τις Shockwave 
επιλογές από όπου μερικές από τις τρισδιάστατες τοποθετήσεις 3D renderer 
μπορούν να ρυθμιστούν.  

2.3.2.4. Εξαγωγή ως WRL - VRML 2,0. 
 
Αυτές οι επιλογές εξάγουν το μοντέλο στο σχήμα VRML 2,0 το οποίο φαίνετε 
απευθείας από έναν VRML viewer ή για την εισαγωγή σε άλλες εφαρμογές.  
Τα δύο αρχεία που παράγονται από αυτήν την επιλογή εξαγωγής είναι:   
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 Το αρχείο WRL που περιέχει το ίδιο το μοντέλο.   

 Το αρχείο JPG που περιέχει το χάρτη υφής.   

2.3.2.5. Εξαγωγή ως MascotCapsule.  
 
Αυτές οι επιλογές εξάγουν το μοντέλο HI Corp MascotCapsule. Τα αρχεία που 
παράγονται από αυτήν την επιλογή εξαγωγής είναι:  

 μια BAC και ένα αρχείο TRA που περιέχουν το ίδιο το μοντέλο.  

 ένα BMP αρχείο που περιέχει το χάρτη υφής.   

Αυτό το σχήμα μπορεί να βελτιωθεί για εγκατάσταση κινητών τηλεφώνων 
κάνοντας κλικ στο Mascot Options Window. Συνίσταται να παραχθεί ο χάρτης 
υφής σε τρισδιάστατη μορφή - S.o.m. σε μια υψηλότερη ανάλυση (π.χ. 
512x512). Αυτή η επιλογή εξαγωγής μικραίνει το χάρτη υφής σε 128x128 με 
έναν βέλτιστο τρόπο για την εγκατάσταση κινητών τηλεφώνων. 
 

2.4.Βοηθητικές αναφορές για το χρήστη. 
2.4.1. Η κύρια ράβδος εργαλείων. 
Αυτή η ράβδος εργαλείων χρησιμοποιείται για να εκτελέσει όλες τις 
σημαντικές λειτουργίες στο 3DSOM Pro πρόγραμμα. Μπορεί να ελεγχθεί εάν 
δεν υπάρχει από το μενού View > Toolbar. 

Project operations 

Η επιλογή New project... κλείνει το τρέχον πρόγραμμα και αρχίζει ένα νέο, 
που σας προτρέπει να επιλέξετε τις εικόνες που θα χρησιμοποιήσετε για το 
νέο πρόγραμμα. Μπορούν να επιλεχθούν περισσότερες από μια εικόνες 
χρησιμοποιώντας το πλήκτρο CTRL. Όλες οι εικόνες πρέπει να είναι στον ίδιο 
κατάλογο, αλλά μπορούν να αποθηκευτούν με τα διαφορετικά σχήματα.  
Πάντα μπορούν να προστεθούν περισσότερες εικόνες αργότερα με την 
επιλογή Images > Add Images...  

 
Η επιλογή Open project... κλείνει το τρέχον πρόγραμμα και ανοίγει ένα ήδη 
αποθηκευμένο πρόγραμμα. Το 3DSOM Pro θα προσπαθήσει να βρει τις 
εικόνες αυτές από το φάκελο που ήταν αποθηκευμένες. Εάν δεν είναι εκεί, θα 
κοιτάξει στον ίδιο κατάλογο με το αρχείο του προγράμματος σε περίπτωση 
που έχει μετακινηθεί. Εάν ακόμη δεν μπορούν να βρεθούν θα πρέπει να γίνει 
έρευνα για να εντοπιστούν οι εικόνες.   

 
Η επιλογή Save project αποθηκεύει την τρέχουσα κατάσταση του 
προγράμματος. Εάν δεν έχει αποθηκευτεί ήδη το πρόγραμμα, θα 
καθοδηγηθείτε προκειμένου να εισαχθεί ένα όνομα αρχείου.  Προσοχή οι μη 
χρησιμοποιούμενες πληροφορίες δεν θα αποθηκευτούν με το πρόγραμμα 
αλλά  ούτε οι αρχικές εικόνες, οι οποίες πρέπει να κρατηθούν προκειμένου να 
συνεχίσουν να δουλεύουν με το πρόγραμμα αργότερα.  
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Η επιλογή Print mat... χρησιμοποιείται για να εκτυπώσει το δίσκο 
βαθμονόμησης. Αυτό θα ανοίξει ένα παράθυρο διαλόγου ώστε να γίνει η 
επιλογή του δίσκου που θα χρησιμοποιηθεί για να το τυπώσει. Μπορεί να 
αλλάξει το μέγεθος του δίσκου σε σχέση με τη σελίδα μέσω της εντολής 
File > Page Setup... 

Η επιλογή Change settings... ανοίγει το παράθυρο 3DSOM Pro Settings 
όπου μπορούν να αλλάξουν οι διάφορες τοποθετήσεις που συνδέονται με την 
εφαρμογή και το τρέχον πρόγραμμα. Οι τρέχουσες τοποθετήσεις 
αποθηκεύονται όταν κλείσει το 3DSOM Pro και ξαναφορτώνονται την επόμενη 
φορά που θα επανεκκιμηθεί το πρόγραμμα. Οι περισσότερες ρυθμίσεις 
επίσης αποθηκεύονται και φορτώνονται από το 3DSOM project file.  

Editing operations 

Η επιλογή Undo επιτρέπει την επιστροφή του προγράμματος είτε τον τρέχον 
εντοπισμό φόντου (όταν το Edit Masks Window είναι ενεργό) είτε το μοντέλο 
(όταν το View Model Window είναι ενεργό) στην κατάσταση πριν από την 
προηγούμενη λειτουργία. Όλες οι λειτουργίες στον εντοπισμό φόντου 
μπορούν να αλλάξουν όπως μπορεί οποιαδήποτε λειτουργία που τροποποιεί 
τον χάρτη γεωμετρίας ή υφής του μοντέλου. Να σημειωθεί  ότι οι λειτουργίες 
που έχουν σχέση με την επεξεργασία των εικόνων όπως η αλλαγή του τύπου 
τους ή η διαγραφή τους δεν είναι εφικτό να αποθηκευτούν.  

Η επιλογή Redo model or mask change εφαρμόζει ξανά την τελευταία 
χρήση που έχει ακυρωθεί κάνοντας το αμέσως μετά το Edit Model > Undo 
Model Edit, είτε στην ίδια την  φορτωμένη μάσκα είτε στο μοντέλο ανάλογα με 
εάν το Edit Masks Window ή το View Model Window είναι ενεργό.  

View operations 

Η επιλογή View as icons αλλάζει το Thumbnail Window στην επίδειξη των 
Thumnails για κάθε εικόνα.  

Η επιλογή View image details αλλάζει το Thumbnail Window σε έναν 
κατάλογο που δείχνει τις λεπτομέρειες για κάθε εικόνα στις στήλες.  

Processing operations 

Η επιλογή Mask all images... ανοίγει το Mask Wizard έτσι ώστε αυτόματα να 
δημιουργηθεί ο εντοπισμός φόντου για όλες τις εικόνες. Βλ.Masking the 
images για περισσότερες πληροφορίες.  

 
Η επιλογή Generate surface... ανοίγει το Surface Wizard ώστε να ξεκινήσει η 
δημιουργία της επιφάνειας του αντικειμένου και η βελτίωση της. Βλ. Building 
the wireframe model  για περισσότερες πληροφορίες.  
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Η επιλογή Generate texture maps... ανοίγει το Texture Wizard για την 
δημιουργία μιας νέας υφής για το μοντέλο. Βλ. Adding the surface texture για 
περισσότερες πληροφορίες.  

Η επιλογή Make all μπορεί να χρησιμοποιηθεί για να δημιουργήσει ένα 
ολοκληρωμένο μοντέλο αυτόματα. Εάν δεν έχει δημιουργηθεί ένα νέο project 
ήδη, θα φροντίσει γι’αυτό το πρόγραμμα, καθώς και για την επιλογή των 
εικόνων που θα χρησιμοποιηθούν. Οι εντολές Mask Wizard, the Surface 
Wizard και το Texture Wizard ανοίγουν και έπειτα η επιλογή Export Window 
ώστε να επιλεγεί με ποια μορφή θα αποθηκευτεί το ολοκληρωμένο μοντέλο.  
Η διαδικασία σε οποιοδήποτε σημείο μπορεί να διακοπεί. 

Η επιλογή Export model... ανοίγει το παράθυρο εξαγωγής για την εξαγωγή 
του ολοκληρωμένου μοντέλου.  

Help 

Η επιλογή User Guide... ανοίγει τη «βοήθεια» επιδεικνύοντας τα διαθέσιμα 
εγχειρίδια.  

2.4.2. Το κεντρικό μενού.   

File menu 
Το File > New στοιχείο επιλογών κλείνει το τρέχον project και ανοίγει ένα νέο, 
με το οποίο μπορούν να επιλεχθούν οι εικόνες που πρόκειται να 
χρησιμοποιηθούν για το νέο project. Μπορούν να επιλεχθούν περισσότερες 
από μια εικόνες χρησιμοποιώντας το κουμπί CTRL και πατώντας επάνω ή 
σέρνοντας γύρω από τα πρόσθετα ονόματα αρχείου. Όλες οι εικόνες πρέπει 
να είναι στον ίδιο κατάλογο, αλλά μπορούν να αποθηκευτούν με διαφορετικά 
ονόματα. Μπορούν πάντα να προστεθούν επιπλέον εικόνες αργότερα μέσω 
του μενού επιλογών Images > Add Images...  
 
Το File > Open... από το μενού επιλογών κλείνει το τρέχον project και ανοίγει 
ένα που έχει αποθηκευτεί ήδη. Το 3DSOM Pro θα προσπαθήσει να βρει τις 
εικόνες στον φάκελο που είχαν αποθηκευτεί. Εάν δεν είναι εκεί, θα κοιτάξει 
στον ίδιο κατάλογο με το αρχείο προγράμματος. Εάν δεν μπορούν ακόμα να 
βρεθούν θα πρέπει ο χρήστης να ερευνήσει για να εντοπίσει τις εικόνες.   
 
Το File > Close από το μενού επιλογών κλείνει το τρέχον project. Ωστόσο θα 
πρέπει πρώτα να αποθηκευτούν οι τρέχουσες αλλαγές του προγράμματος για 
να μη χαθούν.  
 
Το  File > Save από το μενού επιλογών αποθηκεύει την τρέχουσα κατάσταση 
του project. Εάν δεν έχει αποθηκευτεί ήδη το project, θα πρέπει να εισαχθεί 
ένα όνομα αρχείου αρχικά. Να σημειωθεί ότι οι μη χρησιμοποιημένες 
πληροφορίες δεν θα αποθηκευτούν με το πρόγραμμα αλλά ούτε οι αρχικές 
εικόνες, οι οποίες πρέπει να κρατηθούν προκειμένου να συνεχίσουν να 
δουλεύουν με το πρόγραμμα αργότερα.  
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Το File > Save As... από το μενού επιλογών αποθηκεύει την τρέχουσα 
κατάσταση του project όπως για το File > Save από το μενού επιλογών αλλά 
με ένα διαφορετικό όνομα.  
 
Το File > Page Setup... από το μενού επιλογών επιτρέπει την ρύθμιση του  
μεγέθους του δίσκου βαθμονόμησης που θα τυπωθεί. Μπορεί είτε να τεθεί η 
διάμετρος του δίσκου είτε να επιλεγεί και να εγκατασταθεί επάνω σε έναν 
επιλεγμένο αριθμό σελίδων. Προσοχή απαιτείται για τη σωστή σύνδεση των 
φύλλων που θα εκτυπωθούν. 
 
Το File > Print Preview... από το μενού επιλογών δείχνει μια πρόοψη του 
δίσκου βαθμονόμησης έτσι ώστε να δει εκ των προτέρων ο παρατηρητής πώς 
αυτός θα τυπωθεί 
 
Το File > Print Mat... από το μενού επιλογών χρησιμοποιείται για να 
εκτυπώσει το δίσκο βαθμονόμησης. Αυτό θα ανοίξει έναν διάλογο τυπωμένων 
υλών όπου είναι δυνατή η εύρεση του τύπου του εκτυπωτή που θα 
χρησιμοποιηθεί. Επιπλέον είναι δυνατό να αλλάξει το μέγεθος του δίσκου 
μέσω της εντολής File > Page Setup...  
 
Το File > Settings... από το μενού επιλογών ανοίγει το 3DSOM Pro Settings 
Window μέσω του οποίου μπορούν να αλλάξουν οι διάφορες τοποθετήσεις 
που συνδέονται με την εφαρμογή και το τρέχον project. Οι τρέχουσες 
τοποθετήσεις αποθηκεύονται όταν κλείσει το 3DSOM Pro και 
ξαναφορτώνονται την επόμενη φορά.  
 
Το File > Export... από το μενού επιλογών ανοίγει το Export Window  για την 
εξαγωγή του ολοκληρωμένου μοντέλου.  Ο τομέας της έκδοσης του 
τελειοποιημένου μοντέλου περιγράφει τις διαθέσιμες επιλογές.  
 
Το File > Exit από το μενού επιλογών κλείνει το 3DSOM Pro αφού πρώτα 
αποθηκευτεί οποιαδήποτε αλλαγή έχει γίνει στο project και δεν έχει 
αποθηκευτεί.  
 
Το Main Menu > File επιλογή αρχείων περιέχει έναν κατάλογο μέχρι 
τεσσάρων πρόσφατων ανοιχτών αρχείων σαν μια συντόμευση ώστε να 
μπορούν να ανοίξουν αυτά τα προγράμματα.   
 
Edit menu 
Το Edit > Undo από το μενού επιλογών επιστρέφει είτε στον τρέχον 
εντοπισμό φόντου (όταν το Edit Masks Window είναι ενεργό) είτε στο μοντέλο 
(όταν το View Model Window είναι ενεργό) στην κατάσταση πριν από την 
προηγούμενη λειτουργία. Όλες οι λειτουργίες στον εντοπισμό φόντου 
μπορούν να αλλάξουν όπως και οποιαδήποτε λειτουργία που σχετίζεται με τη 
δημιουργία του χάρτη γεωμετρίας ή υφής του μοντέλου.  
 
Το Edit > Redo από το μενού επιλογών εφαρμόζει την τελευταία λειτουργία 
που έχει γίνει κατ' ευθείαν μετά το Edit Model > Undo Model Edit από το 
μενού επιλογών, είτε στην τρέχουσα εικόνα με εντοπισμό φόντου που έχει 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  55

εισαχθεί είτε στο μοντέλο ανάλογα με εάν το Edit Masks Window ή το View 
Model Window είναι ενεργό.  
 
Το Edit > Copy από το μενού επιλογών (όταν το View Model Window είναι 
ενεργό και ο χάρτης υφής έχει δημιουργηθεί) αντιγράφει την τρέχουσα όψη 
του μοντέλου πάνω στο πίνακα του Window έτοιμο για την έκδοση υφής σε 
μια εξωτερική εφαρμογή. 
  
Το Edit > Paste από το μενού επιλογών (όταν το View Model Window είναι 
ενεργό) αναμιγνύει τις εικόνες στο Windows Clipboard πίσω στο χάρτη υφής. 
Η εικόνα στην περιοχή αποκομμάτων πρέπει να είναι το ίδιο μέγεθος σαν τις 
άλλες εικόνες στο πρόγραμμα και πρέπει να είναι μια έκδοση μιας 
αποκτημένης εικόνας χρησιμοποιώντας το Texture Editing > Copy Texture. 
 
View menu 
Το View > View Image Thumbnails επιδεικνύεται κάθε εικόνα που έχει 
εισαχθεί στο παράθυρο Thumbnail. 

 

Το View > View Image Details επιδεικνύει λεπτομέρειες της κάθε εικόνας 
που έχει εισαχθεί στο Thumbnail σε στήλες. 

 

Το View > Edit Mask ενεργοποιεί το Edit Masks Window για την εξέταση και 
την έκδοση των εντοπισμών φόντου, που κρύβουν το View Model Window.  

 

Το View > Edit Geometry ενεργοποιεί το View Model Windowγια την εξέταση 
και την έκδοση του μοντέλου, που κρύβει το Edit Masks Window. 

 

Το View > Toolbar εμφανίζει την κύρια εργαλειοθήκη στην κορυφή του 
3DSOM Pro window. 

  

Το View > Edit Toolbar εμφανίζει μια ράβδο εργαλείων που συνδέεται με το 
Edit Masks Window και την View Model ράβδο εργαλείων.  

 

Το View > Status Bar εμφανίζει την κύρια μπάρα στο κατώτατο σημείο του 
3DSOM Pro window.  

 
Processing menu 
Το Processing > Make All από το μενού επιλογών μπορεί να χρησιμοποιηθεί 
για να φτιάξει ένα ολοκληρωμένο μοντέλο αυτόματα. Εάν δεν έχει 
δημιουργηθεί ένα νέο project ήδη, θα φροντίσει γι’ αυτό το πρόγραμμα το 
οποίο θα προτρέψει τον χρήστη στην επιλογή των εικόνων που θα 
χρησιμοποιηθούν. Οι εντολές Mask Wizard, το Surface Wizard και  το Texture 
Wizard ανοίγουν και έπειτα με την εντολή Export Window θα γίνει η επιλογή 
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του τύπου που θα χρησιμοποιηθεί για την αποθήκευση του ολοκληρωμένου 
μοντέλου. Μπορεί να διακοπεί αυτή η διαδικασία σε οποιοδήποτε σημείο. 

Το Processing > Mask All Images... ανοίγει το Mask Wizard όπου αυτόματα 
θα δημιουργηθεί ο εντοπισμός φόντου για όλες τις εικόνες. Βλ. Masking the 
images για περισσότερες λεπτομέρειες.  

 

Το Processing > Generate Surface... ανοίγει το Surface Wizard για την 
δημιουργία της επιφάνειας του αντικειμένου και την βελτίωσης της.Βλ.  
Building the wireframe model section για περισσότερες λεπτομέρειες.  

  

Το Processing > Generate Texture Maps...ανοίγει το Texture Wizard για τη 
δημιουργία μιας νέας υφής για το μοντέλο. Βλ. Adding the surface texture για 
περισσότερες λεπτομέρειες.  

 

Images menu 
Αυτές οι επιλογές περιγράφονται στο πλαίσιο του τμήματος του Thumbnail 
Window. 

 

Mask Tools menu και Model Tools menu 
Αυτές οι επιλογές περιγράφονται στο πλαίσιο του The Edit Masks Window και 
του The View Model Window των τμημάτων αντίστοιχα.   

 

Help menu 
Το Help > User Guide...  ανοίγει τη «βοήθεια» επιδεικνύοντας τα διαθέσιμα 
εγχειρίδια.  

 

Το Help > About 3DSOM Pro... ανοίγει έναν διάλογο με τις πληροφορίες για 
την τρέχουσα έκδοση του λογισμικού και των εκδόσεων. 

 

2.4.3. Tο παράθυρο Thumbnail. 
 
Αυτό το τμήμα περιγράφει πώς να διαχειριστεί τις εικόνες σε ένα project 
3DSOM χρησιμοποιώντας το Thumbnail Window και να εκτελέσει τις 
διαδικασίες για τις πολλαπλές εικόνες αμέσως.   

 

Το Main Menu > Images μπορεί να προσεγγιστεί είτε από το κύριο μενού είτε 
με τον σωστό πάτημα Thumbnail Window. 
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Σημείωση: Εάν το πρόγραμμα περιλαμβάνει περισσότερες εικόνες από ότι 
χωράνε στην οθόνη σύρετε το διαχωριστικό κάτω από το  Thumbnail Window 
έτσι ώστε οι εικόνες να φαίνονται σε περισσότερες από μια σειρά.  

2.4.3.1. Οργάνωση των εικόνων στο παράθυρο thumbnail. 

Πατώντας το κουμπί View as icons θα αλλάξει το πεδίο του thumbnail (είναι η 
επιλογή όταν ένα πρόγραμμα φορτώνεται ή δημιουργείται). Εάν ο 
προσανατολισμός της φωτογραφικής μηχανής είναι γνωστός για μια εικόνα, 
να φαίνεται περιστροφικά έτσι ώστε το αντικείμενο είναι σχεδόν όρθιο - αυτό 
μπορεί να είναι ένας διαφορετικός προσανατολισμός στην αρχική εικόνα στο 
δίσκο.  

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.4 3. .1

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕπιλογή εικόνων στο 3D Som

 

 
Μπορούν να επιλέγούν μια ή περισσότερα thumbnails χρησιμοποιώντας τον 
κέρσορα ή το πληκτρολόγιο.  Επιλέγεται μια εικόνα πατώντας πάνω σ’ αυτήν. 
Εάν περιστραφεί γύρω από την περιοχή των εικόνων θα τις επιλέξει ή θα τις 
απελευθερώσει όλες.  Το πάτημα του CTRL θα το προσθέσει ή θα αναιρέσει 
την υπάρχουσα επιλογή.  Το πάτημα του SHIFT θα προσθέσει ή θα αναιρέσει 
όλες τις εικόνες μεταξύ της τελευταίας επιλεγμένης εικόνας και της τρέχουσας.   

Περνώντας πάνω από κάθε εικόνα με τον κέρσορα θα δημιουργηθεί μια 
εικόνα συμβουλής με τις λεπτομέρειες της κάθε εικόνας. Αυτές περιγράφονται 
στον τομέα του Image properties.   

 Μπορούν να φορτωθούν (ή να ξαναφορτωθούν) τα thumbnails με τη 
χρησιμοποίηση του Images > Load Thumbnails από το μενού επιλογών. 

2.4.3.2. Λεπτομερής οργάνωση των εικόνων. 
 
Το πάτημα του κουμπιού View image details  θα μεταπηδήσει στη 
λεπτομερή οργάνωση. Κάθε εικόνα επιδεικνύεται ως σειρά με τις διάφορες 
πληροφορίες που επιδεικνύονται στις στήλες δεξιά του ονόματος της κάθε 
εικόνας. Το περιεχόμενο των στηλών περιγράφεται στο τμήμα ιδιοτήτων της 
εικόνας.   
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Μπορούν να ταξινομηθούν οι εικόνες σε οποιαδήποτε στήλη με το πάτημα 
στην επιγραφή στηλών. Πατώντας μια δεύτερη φορά αναστρέφει την εντολή 
και η τρίτη φορά επιστρέφει στη διαταγή του προγράμματος. Ένα βέλος στην 
στήλη δείχνει ποια στήλη εάν υπάρχει ταξινομείται. Τη διαταγή είδους έχει 
επιπτώσεις στη διαταγή των εικόνων όταν επιδεικνύονται στον τρόπο 
thumbnail.   
 

2.4.3.3. Ιδιότητες των εικόνων. 
 
Αυτό το τμήμα περιγράφει τις ιδιότητες που συνδέονται με κάθε εικόνα και 
πως μπορούν αυτά να επηρεαστούν. Οι ιδιότητες αυτές είναι ορατές για τον 
χρήστη για κάθε εικόνα με το πέρασμα του κέρσορα πάνω από το αντίστοιχο 
thumbnail ή πηγαίνοντας στις λεπτομέρειες χρησιμοποιώντας το κουμπί View 
image details. 
 
"Όνομα"    
Εξ ορισμού αυτό είναι το όνομα του φακέλου της εικόνας. Αυτό είναι χρήσιμο 
στο thumbnail όπου αυτή είναι η μόνη πληροφορία που φαίνεται δίπλα σε 
κάθε εικόνα.   
 
"Τύπος"  
Οι περισσότερες εικόνες περιγράφονται σαν "normal" που σημαίνει ότι ο 
εντοπισμός φόντου που σχετίζεται με την εικόνα θα χρησιμοποιηθεί ώστε να 
δημιουργήσει τη γεωμετρία ενώ οι πληροφορίες του χρώματος στην εικόνα θα 
χρησιμοποιηθούν για να δημιουργήσουν την υφή.   
Μπορεί να αλλάξει ο τύπος επιλεγμένων εικόνων μέσω της εντολής 
Images > Image Type. Η επιλογή Image Type > Geometry Only αλλάζει τον 
τύπο "silhouette" ενώ η επιλογή Image Type > Texture Only αλλάζει τον 
τύπο "texture". Τέλος, εάν η εικόνα έχει δημιουργηθεί από την επιλογή 
Geometry Editing > Create Silhouette, κατόπιν ο τύπος θα είναι 
"synthetic".   
 
"Θέση"  
Οι εικόνες μπορούν να χαρακτηριστούν ως "rejected" με την εισαγωγή τους 
στο πρόγραμμα ή μέσω του στοιχείου επιλογών Images > Reject Images 
που σημαίνει ότι οι επόμενες διαδικασίες θα αγνοήσουν αυτήν την εικόνα. 
Στον thumbnail αυτό, ένας σταυρός φαίνεται πάνω στην εικόνα. Εξ ορισμού, 
οι εικόνες δεν θα συμπεριλαμβάνονται.  Αυτός ο τομέας θα δείξει "aligning" 
εάν αυτή η εικόνα ευθυγραμμίζεται στο στάδιο αυτό μέσω του παράθυρου 
Align. 
 
"Φωτογραφική μηχανή"  
Όταν μια εικόνα φορτώνεται σε 3DSOM Pro για πρώτη φορά, το λογισμικό 
προσπαθεί αυτόματα να βρει που τοποθετήθηκε η φωτογραφική μηχανή και 
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που τοποθετήθηκε η εικόνα σε σχέση με το αντικείμενο. Αυτό γίνεται 
αναγνωρίζοντας το δίσκο βαθμονόμηση στην εικόνα. Οι γωνίες ανύψωσης και 
περιστροφής φωτογραφικών μηχανών επιδεικνύονται σε αυτόν τον τομέα 
(στον κοντινότερο βαθμό) καθώς επίσης και ένας αριθμός που 
αντιπροσωπεύει την απόσταση του αντικειμένου.   
Σε μερικές περιπτώσεις αυτός ο τομέας θα δείξει ότι η θέση φωτογραφικών 
μηχανών δεν είναι γνωστή για μια εικόνα. Μια τέτοια εικόνα θα χαρακτηριστεί 
ως απορριπτέα, δεδομένου ότι χωρίς να ξέρει τη θέση της φωτογραφικής 
μηχανής, δεν μπορεί να χρησιμοποιηθεί. Για να διευκρινιστεί με το χέρι η θέση 
της φωτογραφικής μηχανής, επιλέγεται η εντολή Images > Align Images... 
όπως περιγράφεται και για τη βάση του αντικειμένου.  
 
"Θέση μασκών"    
Αυτός ο τομέας επιδεικνύει τη "mask created" εάν υπάρχει εντοπισμός 
φόντου για αυτήν την εικόνα.  
 
"Διάταξη" 
Αυτός ο τομέας καθορίζει τη διαταξή των εικόνων σύμφωνα με τις οποίες το 
3DSOM Pro περιγράφει τις περισσότερες πληροφορίες. Υπάρχουν διάφορες 
λειτουργίες που επεξεργάζονται τις εικόνες χρησιμοποιώντας αυτήν την 
διαταγή, όπως η βελτιστοποίηση επιφάνειας και η παραγωγή υφής.   
Είναι δυνατό για τον χρήστη να αγνοήσει την αυτόματη διαταγή 
χρησιμοποιώντας τη γνώση του αντικειμένου για να χαρακτηρίσει μερικές 
εικόνες ως υψηλή προτεραιότητα χρησιμοποιώντας τις επιλογές από το μενού 
Images > Image Order.   
 
"Μέγεθος "  
Αυτός ο τομέας δείχνει το μέγεθος της εικόνας σε ‘’pixel’’ όπως αποθηκεύεται 
σε δίσκο. 
  "Full path" 
Αυτός ο τομέας δείχνει το πλήρες όνομα της εικόνας. Εάν η εικόνα thumbnail 
δεν έχει φορτωθεί, αυτή θα είναι η τελευταία γνωστή θέση της εικόνας. Όταν 
το thumbnail φορτώνεται αρχικά, το 3DSOM Pro θα ψάξει την εικόνα στην 
τελευταία γνωστή θέση του. Εάν δεν μπορεί να βρεθεί θα κοιτάξει στον ίδιο 
κατάλογο με το αρχείο του προγράμματος, και εάν δεν μπορεί να βρεθεί εκεί ο 
χρήστης θα πρέπει να  εντοπίσει το αρχείο.   
 

2.4.3.4. Επιλογές των εικόνων. 
 
 Διαχείριση των εικόνων  
Η επιλογή Images > Select All από το μενού επιλογών και το 
Images > Select None μπορούν να χρησιμοποιηθούν ως συντομότεροι 
δρόμοι για την επιλογή των εικόνων. Να σημειωθεί ότι οι λειτουργίες που 
υφίστανται για επιλεγμένες εικόνες θα εφαρμοστούν σε όλες τις εικόνες εάν 
δεν έχει επιλεγεί καμία.   
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Η επιλογή Images > Load Thumbnails από το μενού επιλογών θα πάρει 
thumbnails απο τα επιλεγμένα αρχεία εικόνας και θα προσπαθήσει να τα 
φορτώσει στο δίσκο. Εάν όλες οι επιλεγμένες εικόνες έχουν ήδη φορτώσει τα 
thumbnails τότε αυτά θα ανανεωθούν από το δίσκο.   

 
Η επιλογή Images > Add Images... από το μενού επιλογών χρησιμοποιείται 
για να προσθέσει νέες εικόνες στο πρόγραμμα. Θα πρέπει να επιλεχθούν ένα 
ή περισσότερα αρχεία από το δίσκο και έπειτα κάθε ένας να προστεθεί στη 
συνέχεια εναλλάξ. Όπως προστίθενται οι εικόνες, η θέση των φωτογραφικών 
μηχανών υπολογίζεται. Εάν αυτό αποτύχει, επειδή ο δίσκος βαθμονόμησης 
δεν είναι στη φωτογραφία η εικόνα θα απορριφθεί. Θα πρέπει να 
ευθυγραμμίσετε αυτές τις εικόνες με το χέρι χρησιμοποιώντας το Align 
Wizard.  

  

Σημείωση: Το 3DSOM Pro θα λειτουργήσει μόνο στις εικόνες που είναι όλες 
το ίδιο μέγεθος. Οι εικόνες των διαφορετικών μεγεθών μπορούν να 
προστεθούν στο πρόγραμμα για την ευκολία, αλλά θα χαρακτηριστούν ως 
απορριπτέες.  

 

Για να αφαιρεθούν μερικές εικόνες από το πρόγραμμα, επιλέγεται το στοιχείο 
Images > Delete Images. Αυτό θα αφήσει την εικόνα άθικτη στο δίσκο, αλλά 
θα καταστρέψει οποιοδήποτε εντοπισμό φόντου έχει δημιουργηθεί στο 
3DSOM Pro και θα την αφαιρέσει από το πρόγραμμα μόνιμα.   

 
Χρησιμοποίηση των εικόνων  
Η επιλογή Images > Edit Mask από το μενού επιλογών θα φορτώσει την 
επιλεγμένη εικόνα στο Edit Masks Window για την εξέταση ή την έκδοση του 
εντοπισμού φόντου.   

 

Η επιλογή Images > View Camera από το μενού επιλογών θα αλλάξει την 
όψη των φωτογραφικών μηχανών στο View Model Window για να ταιριάζει με 
τη θέση των φωτογραφικών μηχανών που χρησιμοποιείται για να πάρει την 
επιλεγμένη εικόνα.  

 

Η επιλογή Images > Copy Image από το μενού επιλογών τοποθετεί ένα 
αντίγραφο της επιλεγμένης εικόνας στην περιοχή πλαισίου Windows έτσι 
ώστε να μπορεί εύκολα να επικολληθεί σε έναν εξωτερικό τομέα. Η εικόνα θα  
προσαρμοστεί έτσι ώστε να ταιριάζει με την αντίστοιχη υφή ως προς το 
χρώμα της.  Βλ.Advanced texture editing.   

 

Μόλις ολοκληρωθεί η γεωμετρία του μοντέλου, μπορεί να επιλεχθεί 
Images > Paste Into Model  από το μενού επιλογών για να ενσωματωθεί 
ακριβώς η επιλεγμένη εικόνα στο χάρτη υφής.  
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Διαδικασίες στις εικόνες 
 Η επιλογή Images > Include Images από το μενού επιλογών θα 
χαρακτηρίσει τις επιλεγμένες εικόνες ως "included" έτσι ώστε να 
χρησιμοποιηθούν στις επόμενες διαδικασίες. Να σημειωθεί ότι όλες οι 
"included" εικόνες πρέπει να έχουν το ίδιο μέγεθος και μια καθορισμένη θέση 
φωτογραφικών μηχανών - εάν αυτό δεν συμβεί δεν θα μπορεί να αλλάξει η 
θέση τους χρησιμοποιώντας αυτήν την εντολή.   
Η επιλογή Images > Reject Images από το μενού επιλογών θα χαρακτηρίσει 
τις επιλεγμένες εικόνες ως απορριπτέες έτσι ώστε να αγνοηθούν για τις 
επόμενες λειτουργίες συμπεριλαμβανομένης του εντοπισμού φόντου, της 
δημιουργίας επιφάνειας και της δημιουργίας υφής. Οι εικόνες που 
απορρίπτονται μπορούν να διαγραφούν από το πρόγραμμα και επίσης να 
ευθυγραμμιστούν.   

 

Η επιλογή Images > Image Type από το μενού επιλογών επιτρέπει στον 
τύπο της εικόνας να αλλαξει όπως περιγράφεται στο τμήμα ιδιοτήτων εικόνας.   

 

Η επιλογή Images > Image Order από το μενού επιλογών επιτρέπει στη 
διάταξη της εικόνας να αλλάξει. Οι εικόνες συχνά επεξεργάζονται με τη σειρά 
όπως περιγράφονται στο τμήμα ιδιοτήτων εικόνας. 

  

Η επιλογή Images > Masking από το μενού επιλογών επιτρέπει στο χρήστη  
να αναπτύξει δραστηριότητες στον εντοπισμό φόντου που συνδέονται με  τις 
επιλεγμένες εικόνες.   

 

Η επιλογή Images > Align Images... από το μενού επιλογών επιτρέπει την 
ευθυγράμμιση των επιπρόσθετων φωτογραφιών που λήφθηκαν χωρίς το 
δίσκο βαθμονόμησης ή που λαμβάνονται αφότου έχει μετακινηθεί το 
αντικείμενο. Βλ. Adding texture underneath an object   

 

2.4.4. Λειτουργία του παράθυρου εξαγωγής των καλύψεων. 
  
Στο εγχειρίδιο αυτό περιγράφονται τα εργαλεία που είναι διαθέσιμα για την 
εξέταση και την έκδοση του εντοπισμού φόντου που είναι συνδεδεμένα με 
κάθε εικόνα στο πρόγραμμα. 
  
Όλα τα διαθέσιμα εργαλεία από την εργαλειοθήκη Edit Masks μπορούν 
επίσης να χρησιμοποιηθούν μέσω των επιλογών Main Menu > Mask Tools. 
Αυτές οι επιλογές μπορούν να χρησιμοποιηθούν είτε από το menubar όταν το 
Edit Masks Window είναι ενεργό ή με τη βοήθεια του κέρσορα στο Edit Masks 
Window.  
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.4.4

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΔιαθέσιμα εργαλεία

 από το menubar

 
 

2.4.4.1. Παρατήρηση του μοντέλου.   
 Για να φορτωθεί ένας εντοπισμός φόντου σε αυτό το παράθυρο, γίνεται είτε 
με τη βοήθεια του κέρσορα και την απευθείας μετακίνηση της εικόνας από το 
Thumbnail Window, είτε διαμέσου της επιλογής των στοιχείων Images > Edit 
Mask.  

Ο εντοπισμός φόντου επιδεικνύεται ημιδιαφανής πάνω από τη χρωματιστή 
εικόνα. Η καλυμμένη περιοχή καθορίζει τα μέρη αυτής της εικόνας που δεν 
αποτελούν σίγουρα μέρος του αντικειμένου (με άλλα λόγια το φόντο).  

 
Είναι δυνατόν να αλλάξει ο τρόπος με τον οποίο επιδεικνύεται ο εντοπισμός 
φόντου από το μενού Mask Tools > Display Mask.Επιπλέον είναι  δυνατόν 
να αλλάξει και το χρώμα που χρησιμοποιείται έτσι ώστε να φαίνεται καλά σε 
σχέση με τις εικόνες που θα χρησιμοποιηθούν, με την επιλογή Settings 
Window. 

 
Με την επιλογή Zoom in ή Zoom out, μπορεί να γίνει μεγέθυνση της εικόνας 
με τη βοήθεια του κέρσορα. Εναλλακτικά, μπορεί να επιλεχθεί η επιλογή του 
ζουμ από το μενού ή από το  Mask Tools > Zoom to...   

 
Όταν μία εικόνα έχει υποστεί μεγέθυνση, ο χρήστης μπορεί να περιπλανηθείτε 
ελεύθερα σε δύο διαστάσεις με την επιλογή του Pan image. Εναλλακτικά, 
μπορεί να χρησιμοποιήσει τα scrollbars γύρω από το παράθυρο ώστε να 
περιπλανηθεί κάθετα  ή οριζόντια.  

  
Σημείωση:  Ένας σύντομος δρόμος είναι να επιλεγεί το SPACE, το οποίο 
μεταπηδάει στο Pan image ενώ ξεμαρκάρωντάς το, επιστρέφει στο 
προηγούμενο στάδιο επεξεργασίας.  
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Η επιλογή Zoom to fit αλλάζει τις μεγεθύνσεις και τις κοιλότητες έτσι ώστε 
ολόκληρη η μη μαρκαρισμένη περιοχή να χωράει μέσα στο παράθυρο.  

2.4.4.2. Επαναφορά των αλλαγών εντοπισμού φόντου. 
  
 Οι αλλαγές που μπορούν να αναιρεθούν είναι εκείνες που έχουν γίνει στην 
τρέχουσα εικόνα που φαίνετε στο Edit Masks Window.Ακόμη και οι αλλαγές 
που γίνονται στο Mask Wizard μπορούν να αναιρεθούν. Αυτό μπορεί να είναι 
ιδιαίτερα χρήσιμο για  να δεί ο χρήστης εάν ο αυτόματος εντοπισμός φόντου 
με τις διαφορετικές παραμέτρους έχει βελτιωθεί ή όχι. Να σημειωθεί ότι αυτές 
οι πληροφορίες αναίρεσης δεν αποθηκεύονται στο αρχείο προγράμματος.  
Χρησιμοποιώντας το κουμπί Undo model ή mask change που βρίσκεται 
στην κύρια ράβδο εργαλείων το πρόγραμμα θα επιστρέψει στον προηγούμενο 
εντοπισμό φόντου της εικόνας ενώ με την επιλογή Redo model ή mask 
change θα επαναφέρει την αλλαγή αυτή.  

2.4.4.3. Εργαλεία αυτόματης κάλυψης. 
  
 Τα αυτόματα Masking Tools στο Edit Masks Window επιτρέπει την 
αμφίδρομη δημιουργία εντοπισμού φόντου, επιτρέποντας στο χρήστη να 
ρυθμίσει τις παραμέτρους που θα βελτιώσουν το τελικό αποτέλεσμα. Βλ. τα 
εγχειρίδια Fine tuning the auto-masking και Manual masking with the shrink-
wrap tool για το πώς μπορούν να χρησιμοποιηθούν αυτά τα εργαλεία 
αποτελεσματικά.   
 

Με την επιλογή Regenerate mask  ο εντοπισμός φόντου θα 
επαναπροσδιοριστεί με τη βοήθεια του ολισθαίνοντος ρυθμιστή που 
εμφανίζεται στη ράβδο εργαλείων. Η μετακίνηση του ολισθαίνοντος ρυθμιστή 
ρυθμίζει επίσης το κατώτατο όριο που θα χρησιμοποιηθεί για τον αυτόματο 
εντοπισμό φόντου μέσω του Mask Wizard.  

 
Η επιλογή Shrink-wrap Mask επιτρέπει την δημιουργία εντοπισμού φόντου 
με το χέρι χρησιμοποιώντας διάφορα εργαλεία. Αντίθετα από την Regenerate 
mask αυτή η τεχνική χρησιμοποιεί τον τρέχον εντοπισμό ως αφετηρία και τον 
βελτιώνει καλύπτοντας επαρκώς οποιαδήποτε λεπτομέρεια.  

 

Το κουμπί Unmask image είναι ένας γρήγορος τρόπος για να διαγραφεί ο 
εντοπισμός φόντου μιας εικόνας. 

 
Το κουμπί Clean Mask είναι διαθέσιμο μόνο όταν έχει δημιουργηθεί κάποια 
γεωμετρία. Επιλέγοντας την εντολή αυτή, το πρόγραμμα θα  χρησιμοποιήσει 
το σχήμα του μοντέλου για να αφαιρεθεί ο εντοπισμός φόντου. Μπορεί επίσης 
να χρησιμοποιηθεί για την δημιουργία ενός αρχικού εντοπισμού φόντου για τις 
νέες εικόνες όπως χρησιμοποιείται για ένα μεγάλο σύνολο εικόνων. Βλ 
Advanced Masking for a large set of images. 
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Η επιλογή Shadows χρησιμοποιείται για να αντισταθμίσει τις σκιές στο 
σκηνικό.   

Εάν η επιλογή "Holes" έχει επιλεχθεί, τα εργαλεία αυτόματου εντοπισμού 
φόντου μπορούν να καλύψουν πιθανές τρύπες που υπάρχουν στο 
αντικείμενο.  

2.4.4.4. Εργαλεία μη αυτόματου εντοπισμού φόντου. 
 
 Τα εργαλεία μη-αυτόματου εντοπισμού φόντου επιτρέπουν στο χρήστη να 
δημιουργήσει έναν εντοπισμό φόντου με το χέρι. Συστήνουμε να αποφευχθεί 
να χρησιμοποιηθούν τα εργαλεία αυτόματου εντοπισμού φόντου οπουδήποτε 
είναι δυνατόν. .  
 Κάθε εργαλείο μπορεί να χρησιμοποιηθεί είτε με το κουμπί Paint mask που 
επιλέγεται για να καλυψει μια περιοχή είτε με το κουμπί μασκών Unpaint 
mask που επιλέγεται για να αφαιρέσει. 
 
Σημείωση: Εναλλαγή των εργαλείων μη αυτόματου εντοπισμού φόντου: Paint 
mask και Unpaint mask γίνεται με το πάτημα και το κράτημα του πλήκτρου 
CTRL. 
 
Υπάρχουν δύο εργαλεία βουρτσών για την ελεύθερη ζωγραφική. Αυτά είναι 
είτε το Round Brush είτε το Square Brush. Το μέγεθος της βούρτσας 
ρυθμίζεται χρησιμοποιώντας τον ολισθαίνοντα ρυθμιστή επάνω από αυτά τα 
εργαλεία. 
 
Η επιλογή Fill mask εκθέτει ένα απλό εργαλείο γέμισης. Το πάτημα του 
κουμπιού αυτού σε μια περιοχή μη καλυπτόμενων σημείων της εικόνας, θα τα 
καλύψει.   
 
Η επιλογή Fill Polygon επιτρέπει το γέμισμα πολυγώνων. Με διπλό κλικ του 
κέρσορα ολοκληρώνεται το γέμισμα των πολυγώνων .  
 

2.4.5. Το παράθυρο View Model. 
  
Αυτό το τμήμα περιγράφει τα διαθέσιμα εργαλεία για την εξέταση και την 
τροποποίηση του τρισδιάστατου μοντέλου που επιδεικνύεται στο παράθυρο 
View Model. 
  
Όλα τα διαθέσιμα εργαλεία από την ράβδο εργαλείων View Model μπορούν 
επίσης να επιλεγούν μέσω των εντολών Main Menu > Model Tools. Αυτές οι 
επιλογές μπορούν να χρησιμοποιηθούν είτε από το κύριο μενού όταν το View 
model window είναι ενεργό ή από το View model window.   
 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  65

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.4 5.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΔιαθέσιμα εργαλεία

 για την δημιουργία  του μοντέλου

 

2.4.5.1. Τροποποίηση γωνίας θέασης του μοντέλου. 
 
Υπάρχουν διάφορα εργαλεία για την περιστροφή του μοντέλου ωστε να είναι 
ορατό από διαφορετικές κατευθύνσεις. Αυτά όλα λειτουργούν με τη βοήθεια 
του κέρσορα. 
 
Με την επιλογή Rotate model το μοντέλο περιστρέφεται γύρω από το κέντρο 
του.   
 
Με την επιλογή του Move model το μοντέλο μετακινείται αριστερά /δεξιά και 
επάνω / κάτω. 
 
Με την επιλογή Spin model  το μοντέλο περιστρέφεται γύρω από την 
τρέχουσα όψη.   
 
Χρησιμοποιώντας το Zoom model το μοντέλο μετακινείται προς τα πίσω ή 
προς τα μπροστά, κάνοντας το να φαίνετε μικρότερο ή μεγαλύτερο.  
 
Σημείωση: Το πάτημα του CTRL επιτρέπει την εναλλαγή των εργαλείων 
αυτών. 
 
Η επιλογή της εντολής Reset view θα επιστρέψει την φωτογραφική μηχανή 
στην αρχική της θέση. Έτσι έχουμε όλο το αντικείμενο ορατό στο παράθυρο 
και περιστρεφόμενο ώστε να φαίνεται από την κατεύθυνση του "tick mark" στο 
δίσκο βαθμονόμησης.   
 
Με την επιλογή της εντολής Last view το πρόγραμμα θα επιστρέψει την όψη 
στην προηγούμενη θέση της.  

2.4.5.2. Αναπαράσταση του μοντέλου. 
 
Η επιλογή View wireframe model επιδεικνύει το μοντέλο με γραμμές γύρω 
από τις άκρες κάθε τριγώνου. Αυτό μπορεί να χρησιμοποιηθεί για να πάρουμε 
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μια ιδέα απο το πόσα τρίγωνα υπάρχουν στο πλέγμα και που είναι πυκνά ή 
αραιά. 
 
Η επιλογή View flat shaded model  επιδεικνύει το μοντέλο σαν ένα στερεό 
αντικείμενο αλλά χωρίς υφή. Αυτό είναι ένας καλός τρόπος επίδειξης για να 
χρησιμοποιηθεί κατά τη μείωση του αριθμού τριγώνων στο πλέγμα δεδομένου 
ότι θα φανεί σε ποιο σημείο η μορφή του αντικειμένου αρχίζει να αλλάζει.  
 
 Σημείωση: Είναι μερικές φορές χρήσιμο να αφαιρεθεί η υφή ώστε να μας  
βοηθήσει να δούμε το σχήμα. Μπορούν επίσης να αλλάξουν τα χρώματα που 
χρησιμοποιούνται για το φόντο και το μοντέλο συρματοπλέγματος από το 
3DSOM Pro Settings Window.  
 
Η επιλογή View textured model επιδεικνύει το τελικό μοντέλο με έναν χάρτη 
υφής που παράγεται από τις εικόνες.   
 
Η επιλογή View Dependent Textures επιδεικνύει το μοντέλο 
χρησιμοποιώντας μια υφή εξαρτώμενης όψης - αυτή η υφή θα αλλάξει 
ανάλογα με την όψη του μοντέλου ώστε να αναγνωρίσει τις πιο λεπτομερείς 
παραλλαγές των αρχικών εικόνων.   
 
Ενώ το μοντέλο υφής επιδεικνύεται, η επιλογή Use Light Source 
παρουσιάζει μια εικονική πηγή φωτός. Αυτό είναι μια χρήσιμη 
προεπισκόπηση εάν πρόκειται να εξαχθεί το μοντέλο σε τρισδιάστατη μορφή 
όπου ίσως επαναφορτωθεί από τον χρήστη. 

Σημείωση: Μπορούν να χρησιμοποιηθούν συντομότεροι δρόμοι μέσω του 
πληκτρολόγιου που εναλλάσουν διαφορετικούς τρόπους επίδειξης: View 
wireframe model (F5), View flat shaded model (F6), View textured model 
(F7), and View Dependent Textures (F8).  

Η επιλογή Toggle calibration mat επιδεικνύει ένα εικονικό δίσκο 
βαθμονόμησης. Αυτό μπορεί να είναι χρήσιμο ώστε το πρόγραμμα να 
αντιληφθεί το ισότιμο σύστημα του αντικειμένου, ιδιαίτερα κατά τη διάρκεια της 
λειτουργίας ευθυγράμμισης.   
 
Η επιλογή Display Mode > Display Cameras από το μενού επιλογών 
τοποθετεί τις εικόνες στο πρόγραμμα. Κατά τη διάρκεια της ευθυγράμμισης, οι 
φωτογραφικές μηχανές που ευθυγραμμίζονται στο στάδιο αυτό διακρίνονται 
με κόκκινο. 
 
Για να προσδιοριστεί η θέση της φωτογραφικής μηχανής, επιλέγεται 
προσωρινά το παράθυρο Align Wizard για να δοθεί έμφαση σε αυτήν, 
ωστόσο μετά τον καθορισμό της θέσης της φωτογραφικής μηχανής, η 
λειτουργία θα πρέπει να απενεργοποιηθεί. 
 
 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  67

2.4.5.3. Εργαλεία επεξεργασίας του παράθυρου thumbnail. 
 
Κατά τη διάρκεια της λειτουργίας ευθυγράμμισης, μια από τις εικόνες που 
ευθυγραμμίζεται παρουσιάζεται ως φόντο πίσω από το μοντέλο έτσι ώστε το 
μοντέλο να μπορεί να είναι σε θέση να ταιριάξει με την εικόνα. Για να γίνει 
αυτό ακριβέστερα, υπάρχουν μερικά πρόσθετα εργαλεία που μπορούν να 
χρησιμοποιηθούν κατά τη διάρκεια της λειτουργίας ευθυγράμμισης.   
 
Η επιλογή Magnify View, ζουμάρει την τρέχουσα εικόνα που επιτρέπει την 
παρατήρηση λεπτομερειών. Η επιλογή αυτή διαφέρει από το Zoom model,η 
οποία μετακινεί τη φωτογραφική μηχανή πιο κοντά στο αντικείμενο 
αλλάζοντας την οπτική, αντί να κρατάει το αντικείμενο σταθερό σε σχέση με το 
φόντο.   
 
Η επιλογή Pan View, κρατά το αντικείμενο σταθερό σε σχέση με το φόντο. 
Πάλι αυτό διαφέρει από το move model που θα κινούσε το αντικείμενο 
ανάλογα με την εικόνα του φόντου.   
 
Η επιλογή της εντολής Full Image επιτρέπει την μεγιστοποίηση έτσι ώστε 
ολόκληρη η εικόνα να χωράει μέσα στο παράθυρο. 

2.4.5.4. Έλεγχος του τριγωνικού πλέγματος. 
 
Το μοντέλο παρουσιάζεται ως τριγωνικό πλέγμα δηλαδή με έναν αριθμό 
τριγώνων ο οποίος ποικίλλει από πλευρά σε πλευρά.  
Ο αριθμός των τριγώνων σ’ αυτήν την περίοδο ως πλέγμα παρουσιάζεται από 
την επιλογή της εντολής View Model. Κάτω από αυτό, υπάρχει ένας 
ρυθμιστής που μπορεί να χρησιμοποιηθεί για να αλλάξει από όλες τις 
πλευρές τον αριθμό τριγώνων. Εναλλακτικά, ο χρήστης μπορεί να 
πληκτρολογήσει άμεσα τον αριθμό των τριγώνων που επιθυμεί.   
 
Σημείωση: Εάν ο ρυθμιστής αντικατασταθεί απο μία επιλογή συνολικού 
αριθμού τριγώνων, τότε η διαδικασία αυτομάτως θα ακυρωθεί. Θα πρέπει να 
επιλεχθεί η εντολή αυτή ξανά ώστε να ξαναδημιουργηθεί ο συνολικός αριθμός 
τριγώνων και να εμφανιστεί πάλι ο ολισθαίνων ρυθμιστής.  
 
Μπορεί να αλλάξει ο αριθμός τριγώνων ακόμα και όταν το μοντέλο έχει υφή, 
αλλά μπορεί να χρειαστεί να δημιουργηθεί ξανά η υφή του μόλις επιλεχθεί ο 
τελικός αριθμός τριγώνων καθώς τα αποτελέσματα μπορεί να είναι 
διαφορετικά. Βλ. Building wireframe model, για περισσότερες λεπτομέρειες 
όσον αφορά στην επιλογή του κατάλληλου αριθμού τριγώνων.  

2.4.5.5. Εργαλεία ελέγχου γεωμετρίας. 
  
Οι επιλογές αυτού του εγχειρίδιου χρησιμοποιούνται για να τροποποιήσουν τη 
μορφή του υπάρχοντος μοντέλου και άρα χρησιμοποιούνται μόνο αφού έχει 
δημιουργηθεί κάποια γεωμετρία.   
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Η επιλογή Create silhouette θα δημιουργήσει μια νέα εικόνα στο πρόγραμμα 
από την τρέχουσα όψη, χρησιμοποιώντας την τρέχουσα γεωμετρία για να 
καθορίσει τον εντοπισμό φόντου της εικόνας. Αυτή η εικόνα μπορεί έπειτα να 
εκδοθεί η οποία θα τροποποιήσει τη γεωμετρία την επόμενη φορά που θα 
δημιουργηθεί. Εάν ο χάρτης υφής έχει επίσης δημιουργηθεί, μπορεί να 
αποθηκευτεί σε ένα αρχείο εικόνας σε δίσκο που συνδέεται με τη νέα εικόνα.  
Το εγχειρίδιο Adding synthetic silhouettes εξηγεί πώς μπορεί να 
χρησιμοποιηθεί αυτό. 
 
Με την επιλογή Move clip plane επιδεικνύεται επίπεδο πλαίσιο με το οποίο 
μπορεί να απομακρυνθεί οποιοδήποτε σημείο του μοντέλου που απεικονίζεται 
λανθασμένα ιδιαίτερα στη βάση του αντικείμενου. Για να συμβεί αυτό το 
επίπεδο πλαίσιο θα πρέπει να μετακινηθεί επάνω ή κάτω με τη βοήθεια του 
κέρσορα. 
 
Η επιλογή Clip model αναγκάζει όλη τη γεωμετρία κάτω από το τρέχον 
επίπεδο να αφαιρεθεί. Μπορεί να αναιρεθεί η λειτουργία αυτή με την επιλογή 
Edit Model > Undo Model Edit. Βλ Building wireframe model, για 
περισσότερες λεπτομέρειες.   

2.4.5.6. Εργαλεία ελέγχου υφής. 
 
Αφού δημιουργηθεί ένας χάρτης υφής, μπορεί το μοντέλο αυτό να εκδοθεί 
χρησιμοποιώντας μια διαισθητική 2D με τη λήψη ενός αντίγραφου του 
μοντέλου από μια ιδιαίτερη όψη, το οποίο την τροποποιεί σε ένα χωριστό 
αρχείο έκδοσης εικόνας, και έπειτα το κολλάει πίσω στο μοντέλο. Το Editing 
the textures και Advanced texture editing περιγράφουν τους διαφορετικούς 
τρόπους με τους οποίους αυτή η τεχνική μπορεί να χρησιμοποιηθεί. 
 
Η επιλογή Copy View  εμφανίζει το μοντέλο μέσω μιας εικονικής 
φωτογραφικής μηχανής από την τρέχουσα όψη και το τοποθετεί στην περιοχή 
πλαισίου. 
   
Η επιλογή Paste View συνδυάζει την εικόνα στην περιοχή πλαισίου στον 
τρέχοντα χάρτη υφής. Η εικόνα πρέπει να έχει τις ίδιες διαστάσεις με τις άλλες 
εικόνες στο πρόγραμμα. Μπορεί να αναιρεθεί αυτή η λειτουργία με την 
επιλογή Edit Model > Undo Model Edit από το μενού επιλογών.   

2.4.6. Ρύθμιση παραμέτρων του προγράμματος.  
  
Το 3DSOM Pro Settings Window μπορεί να ανοίξει με την επιλογή του 
Change settings... ή την επιλογή File > Settings...  
 
Όλες οι τοποθετήσεις αποθηκεύονται και φορτώνονται από το 3DSOM αρχείο 
προγράμματος εκτός από την επιλογή "Automatically scroll canvas when 
painting". Για να επιστρέψει το πρόγραμμα στις προκαθορισμένες τιμές για 
όλες τις τοποθετήσεις, επιλέγεται η εντολή Defaults. Επιλέγοντας ΟΚ θα 
διατηρηθούν οποιεσδήποτε αλλαγές που έχουν γίνει. Με την επιλογή Cancel 
οποιεσδήποτε αλλαγές έχουν γίνει θα απορριφθούν.   
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Οι περισσότερες από τις τοποθετήσεις μπορούν να ρυθμιστούν κάνοντας 
μεμονωμένα βήματα επεξεργασίας, εντούτοις μπορεί να είναι χρήσιμο να 
οργανωθούν οι προκαθορισμένες αξίες έτσι ώστε οι λειτουργίες όπως η 
Processing > Make All να μπορούν να τρέξουν χωρίς διακοπή. Οι 
περισσότερες τοποθετήσεις αποθηκεύονται επίσης με το πρόγραμμα 
3DSOM, έτσι  πάντα θα υπάρχουν οι αρχικές επιλογές την επόμενη φορά που 
θα φορτωθεί το πρόγραμμα.  
 
‘‘Τοποθετήσεις παραγωγής μασκών’’    
 
Αυτές οι τοποθετήσεις έχουν επιπτώσεις στην αυτόματη δημιουργία 
εντοπισμού φόντου που χρησιμοποιείται στο Mask Wizard (που 
περιγράφονται στο τμήμα Masking the images) και στην αρχική συμπεριφορά 
του ολισθένοντα ρυθμιστή εντοπισμού φόντου και τις εντολές Regenerate 
mask ,Shrink-wrap Mask. 
 
Το "Background detection threshold" ελέγχει κατά πόσο η εικόνα 
αντιμετωπίζεται σαν φόντο όταν αυτό καλύπτεται. Μια υψηλότερη αξία 
παράγει περισσότερη κάλυψη.  
 
Όταν επιλέγεται η εντολή "Use colour normalisation" (ορατή στη Edit Masks 
ως επιλογή "Shadows") ο αυτόματος εντοπισμός φόντου προσπαθεί να 
αντισταθμίσει τις σκιές που αφορούν το σκηνικό.  
 
‘‘Wireframe Generation Properties’’ 
 
Η επιλογή "Default number of triangles" καθορίζει τον αρχικό αριθμό 
τριγώνων που θα χρησιμοποιηθούν για την επίδειξη του μοντέλου όταν 
δημιουργηθεί. Ο αριθμός των τριγώνων μπορεί επίσης να αλλάξει αμφίδρομα 
αφότου έχει δημιουργηθεί η γεωμετρία. 
  
Η επιλογή "Maximum surface error" είναι ένας εναλλακτικός προηγμένος 
τρόπος καθορισμού των πόσων τρίγωνων θα επιδειχθούν αφότου έχει 
ολοκληρωθεί η δημιουργηθεί μοντέλου συρματοπλέγματος που είναι χρήσιμο 
όταν ανιχνεύονται πολλά αντικείμενα. Εάν αφεθεί στην μηδενική 
προκαθορισμένη αξία, κατόπιν θα αγνοηθεί.   
 
Όταν η επιλογή "Automatically align high-angle cameras" επιλέγεται κατά 
τη διάρκεια της δημιουργίας μοντέλου συρματοπλέγματος, το 3DSOM Pro θα 
προσπαθήσει αυτόματα να ρυθμίσει οποιεσδήποτε εικόνες που έχουν ληφθεί 
από μεγάλες γωνίες για να αντισταθμίσει τη βαθμονόμηση. Πρέπει να 
χρησιμοποιηθεί αυτή η επιλογή μόνο εάν υπάρχει πρόβλημα με τη γεωμετρία 
λόγω της ευθυγράμμισης των φωτογραφικών μηχανών μεγάλης γωνίας, 
συχνά ορατής ως ένα μοντέλο που γίνεται πολύ λεπτό όταν περιλαμβάνονται 
αυτές οι εικόνες.   
 
"Ιδιότητες παραγωγής υφής"   
Αυτές οι τοποθετήσεις έχουν επιπτώσεις στην παραγωγή υφής στο Texture 
Wizard (που περιγράφεται στο Adding the surface texture).   
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Η επιλογή "Texture map size" θέτει ως μέγεθος το μέγεθος των pixels του 
χάρτη υφής. Ο χάρτης υφής είναι πάντα τετραγωνικός και το μέγεθος 
καθορίζει την ανταλλαγή μεταξύ της λεπτομέρειας στην υφή και του ποσού 
αποθήκευσης που απαιτείται για το χάρτη υφής. Γενικά οι τιμές όπως 512 ή 
1024 pixels τείνουν να είναι επαρκείς για τις περισσότερες χρήσεις. Η μέγιστη 
επιτρεπόμενη θα εξαρτηθεί από τη διαθέσιμη φυσική μνήμη. Για τα 
συστήματα με 0.5Gb της μνήμης το μέγιστο είναι περίπου 2048 pixels. Για τα 
συστήματα με 2Gb της μνήμης ή περισσότερο το μέγιστο θα είναι μέχρι 4096 
pixels. Το πραγματικό μοντέλο που επιδεικνύεται μπορεί να χρησιμοποιήσει 
ένα υποδειγματικό χάρτη υφής ανάλογα με τους πόρους καρτών γραφικής 
παράστασης.  
 
Όταν η επιλογή "Tone correct textures" επιτρέπεται, το 3DSOM Pro θα 
προσπαθήσει να αντισταθμίσει τις παραλλαγές στην έκθεση μεταξύ των 
εικόνων που διαφορετικά θα ανάγκαζαν τη επιφάνεια υφής να έχει 
ανεπιθύμητες παραλλαγές στην ένταση. Εάν χρησιμοποιηθούν οι ελεγχόμενες 
συνθήκες φωτισμού ή δοκιμάζονται αλλαγές χρώματος στην υφή ίσως να είναι 
επιθυμητό να απενεργοποιηθεί αυτήν η επιλογή.   
 
Όταν επιλεχθεί η εντολή "Texture boosting", το 3DSOM Pro αυτόματα 
επιλέγει ένα σύνολο μέχρι 6 βασικών όψεων και χρησιμοποιεί αυτές για να 
προσθέσει τη λεπτομέρεια στο χάρτη υφής. Διαφορετικά, το 3DSOM Pro θα 
προσπαθήσει να συνδυάσει μαζί τις πληροφορίες από όλες τις εικόνες, οι 
οποίες μπορούν να οδηγήσουν σε θόλωμα ή να σκιάσουν τις λεπτομέρειες, 
ιδιαίτερα εάν υπάρχει οποιαδήποτε μικρή εγγραφή, ανακρίβειες στη 
γεωμετρία, ή τη μετακίνηση του αντικειμένου κατά τη διάρκεια της 
φωτογραφίας.   
 
 
"Ιδιότητες εξαγωγής"  
 
Αυτές οι τοποθετήσεις έχουν επιπτώσεις στις προκαθορισμένες αξίες στο 
παράθυρο εξαγωγής (που περιγράφεται στο τμήμα Exporting the finished 
model).   
 
Η επιλογή "Texture quality" μειώνει το μέγεθος του χάρτη υφής όπως 
αποθηκεύεται σε δίσκο με την αλλαγή της συμπίεσης εις βάρος της μείωσης 
της ποιότητας υφής - αυτό είναι μια αξία μεταξύ 1 (χαμηλότερη ποιότητα) και 
100 (υψηλότερη ποιότητα).   
 
Η επιλογή "Geometry quality"  καθορίζει πως το στοιχείο γεωμετρίας 
συμπιέζεται και είναι μια αξία μεταξύ 1 (χαμηλότερη ποιότητα, μικρότερο 
μέγεθος) και 100 (υψηλότερη ποιότητα, μεγαλύτερο μέγεθος). Οι τιμές κάτω 
από 50 δεν συστήνονται για την κανονική χρήση.   
 
"Ιδιότητες χώρου εργασίας"  
 
Αυτές οι τοποθετήσεις ελέγχουν πώς ο εντοπισμός φόντου και το μοντέλο 
επιδεικνύονται στο Edit Masks Window και το View Model Window.   
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Τα διάφορα χρώματα χρησιμοποιούνται στη επαφή και μπορούν να αλλάξουν 
για να ταιριάξουν στις εικόνες και τα αντικείμενα στα οποία εκτίθονται. Η 
αλλαγή του επιδειχθέντος χρώματος εντοπισμού φόντου μπορεί να είναι πολύ 
χρήσιμη κατά τη διάρκεια της έκδοσης του. Ομοίως, κατά την ευθυγράμμιση 
των εικόνων, η αλλαγή του μοντέλου συρματοπλέγματος ή των στερεών 
χρωμάτων μπορεί να το καταστήσει ευκολότερο στο να γίνει ορατό το τι 
συμβαίνει.   
 
Η επιλογή "Automatically scroll canvas when painting" χρησιμοποιείται 
για να σταματήσει το Edit Masks Window όταν χρωματίζεται κοντά στην άκρη 
του παραθύρου. Η χρήση με συγκεκριμένες κάρτες γραφικής παράστασης ή 
εναλλακτικές χρήσης κέρσορα όπως μια ταμπλέτα, αυτό το χαρακτηριστικό 
μπορεί να κάνει δύσκολο τη ζωγραφική.  
 

2.5. Ειδικές εντολές βελτίωσης του μοντέλου. 
 

2.5.1 Καλιμπράρισμα των φακών.  
 
 Οι τυποποιημένοι φακοί ζουμ και ευρυγώνιων φακών προκαλούν σημαντική 
διαστρέβλωση της εικόνας. Οι ευθείες γραμμές στις άκρες της εικόνας μπορεί 
να εμφανιστούν κυρτές με αποτέλεσμα να επηρεάζεται άμεσα η ακρίβεια της 
διαδικασίας διαμόρφωσης.   

Το πρόγραμμα 3DSOM pro μπορεί αυτόματα να αναγνωρίσει πολλούς 
τυποποιημένους φακούς χρησιμοποιώντας τις ετικέτες EXIF σε εικόνες JPEG 
– οι πληροφορίες αυτές περιλαμβάνονται στις εικόνες των περισσοτέρων 
ψηφιακών φωτογραφικών μηχανών. Όσον αφορά ήδη καθορισμένους 
φακούς, το 3DSOM pro θα διορθώσει αυτόματα πιθανή διαστρέβλωση της 
εικόνας.   

Σε περίπτωση μη καθορισμένου φακού, το 3DSOM pro παρέχει ένα 
πρόγραμμα ΑΑυυττόόμμααττηηςς  ΒΒααθθμμοοννόόμμηησσηηςς  ΦΦαακκώώνν((LLeennss  CCaalliibbrraattiioonn  wwiizzaarrdd)) 
που επιτρέπει στο χρήστη  να τραβήξει επιπρόσθετες φωτογραφίες ώστε το 
καλιμπράρισμα να γίνει αυτόματα. Μόλις αυτό επιτευχθεί, οι νέες 
φωτογραφίες θα έχουν διορθωθεί όταν αυτές φορτωθούν από το δίσκο.   

 Η διαδικασία βαθμονόμησης των φωτογραφικών φακών παρουσιάζεται 
παρακάτω:   

 Ενεργοποιείται η αυτόματη βαθμονόμηση φακών επιλέγοντας 
File>Calibrate Lens…Όταν το παράθυρο ανοίξει μαρκάρεται η πρώτη 
επιλογή,’’New calibration’’ ώστε το καλιμπράρισμα να ξεκινήσει από 
τις φωτογραφίες. 

  Κατόπιν με την επιλογή Next>προωθείται η επόμενη σελίδα του 
προγράμματος.  
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Βήμα 1 
Το πρώτο βήμα είναι να εκτυπωθεί ο δίσκος βαθμονόμησης φακών (ένα 
πλέγμα σημείων)επάνω σε ένα λευκό φύλλο Α4. 

 Επιλέγοντας την εντολή Print calibration grid ανοίγει το παράθυρο 
διαλόγου  εκτύπωσης.   

 
ΣΗΜΕΙΩΣΗ:Σε ιδανικές περιπτώσεις, το μέγεθος του δίσκου βαθμονόμησης 
που θα εκτυπωθεί θα πρέπει να είναι ίδιο με  το αντίστοιχο μέγεθος του υπο 
διαμόρφωση αντικειμένου. Επιπλέον οι φωτογραφίες του δίσκου σωστό θα 
ήταν να ληφθούν από την ίδια απόσταση σε σχέση με τις  φωτογραφίες των 
αντικειμένων. Εντούτοις αυτό δεν είναι ουσιαστικό.   
 

 Επιλέγοντας  την εντολή ‘’Change…’’ γίνεται  τροποποίηση  της  
οργάνωσης και των περιθωρίων της σελίδας που επιτρέπουν στο 
χρήστη να τυπώσει μεγαλύτερους δίσκους σε πολλαπλές σελίδες. 

  Τέλος επιλέγεται η εντολή ΟΚ ώστε να γίνει η εκτύπωση.  

 
Βήμα 2 
Σε δεύτερο στάδιο ο δίσκος βαθμονόμησης φακών θα πρέπει να τοποθετηθεί 
επάνω σε μια επίπεδη επιφάνεια όπως ένα άκαμπτο κομμάτι κάρτας ή ενός 
τοίχου. 

Εάν έχουν τυπωθεί πολλά φύλλα απαιτείται προσοχή  για  την σωστή 
παράταξή τους  σύμφωνα με τις οδηγίες  

Για να γίνει καλιμπράρισμα ενός δίσκου βαθμονόμησης με σταθερό μήκος 
εστίασης θα πρέπει ληφθούν μέχρι 3 εξ’ όψεως φωτογραφίες(σε μια γωνία 
μικρότερη των 10 μοιρών).Για το καλιμπράρισμα πλέγματος με ζουμ, η λήψη 
των φωτογραφιών εξ’ όψεως θα πρέπει να είναι αντίστοιχες των ρυθμίσεων 
zoom που έχουν προεπιλεγεί. Θα πρέπει να σημειωθεί ότι εάν η φωτογραφική 
μηχανή δεν εξάγει τις εικόνες JPEG με τις ετικέτες EXIF θα πρέπει να 
ρυθμιστεί το ζουμ θέτοντάς το ίδιο για όλες τις φωτογραφίες και να θεωρηθεί 
ως σταθερού μήκους εστίασης φωτογραφική μηχανή.   

 
Γενικά σημεία που πρέπει να υπογραμμιστούν… 

 Ο δίσκος βαθμονόμησης  θα πρέπει να είναι επίπεδος.   

 Η κατεύθυνση της φωτογραφικής μηχανής θα πρέπει να είναι τέτοια      
ώστε να μην υπάρχει μεγάλη πιθανότητα διαστρέβλωσης της εικόνας.   

 Τα σημεία θα πρέπει να καλύπτουν όλη την εικόνα.   

 Δεν είναι απαραίτητο να φαίνεται ολόκληρος ο δίσκος αλλά να είναι 
ορατά σε σειρά τουλάχιστον 6 σημεία σε κάθε  φωτογραφία.  

 Για μεγέθυνση των σημείων θα πρέπει να μετακινηθεί η φωτογραφική 
μηχανή μακρυά από τον δίσκο.   

 Η λήψη θα πρέπει να είναι  ξεχωριστή για κάθε ρύθμιση ζουμ. 

 Χρήση τρίποδου εάν αυτό είναι διαθέσιμο.   
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Βήμα 3 
Αφού γίνει λήψη των φωτογραφιών, αυτές μεταφέρονται και φορτώνονται 
στον υπολογιστή επιλέγοντας την εντολή Load photos. 
 
Βήμα 4 
Όταν η παραπάνω επεξεργασία ολοκληρωθεί είναι δυνατή η παρατήρηση των 
εικόνων που εισήχθησαν καθώς επίσης και των διορθωμένων ως αποτέλεσμα 
της βαθμονόμησης  φακών. Τα σημεία βαθμονόμησης θα πρέπει πλέον να 
εμφανίζονται σε ευθεία γραμμή.  

Τα σημεία βαθμονόμησης μπορούν να αποθηκευτούν για περαιτέρω χρήση 
τους στο μέλλον με την εντολή Save.Για να φορτωθεί ξανά μια ρύθμιση 
μπορεί να χρησιμοποιηθεί η επιλογή ‘’Load existing calibration settings’’. 
Επιλέγοντας  την εντολή Finish είναι δυνατή η χρήση των ρυθμίσεων αυτών. 
Οι εισαγόμενες φωτογραφίες (χρησιμοποιώντας την εντολή New project ή 
Images>Add Images..) θα είναι τώρα διορθωμένες σύμφωνα με τα 
αποτελέσματα της βαθμονόμησης.   

 

2.5.2. Τελειοποίηση του αυτόματου εντοπισμού φόντου. 
 
Μερικές φορές ο αυτόματος εντοπισμός φόντου της εικόνας  με τις 
προεπιλεγμένες ρυθμίσεις έχει σαν αποτέλεσμα μία ανεπαρκή διαμόρφωση 
μοντέλου(μάσκα). Ο καθορισμός μίας και μόνο επιλογής εντοπισμού φόντου 
για ολόκληρη την εικόνα μπορεί να απαιτήσει πολλές  δοκιμές  και να 
οδηγήσει σε λάθη ενώ μπορεί επίσης να απαιτηθεί συνδυασμός των 
επιλογών για τις διαφορετικές  περιοχές(γεωμετρία) της εικόνας.   

Το πρόγραμμα 3DSOM Pro παρέχει μία δυνατότητα αυτόματου εντοπισμού 
φόντου,η οποία  επιτρέπει τη χρήση πολλών ρυθμίσεων μαζί ώστε η 
διαμόρφωση που θα προκύψει να αναφέρεται στην πραγματικότητα. Οι 
ρυθμίσεις αυτές μπορούν να εφαρμοστούν σε μια επιλεγμένη περιοχή. 

 
Βήμα 1  
Aφού εισαχθούν στο πρόγραμμα μία ή περισσότερες εικόνες, επιλέγεται μία 
εξ αυτών με διπλό κλικ και μέσω της εντολής RReeggeenneerraattee  mmaasskk  από το 
κεντρικό μενού EEddiitt  mmaasskkss  ενεργοποιείται ο αυτόματος εντοπισμός φόντου. 

ΣΗΜΕΙΩΣΗ: Εάν αυτό είναι επιθυμητό μπορεί να ρυθμιστεί έτσι η 
κανονικοποίηση χρώματος της εικόνας ώστε οι σκιές στο χρωματισμένο 
σκηνικό να αγνοηθούν. Ωστόσο θα πρέπει να  έχει επιλεγεί εξ αρχής ο 
τετραγωνισμένος εντοπισμός φόντου πριν την ενεργοποίηση του αυτόματου.  

 

Βήμα 2  
Μετακινώντας τον ολισθαίνοντα ρυθμιστή  αυτόματου εντοπισμού φόντου 
μπορεί να επιτευχθεί το επιθυμητό αποτέλεσμα. Κινώντας τον  προς τα δεξιά 
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θα δημιουργηθεί περισσότερο χρώμα εντοπισμού φόντου ενώ προς τα 
αριστερά θα προκύψει το αντίθετο αποτέλεσμα.  

ΣΗΜΕΙΩΣΗ: Εάν η διαμόρφωση του εντοπισμού του φόντου  
πραγματοποιείται πάρα πολύ αργά συγκριτικά με τον ολισθαίνοντα ρυθμιστή  
όσον αφορά μεγάλες εικόνες, είναι δυνατόν να εφαρμοστεί νέος τρόπος 
διαμόρφωσής του με την εντολή Display Mask>Solid Mask.   

 
Βήμα 3  
Επιλέγοντας ή ξεμαρκάρωντας το τετραγωνίδιο’’Holes’’ επιτρέπονται ή 
περιορίζονται οι τρύπες στο αντικείμενο. Εάν αυτή η εντολή επιλεγεί τότε οι 
περιοχές αυτές αντιμετωπίζονται ως τμήμα του εντοπισμού φόντου, ο οποίος 
θα ενεργοποιηθεί αυτόματα με την επιλογή του αντίστοιχου τετραγωνιδίου. 

 

Βήμα 4  
Για λεπτομερέστερο έλεγχο μπορεί να τροποποιηθεί το κατώτατο όριο 
κάλυψης σε μια ορθογώνια περιοχή της εικόνας. Απλά επιλέγεται η εντολή 
region select και κατόπιν η επιθυμητή περιοχή της εικόνας με τη βοήθεια του 
κέρσορα. 

 

Βήμα 5  
Μετακινώντας τον ολισθαίνοντα ρυθμιστή αυτή τη φορά τροποποιείται ο 
εντοπισμός φόντου μέσα στην επιλεγμένη περιοχή χωρίς να επηρεάζεται 
κάποιο άλλο σημείο της εικόνας.   

Η κανονικοποίηση χρώματος μπορεί να ρυθμιστεί επιλέγοντας το 
τετραγωνίδιο ‘’Shadows’’, ενώ ταυτόχρονα θα πρέπει να επανενεργοποιηθεί 
ο αυτόματος-εντοπισμός φόντου χρησιμοποιώντας την εντολή Regenerate 
mask.   
 

2.5.3. Μή αυτόματος  εντοπισμός φόντου-Χρήση του  εργαλείου 
shrink wrap. 
 
Μερικές φορές είναι δύσκολη η επιλογή ενός  κατάλληλου σκηνικού και βάσης  
που θα επιτρέπουν την σωστή διαμόρφωση του αυτόματου εντοπισμού 
φόντου (παραδείγματος χάριν η βάση μπορεί να πρέπει να έχει διαφορετικό 
χρώμα από αυτό του σκηνικού). Εντούτοις ο μη αυτόματος εντοπισμός 
φόντου μπορεί να είναι κουραστικός  και να οδηγήσει  σε αρκετά λάθη.   

Το 3DSOM Pro παρέχει ένα ημιαυτόματο εργαλείο για να καταστήσει τον μη 
αυτόματο εντοπισμό φόντου ευκολότερο. Απλά σκιαγραφείται ένα πολύ τραχύ 
περίγραμμα γύρω από το αντικείμενο έτσι ώστε η απαίτηση για εντοπισμό 
φόντου να είναι αισθητά μειωμένη εξασφαλίζοντας εξοικονόμηση χρόνου και 
ακρίβεια. 
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Βήμα 1  
Αρχικά θα πρέπει να αφαιρεθεί οποιοσδήποτε υπάρχων εντοπισμός φόντου 
χρησιμοποιώντας την εντολή Unmask image από το κεντρικό μενού Edit 
masks.   

Σχήμα 2.5.3α

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αρχική εικόνα 
Χωρίς εντοπισμό 

φόντου

 
 

Βήμα 2 
Επιλέγοντας την εντολή PPaaiinntt  mmaasskk θα  χρωματιστεί με τετραγωνισμένο 
εντοπισμό φόντου η υπο εξέταση εικόνα ενώ χρησιμοποιώντας την εντολή 
RRoouunndd  BBrruusshh  θα επιλεγεί η στρογγυλή βούρτσα(το εργαλείο δηλαδή που θα 
χρησιμοποιηθεί). Μετακινώντας  τον ολισθαίνοντα ρυθμιστή μπορεί να 
ρυθμιστεί το πάχος της. 

Σχήμα 2.5.3β

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Περίγραμμα του 
χρωματισμού

 
ΣΗΜΕΙΩΣΗ: Το περίγραμμα μπορεί να είναι πολύ τραχύ ωστόσο θα πρέπει 
να μην αγγίζει το αντικείμενο που πρόκειται να καλυφθεί. Εάν υπάρχουν 
τρύπες στη μορφή του αντικειμένου είναι δυνατό να χρωματιστούν αυτές οι 
περιοχές προκειμένου να επιτευχθεί καλύτερος εντοπισμός φόντου γύρω απ’ 
αυτό.  
 

Βήμα 3 
Επιλέγοντας την εντολή Shrink-wrap Mask και μετακινώντας  τον 
ολισθαίνοντα ρυθμιστή εντοπισμού φόντου γίνεται αμφίδρομη κάλυψη της 
εικόνας. Κινώντας  τον προς τα δεξιά θα προκύψει περισσότερο χρώμα 
εντοπισμού φόντου ενώ προς τα αριστερά λιγότερο.  
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.5.3γ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΚάλυψη του φόντου με 

τον ολισθένοντα ρυθμιστή

 
 
Βήμα 4 
Για λεπτομερέστερο έλεγχο μπορεί να τροποποιηθεί το κατώτατο όριο 
μείωσης περιγράμματος σε μια ορθογώνια περιοχή της εικόνας. Απλά 
επιλέγοντας rreeggiioonn  sseelleecctt. Κατόπιν επιλέγεται η επιθυμητή περιοχή της  
εικόνας με τη βοήθεια του κέρσορα όπου θα πραγματοποιηθεί ο εντοπισμός 
φόντου του αντικειμένου.  

 
Βήμα 5 
Επιλέγοντας  ή ξεμαρκάρωντας  το τετραγωνίδιο "Holes" επιτρέπονται ή 
περιορίζονται οι τρύπες στη μορφή του αντικειμένου. Επιλέγοντας την εντολή 
αυτή θα γίνει αυτόματη ενημέρωση του φόντου. Η ρύθμιση κανονικοποίησης 
χρώματος δεν επηρεάζει καθόλου το περίγραμμα.   
 

ΣΗΜΕΙΩΣΗ: Σε οποιοδήποτε στάδιο, μπορεί να επαναληφθεί μείωση του 
περιγράμματος  χρησιμοποιώντας το τρέχον φόντο ως αφετηρία. Αυτό μπορεί 
να είναι χρήσιμο για την τελειοποίηση του εντοπισμού φόντου  σε μια 
επιλεγμένη περιοχή.   

  

2.5.4 Βελτίωση της γεωμετρίας μιας επιφάνειας. 
  
Το αρχικό μοντέλο συρματοπλέγματος που θα δημιουργηθεί μπορεί να 
προβάλει γωνίες, οι οποίες πιθανόν να μην είναι επιθυμητές δηλαδή να μην 
αντιστοιχούν στην πραγματική μορφή του αντικειμένου ή να είναι αποτέλεσμα 
της λήψης φωτογραφιών από λάθος γωνίες. Εάν το αντικείμενο πρόκειται να 
φωτισθεί χρησιμοποιώντας μια εικονική πηγή φωτός αυτά τα χαρακτηριστικά 
μπορεί να προκαλέσουν τη σκίαση ορισμένων σημείων του . 
  

Το πρόγραμμα επιφάνειας(SSuurrffaaccee  WWiizzaarrdd) μπορεί να χρησιμοποιηθεί για τη 
βελτίωση του τριγωνικού πλέγματος με το οποίο θα επιτευχθεί λείανση του 
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πλέγματος στις περιοχές όπου δεν υπάρχει καμία πληροφορία σχετικά με την 
ύπαρξη τέτοιων χαρακτηριστικών 

Αρχικά δημιουργείται μια αρχική επιφάνεια από την οποία μπορεί να ξεκινήσει 
η διαδικασία βελτίωσης. Θα πρέπει επίσης ο εντοπισμός φόντου σε όλες τις 
εικόνες να γίνεται όσο το δυνατόν καλύτερα καθώς σ’ αυτόν στηρίζεται η 
διαδικασία βελτίωσης της γεωμετρίας του μοντέλου. 
 

ΣΗΜΕΙΩΣΗ: Ίσως να χρειαστεί να χρησιμοποιηθεί απο το κεντρικό  μενού η 
εντολή Automask > Clean Mask για την τελειοποίηση του εντοπισμού 
φόντου, ξεμαρκάρωντας οποιοδήποτε σημείο της εικόνας που βρίσκεται εκτός 
της γεωμετρίας του μοντέλου. Η εντολή "CCoonnssttrraaiinn  ssmmooootthheedd  mmeesshh  ttoo  lliiee  
iinnssiiddee  ccuurrrreenntt  ggeeoommeettrryy " είναι ισοδύναμη αλλά χρησιμοποιεί ένα εσωτερικό 
αντίγραφο εντοπισμού φόντου. 

Μπορούν επίσης να δημιουργηθούν επιπλέον επιφάνειες ώστε να εξεταστούν 
συγκεκριμένα χαρακτηριστικά της εικόνας όπως περιγράφονται στο ΄΄AAddddiinngg  
ssyynntthheettiicc  ssiillhhoouueetttteess  ttuuttoorriiaall’’. 
 

Βήμα 1 
Tο πρόγραμμα επιφάνειας θα ξεκινήσει την διαδικασία βελτίωσης  μέσω της 
εντολής  ΄΄GGeenneerraattee  ssuurrffaaccee ‘’και επιλέγοντας  "OOppttiimmiissee  SSuurrffaaccee". 

 

Βήμα 2 
Για εξομάλυνση των γωνιακών σημείων του υπό διαμόρφωση αντικειμένου, 
συστήνεται η επιλογή "ssmmooootthh  aapppprrooxxiimmaattiioonn " έτσι ώστε να δημιουργηθεί 
πλέγμα  με λίγες γωνίες. Διαφορετικά, μπορεί να χρησιμοποιηθεί η επιλογή 
""rreeaassoonnaabbllee  aaccccuurraaccyy",ενώ για εντοπισμό φόντου με εξαιρετικά μεγάλη 
ακρίβεια και λεπτομέρεια μπορεί να χρησιμοποιηθεί για τη διαμόρφωση του η 
επιλογή "eexxaacctt  ffiitt. 
  

Επιπλέον, επιλέγοντας την εντολή "CCoonnssttrraaiinn  ssmmooootthheedd  mmeesshh  ttoo  lliiee  iinnssiiddee  
ccuurrrreenntt  ggeeoommeettrryy "είναι δυνατόν να αφαιρεθούν περιοχές (π.χ. η βάση ή 
ένας υποτομέας του μοντέλου),οι οποίες ενδέχεται να επηρεάσουν τη 
γεωμετρία του μοντέλου. 
 

ΣΗΜΕΙΩΣΗ: Σε περίπτωση που έχουν φορτωθεί  πολλές εικόνες στο Project 
ή η διαδικασία εντοπισμού φόντου είναι ιδιαίτερα σύνθετη, η διαδικασία 
βελτίωσης μπορεί να είναι αργή, επομένως θα ήταν επιθυμητό να περιοριστεί 
ο αριθμός εικόνων που χρησιμοποιούνται σε κάθε βήμα βελτίωσης με τον 
καθορισμό της παραμέτρου "MMaaxxiimmuumm  nnuummbbeerr  ooff  iimmaaggeess  ttoo  uussee  dduurriinngg  
ooppttiimmiissaattiioonn""..   
 
Βήμα 3 
Αμέσως μετά την έναρξη της διαμόρφωσης , το 3DSOM Pro θα αρχίσει να 
τροποποιεί την επιφάνεια του αντικειμένου, λειαίνοντάς το βαθμιαία ενώ 
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παράλληλα προσαρμόζει σ’ αυτήν τα χαρακτηριστικά των εικόνων που 
προέκυψαν από τον εντοπισμό του φόντου για κάθε μία από αυτές. Κατά τη 
διάρκεια αυτής της διαδικασίας, είναι δυνατή η παρατήρηση  της τρέχουσας  
γεωμετρίας  και η περιστροφή του αντικειμένου στο παράθυρο View Model. 
Σε αυτή τη φάση, το πλέγμα θα επιδειχθεί με το μέγιστο αριθμό τριγώνων, το 
οποίο θα έχει δημιουργηθεί αποκλειστικά και μόνο από τις προκαθορισμένες 
ρυθμίσεις, όταν η βελτίωση ολοκληρωθεί.  

Ανάλογα με το επιθυμητό αποτέλεσμα η διαδικασία βελτίωσης μπορεί να 
διακοπεί επιλέγοντας PPaauussee βελτίωσης ή να επαναληφθεί με την επιλογή 
CCoonnttiinnuuee σε οποιοδήποτε στάδιο. 

Η αλλαγή  των παραμέτρων μπορεί να επιτευχθεί επιλέγοντας  <  BBaacckk σε 
οποιοδήποτε σημείο της διαδικασίας όπου και γίνεται επιστροφή στο 
προηγούμενο βήμα (παραδείγματος χάριν εάν η βελτίωση προχωρά πολύ 
αργά θα μπορούσε  να μειωθεί ο αριθμός  των εικόνων που θα 
χρησιμοποιηθούν).  
 

Βήμα 4  

Σε οποιοδήποτε στάδιο στο οποίο ο παρατηρητής είναι ικανοποιημένος με την 
τρέχουσα επιφάνεια, μπορεί να ανακόψει ή να συνεχίσει τη διαδικασία 
διαμόρφωσης. Επιλέγοντας CClloossee το πρόγραμμα διαμόρφωσης θα 
διατηρήσει το τρέχον μοντέλο συρματοπλέγματος, ενώ με την επιλογή  NNeexxtt > 
θα προχωρήσει η δημιουργία των συνολικών τριγώνων επιφάνειας (όπως 
περιγράφεται στο Compressing the geometry with subdivision surfaces). 
Όταν το πρόγραμμα κλείσει, το μοντέλο θα επιδειχθεί με τον επιλεγμένο 
αριθμό τριγώνων.  
 
2.5.5. Συμπίεση της γεωμετρίας μέσω των συνολικών  τριγώνων 
επιφανείας. 
  
Ο μεγάλος συνολικά αριθμός τριγώνων για τη δημιουργία της επιφάνειας ενός 
μοντέλου μπορεί να έχει σαν αποτέλεσμα τη δύσκολη αποθήκευση και 
μετακίνησή του στο Διαδίκτυο. 

 
Το 3DSOM Pro παρέχει εξαιρετικά μέσα επεξεργασίας της μνήμης ή του 
διαστήματος δίσκων που απαιτείται για την αποθήκευση ενός μοντέλου, με τη 
μετατροπή της γεωμετρίας σε μια επιφάνεια τριγώνων (πλέγμα) με συνέπεια 
την αύξηση των παραγόντων συμπίεσης από 10 σε πάνω από 100 ανάλογα 
με τη μορφή του. 

  

Το 3DSOM Pro αυτόματα δημιουργεί μια επιφάνεια πλέγματος η οποία 
συμπίπτει με την υπάρχουσα γεωμετρία. Η επιφάνεια πλέγματος θα 
προσεγγίσει την αρχική γεωμετρία και είναι δυνατόν να ελέγχεται το πόσο 
συμπαγής ή όχι  θα είναι αυτή αντίστοιχα. 
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Η γεωμετρία θα πρέπει να βρίσκεται στο τελικό της στάδιο, 
συμπεριλαμβανομένης της οποιαδήποτε βελτίωσης (βλ.Optimising the 
surface geometry tutorial) ή διαμόρφωσης  (βλ.Building the wireframe model) 
ώστε το 3DSOM Pro να μπορεί να προσαρμόσει τη νέα επιφάνεια στην 
τρέχουσα γεωμετρία. Ενεργοποιώντας το επίπεδο συνολικών τριγώνων 
επιφάνειας μπορεί να επιδειχθεί ένα υψηλής ποιότητας μοντέλο - η διαδικασία 
συναρμολόγησης  θα χρησιμοποιήσει το επιδειχθέν πλέγμα για να καθορίσει 
τον αριθμό τριγώνων στον έλεγχο  της επιφάνειας πλέγματος. 

 ΣΗΜΕΙΩΣΗ: Αυτή η λειτουργία θα απορρίψει οποιοδήποτε χάρτη υφής που 
έχει δημιουργηθεί, αλλά δεν χρησιμοποιεί τις αρχικές εικόνες ή το φόντο.  
 

Βήμα 1 
Για να ανοίξει η κατάλληλη σελίδα επιφάνειας τριγώνων θα πρέπει να επιλεγεί 
η παρακάτω ακολουθία εντολών: 

    SSuurrffaaccee  WWiizzaarrdd 

    GGeenneerraattee  SSuurrffaaccee  
    FFiitt  SSuubbddiivviissiioonn  SSuurrffaaccee  
    NNeexxtt>>  
 
Βήμα 2  
Η τελική γεωμετρία μπορεί να αλλάξει μεταβάλλοντας τον αριθμό τριγώνων 
στο πλέγμα βάσης. Λιγότερα τρίγωνα θα πάρουν και λιγότερο χώρο, ωστόσο 
όμως θα παραλειφθούν λεπτομέρειες της γεωμετρίας του μοντέλου.  
 

Το 3DSOM Pro θα προτείνει έναν αριθμό τριγώνων βασισμένο στο τρέχον 
πλέγμα και το τρέχον επίπεδο συνολικών τριγώνων επιφάνειας. Έτσι για 
παράδειγμα εάν το μοντέλο επιδεικνύεται με 4000 τρίγωνα, θα προτείνει 250 
στο πλέγμα βάσης.  
 

Πώς μια επιφάνεια συνολικών τριγώνων επιφάνειας αποθηκεύεται;  
Μια επιφάνεια συνολικών τριγώνων επιφάνειας αποθηκεύεται ως απλό ή 
πλέγμα τριγώνων "βάσης" με πολύ λίγα τρίγωνα να αποτελούν την τραχιά 
μορφή του μοντέλου. Το πλέγμα βάσης θα είναι πυκνότερο στους τομείς της 
υψηλής κυρτότητας ώστε να μπορούν να αναγνωριστούν τα αιχμηρότερα 
γνωρίσματα του μοντέλου. 

 
Κάθε τρίγωνο σε αυτό το πλέγμα βάσης είναι χωρισμένο σε 4 ή 16 τρίγωνα 
(ανάλογα με το επίπεδο τριγώνων επιφάνειας) με τέτοιο τρόπο ώστε να 
δημιουργηθεί μια ομαλή επιφάνεια Αυτή η διαδικασία δεν απαιτεί καμία 
πρόσθετη πληροφορία, καθώς αυτή είναι η βέλτιστη επιφάνεια που μπορεί να 
δημιουργηθεί. Όταν επιλεγεί ο αριθμός τριγώνων στο πλέγμα βάσης, η 
διαδικασία συνεχίζει επιλέγοντας  Next>. Είναι δυνατή η δοκιμή διαφορετικών 
αριθμών. 
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Βήμα 3 
Το 3DSOM Pro θα αρχίσει να εγκαθιστά μια επιφάνεια πλέγματος στη 
γεωμετρία. Δεδομένου ότι συμβαίνει αυτό, η τρέχουσα επιφάνεια εμφανίζεται 
στο View Model Window,η οποία μπορεί να περιστραφεί και να εξεταστεί από 
διαφορετικές κατευθύνσεις. 

 

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.5.5

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕπιφάνεια πλέγματος 

στη γεωμετρία

 
Η διαδικασία ξεκινά από τα πιο τραχιά σημεία του μοντέλου  και προχωρά με 
την αναγνώριση περισσότερων λεπτομερειών στη συνέχεια. Μπορεί να 
σταματήσει σε οποιοδήποτε σημείο όταν επιτευχθεί το επιθυμητό αποτέλεσμα 
με την εντολή cclloossee. 
  

Βήμα 4 
Όταν η διαδικασία ολοκληρωθεί, επιλέγεται η εντολή ffiinniisshh ώστε να κλείσει το 
παράθυρο διαλόγου. Για να συγκριθεί με την προηγούμενη γεωμετρία μπορεί 
να χρησιμοποιηθεί  η εντολή UUnnddoo  mmooddeell  oorr  mmaasskk  cchhaannggee ή το RReeddoo  mmooddeell  
oorr  mmaasskk  cchhaannggee..    
  
Μπορεί επίσης να μεταβληθεί ο αριθμός  τριγώνων που επιδεικνύεται 
χρησιμοποιώντας τον ολισθαίνοντα ρυθμιστή τριγώνων στη στήλη εργαλείων 
VViieeww  mmooddeell.  
 

Εναλλακτικά, εάν το τελικό πλέγμα δεν διαμορφώνεται επαρκώς, είναι 
απαραίτητο ο παρατηρητής να επιστρέψει στην προηγούμενη σελίδα και να 
αυξήσει τον αριθμό τριγώνων στο πλέγμα βάσης 
 

2.5.6. Επεξεργασία σύνθετης γεωμετρίας. 
  
Σε περιπτώσεις σύνθετης γεωμετρίας, είναι απαραίτητη η λήψη μίας επιπλέον 
φωτογραφίας από διαφορετική γωνία προκειμένου να επιτευχθεί το καλύτερο 
δυνατό αποτέλεσμα κατά την διάρκεια διαμόρφωσης του μοντέλου. 
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Εάν το μοντέλο δεν έχει μετακινηθεί από την αρχική του θέση μπορεί απλά να 
γίνει λήψη μιας επιπλέον φωτογραφίας και να προστεθεί στο πρόγραμμα 
χρησιμοποιώντας την εντολή IImmaaggeess>>AAdddd  IImmaaggeess.... Σε περίπτωση που έχει 
μετακινηθεί, θα πρέπει να γίνει ευθυγράμμιση της νέας εικόνας όπως 
περιγράφεται στο AAddddiinngg  tteexxttuurree  uunnddeerrnneeaatthh  aann  oobbjjeecctt..  
 
Εάν δεν είναι δυνατή η πρόσβαση στο μοντέλο ή η λήψη άλλων φωτογραφιών 
από αυτό, μπορεί να δημιουργηθεί μια σύνθετη γεωμετρία όπως περιγράφεται 
κατωτέρω, να εκδοθεί ο εντοπισμός φόντου και  με βάση αυτό να  παραχθεί η 
επιφάνεια πλέγματος.  

 
ΣΗΜΕΙΩΣΗ: Στο OOppttiimmiissiinngg  tthhee  ssuurrffaaccee  ggeeoommeettrryy  ttuuttoorriiaall είναι διαθέσιμοι 
άλλοι αυτόματοι τρόποι, οι οποίοι είναι εξίσου αποτελεσματικοί.  
 

ΠΡΟΕΡΓΑΣΙΑ 
Πριν τη δημιουργία της  σύνθετης γεωμετρίας , θα πρέπει να είναι διαθέσιμο 
το αντίστοιχο πρόγραμμα δημιουργίας του μοντέλου συρματοπλέγματος. 
Είναι συχνά ευκολότερο εάν έχει παραχθεί  ένας χάρτης υφής.  
 

Βήμα 1 
Στο View Model Window, το μοντέλο περιστρέφεται και τοποθετείται σε 
γωνία τέτοια ώστε όλη η γεωμετρία να είναι ορατή. Αν κάτι τέτοιο δεν είναι 
εφικτό θα πρέπει να δημιουργηθούν  πολλές γεωμετρίες .  
 

Βήμα 2 
Επιλέγεται η εντολή  Create silhouette. Όταν ολοκληρωθεί η δημιουργία 
υφής του μοντέλου, θα πρέπει να αποθηκευτεί μια εικονική εικόνα του ώστε η 
έκδοση των εντοπισμών φόντου να είναι ευκολότερη. Αυτό είναι γενικά μια 
καλή ιδέα, δεδομένου ότι είναι δύσκολο έτσι κι αλλιώς να εκδοθεί το φόντο 
ακριβώς. Η νέα σύνθετη εικόνα θα εμφανιστεί στο παράθυρο Τhumbnail με 
ένα αρχικό φόντο που έχει προκύψει από την τρέχουσα γεωμετρία. Οι 
σύνθετες  εικόνες δεν χρησιμοποιούνται για την υφή αλλά για την γεωμετρία 
του μοντέλου. 

ΣHMEIΩΣΗ: Το μοντέλο θα πρέπει να είναι ορατό στη νέα εικόνα, διαφορετικά 
η γεωμετρία μπορεί να κοπεί - εάν είναι απαραίτητο, θα πρέπει να διαγραφεί η 
νέα εικόνα, να μεγεθυνθεί και να δημιουργηθεί πάλι.  

 

Βήμα 3 

Το νέο φόντο φορτώνεται στο παράθυρο Edit Μasks κάνοντας διπλό κλικ στο 
αντίστοιχο thumbnail του.  
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Βήμα 4 
Η επιφάνεια θα δημιουργηθεί επιλέγοντας την εντολή Generate Surface... και 
ακολουθείται η διαδικασία όπως περιγράφεται στο  εγχειρίδιο Building the 
wireframe model. 
 

2.5.7. Προσθήκη υφής στη βάση ενός  μοντέλου. 
  
Η βάση του υπό διαμόρφωση μοντέλου δεν είναι ορατή σε καμία από τις 
εικόνες καθώς οι λήψεις των φωτογραφιών πραγματοποιούνται παρουσία του 
δίσκου βαθμονόμησης ενώ το αντικείμενο τοποθετείται πάνω σ’ αυτόν. Όταν 
ολοκληρωθεί ο εντοπισμός φόντου του μοντέλου, η βάση του καλύπτεται με 
το ίδιο χρώμα που περικλείει την τρέχουσα γεωμετρία. 

 Σε πολλές περιπτώσεις η υφή που προκύπτει είναι ικανοποιητική δεδομένου 
ότι μπορεί να παραληφθεί η βάση του μοντέλου σε σχέση με το υπόλοιπο. Η 
προσθήκη υφής στη βάση του, μπορεί να επιτευχθεί προσεγγιστικά με το 
πρόγραμμα 3DSOM Pro,απλά με την τοποθέτηση του επάνω στο δίσκο 
βαθμονόμησης έτσι ώστε να είναι εύκολη η λήψη 1-2 φωτογραφιών που θα 
καλύπτουν όσο το δυνατόν μεγαλύτερο μέρος της βάσης του. Οι φωτογραφίες 
αυτές θα προστεθούν αργότερα στην συνολική υφή του μοντέλου 
χρησιμοποιώντας την εντολή AAlliiggnn  iimmaaggeess..  
Το 3DSOM Pro δεν θα είναι σε θέση να εντοπίσει τη θέση της φωτογραφικής 
μηχανής για τις συγκεκριμένες φωτογραφίες βάσης. Το παράθυρο  Align 
χρησιμοποιείται για να ευθυγραμμίσει κάθε μια από αυτές τις πρόσθετες 
εικόνες ανάλογα με τις αντίστοιχες του μοντέλου έτσι ώστε να μπορούν να 
χρησιμοποιηθούν κατά την δημιουργία της  υφής του.  
 
ΠΡΟΕΡΓΑΣΙΑ 

Αρχικά θα πρέπει να δημιουργηθεί ένα νέο project όπου θα φορτωθούν οι 
φωτογραφίες του μοντέλου που πρόκειται να διαμορφωθεί. Οι εικόνες βάσης 
χωρίς το δίσκο βαθμονόμησης θα  χαρακτηριστούν ως "απορριπτέες". 
Εναλλακτικά, είναι δυνατό να φορτωθούν όλες οι φωτογραφίες  εκτός από 
εκείνες της βάσης , και να προστεθούν αργότερα στο project στο τέλος του 
βήματος αυτού. Στη συνέχεια πραγματοποιείται ο εντοπισμός φόντου για το 
υπόλοιπο των εικόνων και δημιουργείται η γεωμετρία κανονικά.  

Σχήμα 2.5.7α

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Φωτογραφία της 
κάτω όψης του 

μοντέλου
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ΣΗΜΕΙΩΣΗ:Εάν το μοντέλο έχει λίγα γεωμετρικά στοιχεία αλλά πολλά 
στοιχεία υφής, θα  μπορούσε να δημιουργηθεί  η επιφάνειά του (αποκλείοντας 
εκείνες της βάσης ) σε αυτή τη φάση, ώστε να  διευκολυνθεί η  διαδικασία της 
ευθυγράμμισης (align) .  
 

Βήμα 1 
Σε πρώτο στάδιο επιλέγονται οι εικόνες βάσης  (ακόμα κι αν είναι προσωρινά 
χαρακτηρισμένες ως απορριπτέες ) και η εντολή Images > Align Images....  
Η επιλογή "Αlign Each Image" πρέπει να γίνει στο Alignment Wizard:Task 
Page- κάθε πρόσθετη εικόνα θα πρέπει να ευθυγραμμιστεί χωριστά στη 
συνέχεια. Με την εντολή  Next > θα προχωρήσει στην επόμενη σελίδα.  
 
Βήμα 2 
Σε αυτό το σημείο, εξετάζεται το παράθυρο View Model Window- που 
επιδεικνύει το τρέχον μοντέλο ημι-διαφανώς  

ΣΗΜΕΙΩΣΗ:Θα βοηθούσε να επιδειχθεί το μοντέλο συρματοπλέγματος και να 
γίνει αλλαγή του χρώματος  του από το παράθυρο  3DSOM Pro Settings.  
 

Το μοντέλο τοποθετείται και προσανατολίζεται έτσι ώστε να ταιριάζει με την 
εικόνα που επιδεικνύεται πίσω από αυτό χρησιμοποιώντας τις   εντολές  
RRoottaattee  mmooddeell,,MMoovvee  mmooddeell,,ZZoooomm  mmooddeell,,και SSppiinn  mmooddeell. Επιλέγοντας  
Next view (ή Last view) από τη στήλη εργαλείων View model γίνεται 
επιστροφή στο προηγούμενο στάδιο της διαδικασίας.  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.5. β7

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Το μοντέλο με την μορφή 
συρματοπλέγματος 

για την σωστή τοποθέτηση της βάσης
 

Για την τοποθέτηση του μοντέλου στη θέση όπου θα προκύψει και το βέλτιστο 
αποτέλεσμα, μπορεί να γίνει λεπτομερέστερη παρατήρηση των εικόνων – 
επιλέγοντας  MMaaggnniiffyy  VViieeww και PPaann  VViieeww.  
  

Βήμα 3 

Η ευθυγράμμιση της πρώτης εικόνας σε οποιοδήποτε στάδιο είναι 
ικανοποιητική μπορεί να διακοπεί και το πρόγραμμα να προχωρήσει στην 
επόμενη εικόνα επιλέγοντας Next..  
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ΣΗΜΕΙΩΣΗ:Κάνοντας  διπλό κλικ σε μια από τις πρόσθετες εικόνες στο 
παράθυρο thumbnail ή σύροντάς την στο παράθυρο View Model μπορεί να 
χρησιμοποιηθεί ως εικόνα υποβάθρου. 

 Όταν ευθυγραμμιστούν όλες οι επιθυμητές εικόνες, επιλέγεται Next > στη 
βάση του παράθυρου για να προχωρήσει στην τελική σελίδα.  
 
Βήμα 4 
Κλείνοντας το παράθυρο διαλόγου θα έχει γίνει η ευθυγράμμιση των εικόνων 
βάσης με τις αντίστοιχες του μοντέλου. Έπιπλέον το 3DSOM Pro θα 
δημιουργήσει φόντο για κάθε μία από αυτές χρησιμοποιώντας την υπάρχουσα 
γεωμετρία. Οι εικόνες αυτές  μπορούν τώρα να χρησιμοποιηθούν στο project 
με τον ίδιο τρόπο όπως οι υπόλοιπες ,ενώ παράλληλα μπορεί να 
δημιουργηθεί η υφή του μοντέλου συμπεριλαμβανομένων των εικόνων αυτών.  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.5.7γ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕικόνες με βάση και χωρίς 

βάση του μοντέλου 

 
 

ΣΗΜΕΙΩΣΗ:Εάν έχει δημιουργηθεί ήδη η υφή του μοντέλου  μπορούν  να 
συγχωνευτούν σ’ αυτήν, επιλέγοντας κάθε μια ξεχωριστά από το παράθυρο 
thumbnail και έπειτα Ιmages > Paste into model (εναλλακτικά, κρατώντας  το 
CTRL και σύροντας  το thumbnail επάνω στο View Model Window. Μπορεί 
να ρυθμιστεί περαιτέρω η ευθυγράμμιση για μια ή περισσότερες από τις 
εικόνες βάσης με την επιλογή της στο κεντρικό παράθυρο και το άνοιγμα του 
παραθύρου Align.  

2.5.8 Επεξεργασία υφής σε ειδικές περιοχές. 
 
Πολλές φορές είναι επιθυμητή η τοποθέτηση υφής σε ένα παραγόμενο 
τρισδιάστατο μοντέλο. Σε αυτό το στάδιο θα επιδειχθεί ο τρόπος με τον οποίο 
ένα λογότυπο μπορεί να τοποθετηθεί εύκολα σε ένα σημείο του μοντέλου.  
Τα εργαλεία επεξεργασίας υφής επιτρέπουν τον άμεσο χρωματισμό του 
παραγόμενου μοντέλου χρησιμοποιώντας την προεπιλεγμένη δυσδιάστατη 
εικόνα. Αυτό επιτυγχάνεται με τη δημιουργία ειδικών πλαισίων.   

 

 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  85

ΠΡΟΕΡΓΑΣΙΑ 
Προϋπόθεση είναι η εισαγωγή ή η δημιουργία ενός τρισδιάστατου μοντέλου 
από ένα σύνολο φωτογραφιών .  

Βήμα 1 
Προκειμένου να επισυναφθεί το λογότυπο πρέπει να επιλεγεί ο κατάλληλος  
προσανατολισμός του μοντέλου από το οποίο θα ξεκινήσουμε.   

 ΣΗΜΕΙΩΣΗ:Για να εξασφαλιστεί ακριβή επεξεργασία, το μοντέλο θα πρέπει 
να καλύπτει το μεγαλύτερο μέρος της τρισδιάστατης όψης μεγεθύνοντας το, 
χρησιμοποιώντας την εντολή  ZZoooomm  mmooddeell..  
Βήμα 2 
Η αντιγραφή του λογότυπου υφής στην περιοχή των ειδικών πλαισίων 
πραγματοποιείται επιλέγοντας την εντολή CCooppyy  VViieeww  από τη στήλη 
εργαλείων View model.  
Βήμα 3 
Γίνεται επικόλληση του δυσδιάστατου λογότυπου επάνω στο ειδικό πλαίσιο 
(Paste).  

 

Επικόλληση ενός λογότυπου σε PhotoShop  
Σε PhotoShop απαιτείται προσοχή καθώς οι διαστάσεις του λογότυπου θα 
πρέπει να διατηρούνται κατά την επικόλλησή του στην περιοχή πλαισίου.  Για  
να δημιουργηθεί ένα νέο λογότυπο θα  πρέπει πρώτα αυτό να αντιγραφεί στο 
ειδικό πλαίσιο και έπειτα  χρησιμοποιώντας την εντολή  File>New .  
 
Βήμα 4 
Επόμενο βήμα είναι να φορτωθεί το λογότυπο στο τρισδιάστατο 
μοντέλο.Αφού επιλεγεί η περιοχή στην οποία θα γίνει αντιγραφή του 
λογότυπου,γίνεται επικόλληση χρησιμοποιώντας τις εντολές Copy-Paste. Το 
λογότυπο μπορεί να μεταφραστεί, να περιστραφεί και να μεγεθυνθεί όπως 
αυτό είναι επιθυμητό.  

  

Βήμα 5 
Όταν επιτευχθεί το επιθυμητό αποτέλεσμα της παραπάνω επεξεργασίας, οι 
τροποποιήσεις μπορούν να ενσωματωθούν στην υφή του μοντέλου στο 
3DSOM Pro. Για να γίνει αυτό το υπό επεξεργασία λογότυπο θα πρέπει να 
αντιγραφεί στο ειδικό πλαίσιο ως ενιαίο σώμα και να γίνει επικόλληση στ ο 
3DSOM Pro. Στο PhotoShop επιλέγεται η εντολή Layer> Flatten Image.  Στο 
PaintShop Pro layers > merge > merge all αντίστοιχα. Στο σημείο αυτό 
γίνεται αντιγραφή του λογότυπου στο ειδικό πλαίσιο και επικόλληση στο 
3DSOM Pro χρησιμοποιώντας την εντολή Paste view. Oι χρήστες  
PhotoShop πρέπει να αποφύγουν τη δημιουργία πλαισίων.  
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Επικόλληση ενός λογότυπου από PhotoShop  
Τα PhotoShop δεν έχει τη δυνατότητα να τοποθετήσει τις μεγάλες εικόνες σε 
ενα πλαίσιο.Ετσι θα πρέπει να επιλεγεί το εργαλείο "Move" από τη ράβδο 
εργαλείων και να μετακινηθεί το λογότυπο από το PhotoShop στο παράθυρο 
View model του 3DSOM Pro. Με αυτή τη μέθοδο δεν χρειάζεται αντιγραφή. 

 

Βήμα 6  
Μόλις γίνει επικόλληση της εικόνας στο 3DSOM Pro αυτόματα θα διορθωθεί 
και η υφή της.  

 

2.5.9 Προσαρμογή του μοντέλου για εφαρμογές Διαδικτύου. 
 
Για την προσαρμογή ενός τρισδιάστατου μοντέλου που προκύπτει μέσω του 
προγράμματος 3DSOM Pro για εφαρμογές του στο Διαδίκτυο, υπάρχουν 
διάφορες παράμετροι και επιλογές.   

To 3DSOM Pro παρέχει ένα πρακτικό εργαλείο,το οποίο βοηθά στην επιλογή 
των σωστών παραμέτρων για την προσαρμογή του αντίστοιχου project.  
 

ΠΡΟΕΡΓΑΣΙΑ 
Σε πρώτο στάδιο θα πρέπει να εισαχθεί στο πρόγραμμα του 3DSOM ένα 
project με ένα ολοκληρωμένο τρισδιάστατο μοντέλο, το οποίο πρόκειται να 
δημοσιευτεί στο Διαδίκτυο.   

 

Βήμα 1  
Επιλέγεται η εντολή EExxppoorrtt  mmooddeell…. Ο τύπος του αρχείου που πρόκειται να 
μεταβεί στο Διαδίκτυο πρέπει να είναι " 3DSOM viewer". Εάν αυτό δεν ισχύει, 
θα πρέπει να επιλεγεί ο εν λόγω τύπος αρχείου με βάση τις παρακάτω 
επιλογές.   

 

Βήμα 2  
Σε δεύτερο στάδιο πραγματοποιείται βελτίωση των χαρακτηριστικών του 
μοντέλου(γεωμετρία και υφή) με την επιλογή της εντολής RRuunn  ooppttiimmiizzeerr........   
Το τρισδιάστατο μοντέλο διαιρείται σε δύο μέρη - τη γεωμετρία και την υφή 
του,οπότε μπορεί να γίνει έλεγχος και επεξεργασία της ποιότητας της κάθε 
μιας παραμέτρου ξεχωριστά.  

 
Βήμα 3  
Η κορυφαία γραμμή αφορά την ποιότητα γεωμετρίας. Η ποιότητα  ποικίλει 
από 0 (χαμηλότερη ποιότητα) σε 100 (υψηλότερη ποιότητα). Αυτό 
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επιτυγχάνεται είτε μεταβάλλοντας  τον αριθμό άμεσα είτε επιλέγοντας  την 
αντίστοιχη εντολή στα  δεξιά του τομέα εισαγωγής.   

Στη δεξιά πλευρά επιδεικνύεται το μέγεθος του μοντέλου με βάση τις 
επιλεγμένες ρυθμίσεις ποιότητας καθώς και ο χρόνος (σε δευτερόλεπτα)που 
απαιτείται με βάση την προσωρινά προεπιλεγμένη ταχύτητα σύνδεσης. 

Για να γίνει αντιληπτή η σχέση του χρόνου σύνδεσης με διαφορετικές 
ταχύτητες σύνδεσης απλά θα πρέπει να επιλεγεί μία ταχύτητα σύνδεσης κάθε 
φορά έως ότου βρεθεί η επιθυμητή. Περισσότερο συχνά χρησιμοποιούνται 
ταχύτητες σύνδεσης μεταξύ 28Kbps και 56Kbps ενώ σε ειδικές περιπτώσεις 
είναι δυνατό να χρησιμοποιηθούν και ταχύτητες των 128Kbps και 512Kbps.   

 

Βήμα 4  
Η  ποιότητα της γεωμετρίας ενός μοντέλου προσαρμόζεται έτσι ώστε ένας 
χρήστης με ταχύτητα σύνδεσης 56Kbps να μπορεί να αξιοποιήσει όλα τα 
στοιχεία της γεωμετρίας του σε περίπου 5 δευτερόλεπτα:  

 Επιλέγοντας την εντολή  Preview είναι δυνατή η παρατήρηση και η 
επεξεργασία των ρυθμίσεων που έχουν επιλεγεί όσον αφορά την 
προσαρμογή του μοντέλου σε εφαρμογές Διαδικτύου.  

 
Βήμα 5  
Η δεύτερη γραμμή αναφέρεται στην ποιότητα της υφής του μοντέλου. Στη 
δεξιά πλευρά του τομέα είναι εύκολο να παρατηρηθούν τα συνολικά δεδομένα 
υφής του μοντέλου και ο χρόνος που απαιτείται για την μετάβασή του στο 
Διαδίκτυο με βάση την προεπιλεγμένη ταχύτητα σύνδεσης. Οι ρυθμίσεις της 
ποιότητας υφής θα πρέπει να προσαρμοστούν έτσι ώστε ένας χρήστης με μια 
σύνδεση 56Kbps να μπορεί να μεταφέρει βασικά στοιχεία της υφής του 
μοντέλου σε λιγότερο από 2 δευτερόλεπτα ενώ ένας χρήστης με μια γρήγορη 
σύνδεση 512Kbps να μπορεί να μεταφέρει όλα τα στοιχεία υφής σε λιγότερο 
από 5 δευτερόλεπτα.  Θα πρέπει να επιλεγεί η εντολή Preview κάθε φορά 
που είναι επιθυμητό να γίνει παρατήρηση του μοντέλου με τις νέες ρυθμίσεις.   

 

Βήμα 6  
Εάν το μοντέλο έχει δημιουργηθεί με υφή εξαρτώμενης όψης θα πρέπει να 
αποφασιστεί εκ των προτέρων εάν αυτές  πρέπει ή όχι να περιληφθούν στο 
τελικό μοντέλο με την επιλογή του αντίστοιχου τετραγωνιδίου. 

Ο τρόπος με τον οποίο το μοντέλο επιδεικνύεται στο 3DSOM Pro είναι δυνατό 
να αλλάξει με την επιλογή διαφορετικού τύπου υλικών. Αλλάζοντας  τον τύπο 
υλικού και ενεργοποιώντας την εντολή PPrreevviieeww γίνεται προεπισκόπηση της 
επίδειξης του μοντέλου.   
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Βήμα 7  
Όταν το επιθυμητό αποτέλεσμα επιτευχθεί, η σελίδα Διαδικτύου θα πρέπει να 
απενεργοποιηθεί(ώστε τα προσωρινά αρχεία του μοντέλου να διαγραφούν) 
και να επιλεγεί ΟΚ. Εισάγεται το επιθυμητό όνομα αρχείου και ο φάκελος στον 
οποίο θα αποθηκευτεί  και επιλέγεται SSaavvee ώστε να γίνει εξαγωγή του τελικού 
μοντέλου.   

2.6.0. Προηγμένη κάλυψη για ένα μεγάλο αριθμό  εικόνων. 
  
Μερικές φορές οι φωτογραφίες λήψης ενός μοντέλου δεν βοηθούν στη 
διαδικασία αυτόματου εντοπισμού φόντου. Πιθανές αιτίες μπορεί να είναι οι 
εξής:  

 δεν υπήρξε χρησιμοποιούμενη βάση...   

 το σκηνικό δεν περιέβαλλε το αντικείμενο σωστά...  

 το σκηνικό δεν ήταν αρκετά σαφές...   

 δεν  χρησιμοποιήθηκε σκηνικό...   

Εάν περιλαμβάνεται μεγάλος αριθμός εικόνων, ο μη-αυτόματος εντοπισμός 
φόντου θα μπορούσε να είναι αρκετά χρονοβόρος.  

Το 3DSOM Pro παρέχει διάφορα ημιαυτόματα εργαλεία τα οποία επιτρέπουν 
πιο γρήγορο εντοπισμό φόντου πολλών εικόνων.   

 
ΠΡΟΕΡΓΑΣΙΑ 
Το project με τον μεγάλο αριθμό εικόνων εισάγεται στο 3DSOM PRO ενώ 
αφαιρούνται πιθανές υπάρχουσες καλύψεις χρησιμοποιώντας την εντολή 
MMaasskkiinngg>>UUnnmmaasskk  IImmaaggeess. 

 

Βήμα 1  
Αρχικά τα thumbnail τοποθετούνται σε μια σειρά (βλ. λεπτομέρειες των 
thumbnail με την επιλογή View image details.) Επιλέγοντας την ετικέτα "order" 
τα thumbnail θα επιδεικνύονται με αύξουσα σειρά, γεγονός που εξασφαλίζει 
ότι οι πρώτες εικόνες είναι από ευρέως διαφορετικές γωνίες λήψης.   

 
Βήμα 2 
Σε δεύτερο στάδιο επιλέγεται το πρώτο thumbnail και δημιουργείται ο 
κατάλληλος εντοπισμός φόντου χρησιμοποιώντας τα αντίστοιχα εργαλεία(βλ. 
μη αυτόματη κάλυψη με το εργαλείο shrink-wrap).   

 
Βήμα 3  
Η διαδικασία επαναλαμβάνεται για τις πρώτες 3 ή 4 εικόνες στο διαταγμένο 
κατάλογο.   



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  89

Βήμα 4  
Επιλέγοντας τις εντολές Generate surface/Generate wireframe και 
ρυθμίζοντας τις αντίστοιχες παραμέτρους θα δημιουργηθεί ένα αρχικά-τραχύ 
τρισδιάστατο μοντέλο χρησιμοποιώντας αυτές τις λίγες εικόνες .Το παράθυρο 
διαλόγου θα πρέπει να κλείσει αφότου δημιουργηθεί το τρισδιάστατο μοντέλο.       

ΣΗΜΕΙΩΣΗ: Σε αυτή τη φάση δεν συνιστάται να γίνει βελτίωση της επιφάνειας 
αντιθέτως είναι επιθυμητή μια τραχιά υπερεκτίμηση του χώρου στον οποίο  
βρίσκεται το μοντέλο.  

 
Βήμα 5  

Έπειτα γίνεται η επιλογή του επόμενου μη καλυπτόμενου thumbnail.   
 
Βήμα 6 
Τώρα μπορεί να προβληθεί το τρισδιάστατο μοντέλο προκειμένου να 
πάρουμε μια αρχική εκτίμηση για τον εντοπισμό φόντου. Κατόπιν επιλέγεται η 
εντολή CClleeaann  mmaasskk.Εάν είναι απαραίτητο, θα πρέπει να αφαιρεθεί 
οποιοδήποτε τμήμα του μοντέλου έχει παρουσιαστεί με χρώμα. 

 
Βήμα 7  
Τώρα χρησιμοποιώντας το εργαλείο shrink-wrap Mask γίνεται προσεγγιστικά 
ο εντοπισμός φόντου του μοντέλου. Σύροντας τον ολισθαίνοντα ρυθμιστή 
εντοπισμού φόντου θα ολοκληρωθεί πιο γρήγορα η διαδικασία.   

 

ΣΗΜΕΙΩΣΗ: Για την καλύτερη ροή της εργασίας  τα τελευταία δύο βήματα 
μπορούν να συνδυαστούν. Η επιλογή shrink-wrap για μια  μη-καλυπτόμενη 
εικόνα θα εκτελέσει αυτόματα μια καθαρή λειτουργία εντοπισμού που 
ακολουθείται από shrink-wrapping.  

 
Βήμα 8 
Η διαδικασία εντοπισμού φόντου μπορεί να τελειοποιηθεί μέσω του εργαλείου 
shrink-wrapping (βλ. μη αυτόματος εντοπισμός φόντου),εξασφαλίζοντας 
μεγαλύτερη ακρίβεια.  

 
Βήμα 9  
Η ίδια διαδικασία επαναλαμβάνεται για τις υπόλοιπες εικόνες.   
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 2.6

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΌλες οι φωτογραφίες 

με κάλυψη του φόντου

 

2.6.1. Επεξεργασία των εντοπισμών φόντου ενός μοντέλου για 
εξωτερική εφαρμογή. 
  
Το 3DSOM Pro παρέχει ένα εκτενές σύνολο αυτόματων, ημιαυτόματων και 
μη-αυτόματων εργαλείων εντοπισμού φόντου. Εντούτοις οι χρήστες μπορούν 
να χρησιμοποιήσουν πρόσθετα εργαλεία που παρέχονται από το εξωτερικό 
δυσδιάστατο λογισμικό απεικόνισης (όπως το Adobe PhotoShop) για να 
καλύψουν τις εικόνες.   

Τα στοιχεία εντοπισμού φόντου μπορούν να εξαχθούν μαζί με τα στοιχεία της 
εικόνας ως RGBA για την επεξεργασία τους σε τρισδιάστατες εφαρμογές. Οι 
υπό επεξεργασία εικόνες  μπορούν έπειτα να επανεισαχθούν πίσω στο 
3DSOM Pro για την τρισδιάστατη  δημιουργία του μοντέλου.   

ΠΡΟΕΡΓΑΣΙΑ 
Εισάγονται διαφορετικές εικόνες σε ένα νέο project. Τρέχοντας  την διαδικασία 
αυτόματου-εντοπισμού φόντου θα δημιουργηθούν τα αρχικά φόντα.   

 
Βήμα 1  
Στη στήλη των thumbnail επιλέγονται τα thumbnail στα οποία πρόκειται να 
γίνει επεξεργασία σε τρισδιάστατη μορφή. Χρησιμοποιώντας CTRL-κλικ θα 
προστεθεί ένα επιπλέον thumbnail και με shift-κλικ θα επιλεγεί ένα σύνολο 
των thumbnail.   

 
Βήμα 2  
Με την εντολή MMaasskkiinngg>>SSaavvee  MMaasskkss... θα αποθηκευτούν οι εντοπισμοί 
φόντου ενώ παράλληλα είναι δυνατή η επιλογή διαφόρων σχημάτων 
επεξεργασίας φόντου. Για τη συμβατότητα με τους τυποποιημένους 
δυσδιάστατους  συντάκτες εικόνας, συνιστάται ως τύπο αρχείου η επιλογή του 
TIFF. Εάν αυτό είναι εφικτό, συνιστάται τα αρχεία του TIFF να αποθηκευτούν 
στον ίδιο κατάλογο δηλ. "MMaasskkss  iinn  ssaammee  ffoollddeerr  aass  eeaacchh  iimmaaggee" και ΟΚ . 
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Δεν μπορούν να αλλάξουν τα ονόματα που χρησιμοποιούνται για τα αρχεία 
εντοπισμού φόντου, αλλά μπορούν πάντα να αποθηκευτούν σε έναν 
διαφορετικό κατάλογο. Τα αρχεία που υπάρχουν ήδη και θα καλυφθούν είναι 
μαρκαρισμένα με έναν αστερίσκο.   

   
Βήμα 3  
Έπειτα γίνεται άνοιγμα της εικόνας που θα χρησιμοποιηθεί για την δημιουργία 
τρισδιάστατου μοντέλου και φορτώνεται στα αρχεία του TIFF, τα οποία το 
3DSOM Pro θα έχει δημιουργήσει. 

 

Βήμα 4  
Οι πληροφορίες εντοπισμού φόντου αποθηκεύονται στο αρχείο "alpha". Για 
να επιδειχθεί ο εντοπισμός φόντου στο PhotoShop, είναι απαραίτητη η 
επιλογή των αντίστοιχων εντολών Window >Show Channels. Κατόπιν 
επιλέγοντας το τετραγωνίδιο δίπλα στο "alpha" αρχείο θα ενεργοποιηθεί η 
αντίστοιχη διαφάνεια 

ΣΗΜΕΙΩΣΗ: Σε PaintShopPro θα χρειαστεί να δημιουργηθεί  αρχικά ένα 
φόντο χρησιμοποιώντας τις ακόλουθες εντολές Masks >Load From Alpha 
Channel. Και τέλος  Masks>View Mask.   

 

Βήμα 5  
Εάν η επεξεργασία εντοπισμού φόντου πραγματοποιηθεί σε PaintShopPro,θα 
πρέπει αρχικά να είναι βέβαιο ότι το αποτέλεσμα είναι αποθηκευμένο στο 
αρχείο alpha χρησιμοποιώντας τις εντολές Μasks>Save To Alpha Channel. 
Όταν ολοκληρωθεί η επεξεργασία εκτός από το αρχείο του TIFF, θα πρέπει 
να χρησιμοποιηθεί το αρχικό όνομα αρχείου.   

 
Βήμα 6 
Οι εικόνες τύπου TIFF, RGBA μπορούν να εισαχθούν πίσω στο 3DSOM Pro 
με την επιλογή των κατάλληλων thumbnail και των παρακάτω 
εντολώνMasking > Load masks.... Το πρόγραμμα θα αγνοήσει τις εικόνες 
που δεν έχουν μαρκαριστεί με αστερίσκο στον κατάλογο ονομάτων αρχείου 
και κατ’ επέκταση τις εικόνες που δεν έχουν υποστεί καμία επεξεργασία.   

2.6.2. Συγχώνευση πολλαπλών σαρώσεων. 
  
Σε ορισμένες περιπτώσεις, απαιτούνται περισσότερες από μια ή δύο εικόνες 
της βάσης του μοντέλου ώστε να διαμορφωθεί πλήρως η μορφή ή η υφή του.   

Σε τέτοιες περιπτώσεις είναι απαραίτητο να ληφθούν δύο πακέτα 
φωτογραφιών, γυρίζοντας  το αντικείμενο στα ενδιάμεσα. Σε κανονική 
λειτουργία, το 3DSOM Pro  υποθέτει ότι το αντικείμενο δεν κινείται  σε σχέση  
με το δίσκο, έτσι το δεύτερο σύνολο εικόνων πρέπει να ευθυγραμμιστεί με το 
πρώτο.   
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Το παράθυρο Align χρησιμοποιείται για να βοηθήσει τη διαδικασία ένωσης 2 
συνόλων εικόνων έτσι ώστε να διαμορφωθεί ένα ενιαίο project. Το 3DSOM 
Pro  πρέπει να αναγνωρίσει ότι το μοντέλο έχει κινηθεί μεταξύ της λήψης των 
δύο συνόλων φωτογραφιών.   
Αυτό μπορεί να γίνει αυτόματα με την δημιουργία  ενός μοντέλου από ένα 
σύνολο φωτογραφιών και αφήνοντας το λογισμικό να υπολογίσει με ποιο 
τρόπο το δεύτερο πακέτο σχετίζεται με το πρώτο. Οποιοσδήποτε αριθμός 
επιπρόσθετων σαρώσεων μπορεί να συγχωνευθεί με τον ίδιο τρόπο.   

 
ΠΡΟΕΡΓΑΣΙΑ 
Αρχικά θα πρέπει να δημιουργηθεί ένα νέο project να φορτωθούν και τα  δύο 
σύνολα φωτογραφιών και να δημιουργηθεί ο εντοπισμός φόντου για όλες τις 
εικόνες. Το 3DSOM Pro  πρόκειται να χρησιμοποιήσει ένα μοντέλο που 
δημιουργείται από το πρώτο σύνολο φωτογραφιών για να ευθυγραμμίσει το 
δεύτερο. Έτσι επιλέγοντας  το πρώτο σύνολο εικόνων, συνήθως το 
μεγαλύτερο, και απορρίπτοντας  όλες τις  άλλες εικόνες, θα δημιουργηθεί ένα 
τρισδιάστατο μοντέλο. 

 

ΣΗΜΕΙΩΣΗ: Εάν το μοντέλο έχει λίγα γεωμετρικά χαρακτηριστικά συνίσταται 
η δημιουργία μιας  τραχιάς επιφάνειας σε αυτή τη φάση προκειμένου να 
διευκολυνθεί η ευθυγράμμιση.   

 

Βήμα 1  
Επιλέγεται το δεύτερο σύνολο εικόνων (δεν πειράζει εάν είναι προσωρινά 
χαρακτηρισμένες όπως απορριπτέες) και οι εντολές Images > Align 
Images.... Αυτό θα ανοίξει το  παράθυρο διαλόγου Align. Όλες οι άλλες 
εικόνες εμφανίζονται τώρα κλειδωμένες στο παράθυρο thumbnail.   

Με την επιλογή "Μerge Group" - όλες οι επιλεγμένες εικόνες λαμβάνονται από 
μια σταθερή θέση σε σχέση με τον δίσκο βαθμονόμησης και μπορούν 
επομένως να ευθυγραμμιστούν σε ένα ενιαίο βήμα.  

 
Βήμα 2  
Σε αυτό το σημείο, εξετάζεται το παράθυρο View model- στο οποίο 
επιδεικνύεται το τρέχον μοντέλο ημι-διαφανώς από το επιλεγμένο σύνολο 
εικόνων. Είναι δυνατή η περιστροφή και η κίνηση του μοντέλου. 
Χρησιμοποιώντας τις εντολές  Next view(ή το Last view) από την ράβδο 
εργαλείων View model το πρόγραμμα θα επιστρέψει στο προηγούμενο 
στάδιο. 

Επιπλέον είναι δυνατή η επιλογή των εντολών(First Image, Previous Image, 
Next Image και Last Image) στο παράθυρο για να κινηθεί προς μια 
διαφορετική εικόνα. Όταν μεταφερθεί σε μια διαφορετική εικόνα, το μοντέλο 
θα περιστραφεί έτσι ώστε να συνδυαστεί όσο το δυνατόν με μεγαλύτερη 
ακρίβεια με το δεύτερο σύνολο εικόνων.   
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ΣΗΜΕΙΩΣΗ: Η παραπάνω διαδικασία μπορεί να πραγματοποιηθεί είτε με 
διπλό κλικ σε μια εικόνα στο thumbnail είτε  σύροντας  μια εικόνα από το 
παράθυρο thumbnail επάνω στο παράθυρο View model. 

 
Βήμα 3  
Εφ' όσον υπάρχουν αρκετές εικόνες στο δεύτερο σύνολο και έχει γίνει 
εντοπισμός φόντου,  το 3DSOM Pro θα είναι σε θέση να ευθυγραμμίσει το 
μοντέλο αυτόματα. Αυτό είναι ένα μεγάλο πλεονέκτημα, δεδομένου ότι είναι 
κουραστικό να ευθυγραμμιστεί με το χέρι - μπορεί να φανεί καλό από μια όψη, 
αλλά από μια διαφορετική όψη μπορεί να απέχει από την ευθυγράμμιση. 
Χρησιμοποιώντας  την εντολή Guess το  3DSOM Pro η αρχική ευθυγράμμιση 
θα επιλεγεί τυχαία.   

ΣΗΜΕΙΩΣΗ: Εναλλάσσοντας μεταξύ των View wireframe model(F5), και 
View flat shaded model(F6) ή View textured model (F7) επιλέγονται τρόποι 
επίδειξης που  βοηθούν στην παρουσίαση του μοντέλου.   

Μερικές φορές, ιδιαίτερα με τα αρκετά συμμετρικά μοντέλα, το  3DSOM Pro 
δεν έχει τη δυνατότητα να δείξει ποιος τρόπος χρησιμοποιείται γύρω από 
κάθε μοντέλο – όσον αφορά την ευθυγράμμιση του. 

Εάν η αντιστοιχία δεν είναι τέλεια σε αυτή τη φάση δεν πρέπει να είναι 
ανησυχητικό- απλά επιλέγοντας την εντολή "Νext"  το πρόγραμμα θα 
προχωρήσει στο στάδιο βελτίωσης όταν ο προσανατολισμός είναι κατά 
προσέγγιση σωστός σε σχέση με τις υπόλοιπες  εικόνες.   

ΣΗΜΕΙΩΣΗ: Εάν καμία από τις εντολές guess δεν πετυχαίνει μια σωστή 
προσέγγιση, θα πρέπει να περιστραφεί με το χέρι και να κινηθεί το μοντέλο 
έως ότου ευθυγραμμιστεί κατά προσέγγιση.   
 

Βήμα 4  
Κατά τη διάρκεια του σταδίου βελτίωσης ,το 3DSOM  Pro τείνει να κάνει 
ελάχιστες αλλαγές στον προσανατολισμό και τη θέση του μοντέλου, 
ελέγχοντας ταυτόχρονα αν ταιριάζει με την γεωμετρία των επιλεγμένων 
εικόνων. Κατά τη διάρκεια αυτής της διαδικασίας το μοντέλο θα αλλάζει 
διαρκώς υφή. Η διαδικασία μπορεί να διακοπεί σε οποιοδήποτε στάδιο έχει 
επιτευχθεί το επιθυμητό αποτέλεσμα. Xχρησιμοποιώντας την επιλογή Last 
view από την ράβδο εργαλείων View model,το πρόγραμμα θα επανέλθει στην 
προηγούμενη ευθυγράμμιση.   

  
ΒΒήήμμαα  55  
Με το κλείσιμο του παραθύρου θα ολοκληρωθεί η ευθυγράμμιση του 
δεύτερου συνόλου εικόνων σχετικά με το πρώτο. Μπορούν τώρα να 
χρησιμοποιηθούν στο πρόγραμμα με τον ίδιο τρόπο όπως  το αρχικό σύνολο 
εικόνων. Εάν είχε χρησιμοποιηθεί πρόσθετο σύνολο εικόνων για να 
συμπεριληφθούν περισσότερες πληροφορίες μορφής, θα πρέπει να 
συνεχιστεί η δημιουργία της  γεωμετρίας  και έπειτα της υφής . Εάν το 
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αποτέλεσμα είναι το επιθυμητό όσον αφορά  τη γεωμετρία, το πρόγραμμα  θα 
πρέπει να προχωρήσει ώστε να αναπαραχθεί και η αντίστοιχη υφή.  

2.6.3. Λήψη των σωστών φωτογραφιών.  
 
Γενικά όσο περισσότερες φωτογραφίες χρησιμοποιούνται για τη δημιουργία 
ενός τρισδιάστατου μοντέλου, τόσο πιο καλό είναι το τελικό αποτέλεσμα που 
αποδίδει το πρόγραμμα του 3DSOM σε σχέση με τη πραγματική του 
μορφή.Εντούτοις μπορούν να χρησιμοποιηθούν λιγότερες εικόνες εφ’ όσον  
λαμβάνονται από προσεκτικά επιλεγμένες γωνίες.   Εξετάζοντας την 
διαμόρφωση του μοντέλου μπορεί να καθοριστεί ο σωστός αριθμός 
φωτογραφιών που θα πρέπει να ληφθούν και ποιες  γωνίες είναι οι 
καταλληλότερες.   
 
Κυβικά μοντέλα  
Κατά φωτογράφιση των αντικειμένων που έχουν επίπεδη επιφάνεια, όπως ο 
κύβος, συνιστάται οι φωτογραφίες να λαμβάνονται έτσι ώστε μια επιφάνεια να 
είναι απόλυτα ορατή. Για παράδειγμα στην περίπτωση ενός κύβου, οι 
φωτογραφίες με τη μπροστινή επιφάνεια θα πρέπει να είναι στην ίδια ευθεία 
με τη φωτογραφική μηχανή και η πλευρά του μόλις ορατή.   

Έστω ότι δύο εικόνες αναπαριστάνουν ένα κύβο. Ο πραγματικός κύβος 
παρουσιάζεται, σε συνδυασμό με τη σκιά που δημιουργείται πίσω από τη 
θέση του μοντέλου. Το 3DSOM Pro δεν έχει τη δυνατότητα να γνωρίζει αν η 
περιοχή αυτή θα πρέπει να εντάσσεται στο πλαίσιο εντοπισμού φόντου ή όχι.   

Έτσι,κατά την δημιουργία ενός wireframe, το 3DSOM Pro , στην 
πραγματικότητα επεξεργάζεται τα μέρη του μοντέλου που πρόκειται να 
χρησιμοποιηθούν στην αντίστοιχη γεωμετρία του . Με τη λήψη φωτογραφιών 
οι οποίες εστιάζουν στην άκρη της μιας επιφάνειας του μοντέλου,  
επιτυγχάνεται ένας περισσότερο ακριβής εντοπισμός φόντου στην περιοχή 
αυτή.   

Υπάρχουν δύο παραδείγματα ενός κυβικού αντικειμένου. Ο πρώτος 
δημιουργήθηκε χρησιμοποιώντας φωτογραφίες που έχουν ληφθεί από 
διαφορετικές γωνίες γύρω από το μοντέλο, ενώ  ο δεύτερος από τέσσερις 
επιπρόσθετες φωτογραφίες  που έχουν ληφθεί από τις  γωνίες κάθε πλευράς 
του μοντέλου. 

Συγκρίνοντας τους δύο αυτούς κύβους, παρατηρήθηκε ότι το δεύτερο μοντέλο 
έχει πολύ πιο αιχμηρές άκρες σε σχέση με το πρώτο και αυτό διότι οι 
φωτογραφίες που λαμβάνονται από μια γωνία σχεδόν παράλληλη στα 
μοντέλα που χρησιμοποιούνται κάθε φορά επιτρέπουν στο 3DSOM Pro να 
‘’τονίζει’’ τις  πολύ αιχμηρές επιφάνειες.   

 
Κυλινδρικά μοντέλα 
Κατά τη φωτογράφηση μοντέλων που διακρίνονται από κυλινδρικά μέρη, είναι 
ουσιαστικό να εισαχθούν στο 3DSOM Pro πολλές και διαφορετικές 
φωτογραφίες όσον αφορά την γωνία λήψης  
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Παρά τη δυνατότητα του 3DSOM Pro να δημιουργεί την γεωμετρία ενός 
μοντέλου, ωστόσο σε κυλινδρικά μοντέλα ενδέχεται να παρουσιαστεί 
πρόβλημα όσον αφορά τα κοίλα σημεία του μοντέλου, εμφανίζοντάς τα 
τετραγωνισμένα. Αυτό το πρόβλημα αντιμετωπίζεται χρησιμοποιώντας την 
εντολή βελτίωσης της γεωμετρίας– βλ. Optimising the surface geometry 
Και σε αυτήν την περίπτωση όμως, ο χρήστης πρέπει να παρέχει στο 3DSOM 
Pro έναν λογικό αριθμό εικόνων, που έχουν ληφθεί από διαφορετικές γωνίες, 
γύρω από την κυλινδρική μορφή του μοντέλου. Ενώ  το 3DSOM Pro θα 
δημιουργεί το αρχικό wireframe, ο αριθμός ευθειών ακρών μπορεί να αυξηθεί 
στο σημείο όταν παραχθεί η κυλινδρική μορφή (ειδικά μετά από τη βελτίωση).   

 
 Μοντέλα με επίπεδες και κυρτές επιφάνειες  
Στη περίπτωση μοντέλων που έχουν επίπεδες και κυρτές επιφάνειες, όπως 
συμβαίνει σε πολλά μοντέλα, πρέπει να δοθεί η απαραίτητη προσοχή ώστε να 
εξασφαλιστεί η λήψη ενός κατάλληλου συνόλου φωτογραφιών.   

Οι φωτογραφίες που θα ληφθούν θα πρέπει να είναι τόσο από σημεία όπου 
το ύψος της φωτογραφικής μηχανής θα είναι παράλληλα με το ύψος του 
μοντέλου για την ακριβέστερη δημιουργία γεωμετρίας του σε σχέση με τις 
αιχμηρές άκρες, όσο και από διαφορετικές γωνίες γύρω από το μοντέλο ώστε 
η εικονική κυλινδρική μορφή που θα δημιουργηθεί να μην απέχει πολύ από 
την πραγματική. 
ΣΗΜΕΙΩΣΗ: Ένας εναλλακτικός τρόπος αυτού του παραδείγματος  είναι να 
ληφθούν δύο ξεχωριστά σετ φωτογραφιών (το πρώτο σετ θα αντιστοιχεί στο 
κυλινδρικό μέρος του μοντέλου και το δεύτερο στο επίπεδο). Οι δύο σαρώσεις 
μπορούν να συγχωνευθούν χρησιμοποιώντας την εντολή Merging multiple 
scans. 

2.6.4.Επεξεργασία της γεωμετρίας απο εξωτερικές εφαρμογές. 
 
Μερικές φορές το 3DSOM Pro δεν είναι ικανό να διαμορφώσει ακριβώς τη 
γεωμετρία επιφάνειας ενός μοντέλου χρησιμοποιώντας τις διαμορφώσεις που 
προκύπτουν μετά την δημιουργία εντοπισμού φόντου. Παραδείγματος χάριν 
εάν υπάρχουν σημαντικές κοίλες περιοχές στο μοντέλο ή ιδιαίτερα συμμετρικά 
χαρακτηριστικά όπως ένα κυλινδρικό μέρος που απαιτούν  ακριβή 
διαμόρφωση.   

Το 3DSOM Pro παρέχει έναν μηχανισμό που επιτρέπει στους πεπειραμένους 
χρήστες τρισδιάστατης  δημιουργίας να χρησιμοποιήσουν ένα εργαλείο 
τρισδιάστατης διαμόρφωσης  όπως το 3D Studio max του Discrete. Το 
επεξεργασθέν πλέγμα μπορεί να εισαχθεί στο 3DSOM Pro έτσι ώστε τα 
εργαλεία του 3DSOM Pro να μπορούν να χρησιμοποιηθούν για να 
δημιουργήσουν αυτόματα μία εικονική υφή.   

 

ΠΡΟΕΡΓΑΣΙΑ 
Αρχικό στάδιο είναι η εισαγωγή των φωτογραφιών στο πρόγραμμα, η 
δημιουργία εντοπισμού φόντου και η παραγωγή ενός μοντέλου wireframe.  
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Βήμα 1  
Το πλέγμα θα πρέπει να διαμορφωθεί χρησιμοποιώντας το παράθυρο 
επιφάνειας που προωθείται με την εντολή Generate surface.... Επιλέγεται η 
επιλογή "Optimise Surface" ενώ το παράθυρο διαλόγου μπορεί να κλείσει 
όταν επιτευχθεί το επιθυμητό αποτέλεσμα πλέγματος. 

 

ΣΗΜΕΙΩΣΗ: Είναι επιθυμητό να μεταβληθεί ο συνολικός αριθμός τριγώνων 
δημιουργίας wireframe ώστε το 3DS Max να δώσει καλύτερα αποτελέσματα 
στην εκτέλεση ορισμένων διαδικασιών όπως είναι η Boolean.  

 
Βήμα 2  
Το μοντέλο wireframe εξάγεται επιλέγοντας Export model....  Έπειτα ορίζεται 
σαν τύπος φακέλου το 3D Studio Max Object και επιλέγεται ένα κατάλληλο 
3DS όνομα αρχείου και ένα αρχείο χωρίς να κλείσει το πρόγραμμα του 
3DSOM Pro.  

 

Βήμα 3  
Προωθείται τo τρισδιάστατo μοντέλο. Για περισσότερα μοντέλα θα πρέπει να 
υποστηριχθεί ο 3DS τύπος αρχείου. Εισάγεται το 3DS αρχείο που έχει 
αποθηκευτεί.   

 

Βήμα 4  
Τώρα μπορεί να επεξεργαστεί το wireframe χρησιμοποιώντας όλα τα 
διαθέσιμα εργαλεία διαμόρφωσης. Το αποτέλεσμα θα πρέπει να είναι ακόμα 
ένα κλειστό τριγωνικό πλέγμα για να μπορεί να εισαχθεί ξανά στο 3DSOM 
Pro.   

 

 Βήμα 5  
Όταν επιτευχθεί το επιθυμητό αποτέλεσμα εξάγεται το επεξεργασθέν 
wireframe ως 3DS αρχείο πάνω από το αρχικό ή σε ένα νέο αρχείο εάν 
προτιμάται.   

 

Βήμα 6  
Επιστρέφοντας στην εφαρμογή  του 3DSOM Pro με το project που είναι 
ακόμα φορτωμένο γίνεται εισαγωγή του wireframe που επεξεργάστηκε 
χρησιμοποιώντας το στοιχείο επιλογών File > Import... και επιλέγεται η 
εντολή "replace scene".   

 Τώρα μπορούν να χρησιμοποιηθούν όλα τα εργαλεία  3DSOM Pro 
συμπεριλαμβανομένων και των αντίστοιχων για τη δημιουργία υφής του 
μοντέλου χρησιμοποιώντας το παράθυρο διαλόγου δημιουργίας και 
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επεξεργασίας υφής. Τέλος, το μοντέλο μπορεί να εξαχθεί με το επιθυμητό 
σχήμα.   

2.6.5. Προχωρημένες τεχνικές επεξεργασίας υφής. 
 
Μερικές φορές υπάρχουν σημεία του μοντέλου, στα οποία η δημιουργία υφής 
γίνεται αυτόματα. Αυτό οφείλεται στις παραλείψεις όσον αφορά  την ακρίβεια 
της  γεωμετρίας και λήψης των φωτογραφιών. Τα εργαλεία επεξεργασίας 
υφής  που παρέχονται από το 3DSOM Pro ,επιτρέπουν στον παρατηρητή να 
αποβάλει τα περισσότερα χειροποίητα στοιχεία υφής από μία προβληματική 
περιοχή του μοντέλου. Αυτό μπορεί να επιτευχθεί χρησιμοποιώντας την 
επιλογή "Layers" των προγραμμάτων επεξεργασίας εικόνας όπως είναι το 
PaintShop Pro και το PhotoShop.   

 

ΠΡΟΕΡΓΑΣΙΑ 
Δημιουργείται ένα τρισδιάστατο μοντέλο από ένα σύνολο φωτογραφιών. 
Έπειτα  προσδιορίζονται οι προβληματικές περιοχές όπου η υφή στα σημεία 
αυτά μπορεί να βελτιωθεί χρησιμοποιώντας μια από τις αρχικές φωτογραφίες.   

 

Βήμα 1  
Θα πρέπει να βρεθεί μια φωτογραφία της προβληματικής περιοχής όπου το 
σημείο αυτό να είναι αρκετά ευκρινές. Σε ιδανικές περιπτώσεις θα πρέπει  να 
είναι κοντά στη "πρόσοψη" της περιοχής που χρειάζεται διόρθωση. Επιλέγεται 
το thumbnail για να επιβεβαιωθεί ότι έχει βρεθεί η σωστή εικόνα.  

 

Βήμα 2  
Η φωτογραφία πρέπει να μεταφερθεί σε μια δυσδιάστατη εφαρμογή εικόνας. 
Αυτό επιτυγχάνεται δημιουργώντας πλαίσια έτσι ώστε η διορθωμένη 
χρωματικά εικόνα να επεξεργαστεί όπου απαιτείται. Για να γίνει αυτό θα 
πρέπει να επιλεγεί η εντολή Ιmages > Copy Image. 

Έτσι θα επικολληθεί το πλαίσιο που δημιουργήθηκε ως νέα 2D εικόνα  στην 
περιοχή επεξεργασίας της εικόνας. Μεταβάλλοντας την όψη του 
τρισδιάστατου μοντέλου θα ευθυγραμμιστεί με τη δυσδιάστατη εικόνα και θα 
επιδειχθεί απευθείας. Έπειτα αντιγράφεται επάνω στην περιοχή πλαισίου 
χρησιμοποιώντας την εντολή Copy view.  

 

Βήμα 4  
Η εικόνα που δημιουργήθηκε στην περιοχή πλαισίου και η 2D  εικόνα  στην 
περιοχή επεξεργασίας της εικόνας πρέπει να ευθυγραμμιστούν σωστά. 
Επιστρέφοντας  στην 2D περιοχή επεξεργασίας της  εικόνας γίνεται η 
επικόλληση της  εικόνας  που υπάρχει στο πλαίσιο ως πρόσθετο "στρώμα" 
πάνω από την υπάρχουσα εικόνα.   
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Σε PhotoShop επιλέγεται απλά η επιλογή "Paste" από τις "Edit" επιλογές. Σε 
PaintShop Pro επιλέγεται η επιλογή "Paste" από τις "Edit" επιλογές και "As 
New Layer".   

 

Βήμα 5  
Για να αντικατασταθεί η περιοχή στην οποία εντοπίζεται το πρόβλημα θα 
πρέπει να δημιουργηθεί εντοπισμός φόντου για το νέο στρώμα και να 
απομακρυνθεί η προβληματική περιοχή ώστε να αποκαλυφθούν τα αρχικά 
στοιχεία της εικόνας. Δηλαδή δημιουργείται ένας αδιαφανής εντοπισμός 
φόντου για το πρόσθετο στρώμα υφής. Σε PhotoShop επιλέγεται "Add Layer 
Mask" από τις επιλογές "Layer" και "Reveal all". Στο PaintShop Pro επιλέγεται 
"New" από τις "Masks" και "Show All".   

 

Βήμα 6  
Με προσεκτική επεξεργασία του φόντου ενός μοντέλου  μπορούμε να 
απομακρύνουμε τις προβληματικές περιοχές για να αποκαλύψουμε τα pixels 
της αρχικής του φωτογραφίας. Κατ' αυτό τον τρόπο μπορεί να γίνει έλεγχος  
του ακριβές ποσοστού της αρχικής και συνδυασμένης υφής.   

ΣΗΜΕΙΩΣΗ: Για να γίνει επεξεργασία του εντοπισμού φόντου σε PhotoShop 
συνιστάται η επιλογή ενός  σκοτεινού ή μαύρου χρώματος πρώτου πλάνου 
χρησιμοποιώντας τον ολισθαίνοντα ρυθμιστή από τη ράβδο εργαλείων 
"Color".Ο εντοπισμός  θα πρέπει να σταματήσει όταν επιτευχθεί το επιθυμητό 
αποτέλεσμα.    

Για την επεξεργασία του εντοπισμού φόντου  σε PaintShop Pro, επιλέγεται η 
"Edit" επιλογή από τις επιλογές "Masks". Κατόπιν επιλέγεται ένα σκοτεινό ή 
μαύρο χρώμα πρώτου πλάνου και έπειτα "Paint Brush’’ από την  κύρια ράβδο 
εργαλείων. Από τις επιλογές εργαλείων προσαρμόζεται το επιθυμητό μέγεθος 
του εργαλείου που θα χρησιμοποιηθεί και μια χαμηλή τιμή για "τη 
σκληρότητα".   

 

Βήμα 7  
Σε PaintShopPro η επίπεδη εικόνα μπορεί έπειτα να αντιγραφεί στην περιοχή 
πλαισίου και να επικολληθεί στο 3DSOM Pro χρησιμοποιώντας το κουμπί 
Paste View. Σε PhotoShop επιλέγεται η εντολή "Move tool" και σύρεται η 
επίπεδη εικόνα στο παράθυρο View model στο 3DSOM Pro.   

2.6.6. Oψη-εξαρτώμενων εικόνων υφής. 
  
Η επιφάνεια ορισμένων μοντέλων παρουσιάζουν ισχυρές αντανακλάσεις ή 
ιδιότητες που ποικίλλουν ανάλογα με την θέση που αυτά παρουσιάζονται. 
Δεδομένου ότι το 3DSOM Pro κανονικά χρησιμοποιεί μία ενιαία υφή για να 
προσαρμόσει την εμφάνιση του μοντέλου, αυτή η παραλλαγή δεν φαίνεται στο 
τελικό μοντέλο.   
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Για να βελτιωθεί η όψη των μοντέλων αυτών, το 3DSOM Pro μπορεί να 
δημιουργήσει υφή εξαρτώμενης όψης έτσι ώστε να  εμφανίζονται οι αλλαγές  
στο μοντέλο ανάλογα με την θέση που παρουσιάζεται. H μέθοδος αυτή είναι 
παρόμοια με αυτήν του QuickTime VR, αλλά σε πραγματική τρισδιάστατη 
μορφή. 

Για την δημιουργία της υφής του μοντέλου, το πρόγραμμα  χρησιμοποιεί τη 
διαφορά μεταξύ των πληροφοριών υφής από κάθε μια αρχική εικόνα.   

 
ΠΡΟΕΡΓΑΣΙΑ 
Η εκκίνηση γίνεται με το ολοκληρωμένο τρισδιάστατο μοντέλο, 
συμπεριλαμβανομένου και της υφής του. Η όψη εξαρτώμενων εικόνων υφής 
δεν αποθηκεύεται με το πρόγραμμα 3DSOM λόγω του ότι είναι μεγάλου 
μεγέθους, οπότε το τελικό μοντέλο θα πρέπει να εξαχθεί πρίν κλείσει το 
πρόγραμμα.   
 

Βήμα 1  
Γίνεται άνοιγμα του παράθυρου διαλόγου υφής επιλέγοντας την εντολή 
Generate texture map.... Έπειτα "Generate view dependent Texture 
maps" και Next >.   

 

Βήμα 2  
Το συνολικό μέγεθος της όψης εξαρτώμενης υφής που θα προκύψει είναι 
ανάλογο του αριθμού εικόνων που θα χρησιμοποιηθούν για να το παράγουν - 
εντούτοις για να παραχθεί μια ομαλή υφή, θα χρειαστεί ένας  μεγάλος  
αριθμός εικόνων. Συνίσταται τουλάχιστον 16 εικόνες γύρω από το μοντέλο και 
το λιγότερο  32. Μπορεί να περιοριστεί ο αριθμός εικόνων που θα 
χρησιμοποιηθούν σε αυτή τη φάση –καθώς μπορούν να επιλεγούν αυτόματα 
χρησιμοποιώντας την εικόνα "Order" (βλ.The Thumbnail Window για  
λεπτομέρειες αλλαγής της εντολής αυτής).   

ΣΗΜΕΙΩΣΗ:  

Οποιαδήποτε εικόνα δεν είναι επιθυμητό να χρησιμοποιηθεί σε αυτό το στάδιο 
μπορεί προσωρινά να χρησιμοποιηθεί ως απορριπτέα και να ενσωματωθεί 
αργότερα. 

 

Βήμα 3  
Επιλέγοντας την εντολή Next > θα  δημιουργηθεί η όψη εξαρτώμενων εικόνων 
υφής . Όταν ολοκληρωθεί, η επιλογή της εντολής View Dependent Textures 
θα επιτρέψει την παρουσίαση των αποτελεσμάτων.  

Για να φανεί η διαφορά, το μοντέλο θα πρέπει να περιστραφεί και να 
μεταπηδήσει στην αρχική του υφή πάλι. Θα πρέπει να εξεταστούν με 
λεπτομέρεια τα κυριότερα σημεία ή οι αντανακλάσεις του μοντέλου. Ενώ 
περιστρέφεται, το όνομα της εικόνας που χρησιμοποιήθηκε για να 
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δημιουργηθεί η όψη εξαρτώμενων εικόνων υφής από την ήδη υπάρχουσα 
όψή επιδεικνύεται στο κεντρικό μενού (βλ. την περιήγηση του 3DSOM Pro ).   

 
Βήμα 4  
Η αποθήκευση του τελικού αποτελέσματος γίνεται με την εντολή ... Εxport 
model και επιλέγεται το 3DSOM Java Viewer ως τύπος αρχείου. Έπειτα η 
εντολή Options... ώστε να εξασφαλιστεί ότι πραγματοποιείται έλεγχος της 
παραπάνω διεργασίας πριν εξαχθεί το μοντέλο σε εξωτερικές εφαρμογές. 

2.6.7. Επικόλληση υφής σε μοντέλο CAD. 
  
 Σε περίπτωση που ήδη υπάρχει ένα μοντέλο CAD wireframe ενός μοντέλου 
(π.χ. από ένα σχέδιο ή μέσω ενός ανιχνευτή λέιζερ). Εντούτοις εφ’ όσον αυτό 
είναι επιθυμητό μπορούν να χρησιμοποιηθούν προηγμένες εντολές του 
προγράμματος 3DSOM Pro,ώστε να δημιουργηθεί ένα μοντέλο το οποίο θα 
αντιπροσωπεύει σε μεγαλύτερο βαθμό την πραγματική του μορφή. 

 Το 3DSOM Pro υποστηρίζει την εισαγωγή γεωμετρίας CAD με 3DS μορφή. Η 
γεωμετρία μπορεί να ευθυγραμμιστεί με ένα μεγάλο σύνολο φωτογραφιών του 
μοντέλου με μια απλή διαδικασία:απλά χρησιμοποιώντας την εντολή 
ευθυγράμμισης. Ο παρατηρητής μπορεί έπειτα αυτόματα να δημιουργήσει μία 
ενιαία υφή για το μοντέλο (αυτόματα με UV ""). Η υφή του μπορεί να βελτιωθεί 
χρησιμοποιώντας τις εντολές επεξεργασίας υφής που διαθέτει το 3DSOM 
Pro,ώστε να  μπορεί να προωθηθεί σε εξωτερικές εφαρμογές ή να 
δημιουργηθεί  μία  3DS τριγωνική επιφάνεια(πλέγμα).   

 

ΠΡΟΕΡΓΑΣΙΑ 
Το μοντέλο CAD θα πρέπει αρχικά να αποθηκευτεί ως ένα 3DS αρχείο. 
Εξάγονται ένα ή περισσότερα μοντέλα τριγωνικής επιφάνειας με 3DS μορφή.  
‘Έπειτα θα πρέπει να ληφθεί ένα σύνολο φωτογραφιών του μοντέλου (με το 
δίσκο, το σκηνικό και τη βάση βαθμονόμησης). Πιθανώς μπορεί να χρειαστεί 
η λήψη πρόσθετων εικόνων της βάσης του.   

 

Βήμα 1  
Με την εκκίνηση του προγράμματος 3DSOM Pro, επιλέγεται η εντολή New 
Project.... Έπειτα επιλέγονται οι φωτογραφίες του μοντέλου εκτός από τις 
αντίστοιχες της βάσης του. 

Βήμα 2  
Πραγματοποιείται ο εντοπισμός φόντου στις φωτογραφίες. Αρχικά επιλέγεται 
η εντολή Mask all images...Εάν είναι απαραίτητο ρυθμίζονται τα κατώτατα 
όρια εντοπισμού και οι εικόνες εξάγονται χρησιμοποιώντας τις εντολές Fine 
tuning the auto masking and Manual masking with the shrink-wrap tool. 
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Βήμα 3  
Το 3DS αρχείο εισάγεται στο 3DSOM Pro χρησιμοποιώντας τα στοιχεία 
επιλογών File > Import.... Επιλέγεται η εντολή "replace the geometry".   

 

ΣΗΜΕΙΩΣΗ: 

Το 3DSOM Pro μπορεί να εισάγει ενιαία τριγωνική επιφάνεια. Εάν η 
γεωμετρία CAD αποτελείται από περισσότερες από μια τριγωνικές επιφάνειες 
εξάγεται κάθε μία ως χωριστό 3DS αρχείο. Κατόπιν εισάγονται τα αρχεία, ένα 
κάθε φορά  χρησιμοποιώντας  την εντολή  "Αdd to scene".   

 

Βήμα 4  
Οι φωτογραφίες μπορούν τώρα να ευθυγραμμιστούν στο τρισδιάστατο 
τριγωνικό πλέγμα. Επιλέγονται  όλες οι εικόνες χρησιμοποιώντας τις εντολές  
Ιmages >Select all. Κατόπιν προωθείται το παράθυρο διαλόγου 
ευθυγράμμισης επιλέγοντας Images > Align Images...   Τέλος "Merge 
Group" και έπειτα Next >. 

 

Βήμα 5  
Σε αυτό το σημείο οι εικόνες του 3DSOM Pro πρέπει να ευθυγραμμιστούν με 
τις  εισαγόμενες  επιφάνειες  CAD. Πρέπει να επιλεγεί η εντολή Guess  ώστε 
το μοντέλο να αποκολληθεί σωστά. Η διαδικασία αυτή μπορεί να έχει 
αρνητική επίδραση στην ποιότητα της εικόνας.   

 

Βήμα 6  
Το 3DSOM Pro θα κάνει αρχικά μια κατά προσέγγιση ευθυγράμμιση. Η 
παραπάνω διαδικασία μπορεί να επαναληφθεί ώστε να επιτευχθεί το 
επιθυμητό αποτέλεσμα. Έπειτα  επιλέγεται Next >.   

 

Βήμα 7  
Για να ευθυγραμμιστούν αυτόματα όλες οι εικόνες αμέσως απλά 
χρησιμοποιείται η εντολή Start. Είναι ορατή η ευθυγράμμιση για κάθε εικόνα 
ενώ η διαδικασία μπορεί  να σταματήσει όταν το αποτέλεσμα είναι 
ικανοποιητικό.   

 

Βήμα 8  
Για να γίνει δεκτή η ευθυγράμμιση επιλέγεται Next > και έπειτα Finish.   
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Βήμα 9  
Μόλις ολοκληρωθεί η δημιουργία της γεωμετρίας του μοντέλου, μπορεί να 
δημιουργηθεί και η αντίστοιχη υφή του (βλ. την προσθήκη της υφής του 
μοντέλου) πριν εξαχθεί (βλ. την επεξεργασία του μοντέλου).   

 ΣΗΜΕΙΩΣΗ:Μπορούν επίσης να ενσωματωθούν οι πρόσθετες εικόνες της 
βάσης του μοντέλου (βλ. την προσθήκη της σύστασης κάτω από ένα 
αντικείμενο) πριν αυτό  εξαχθεί.   

2.6.8. Μοντελοποίηση εξειδικευμένων περιοχών ενός αντικειμένου. 
 
 Για ένα σύνθετο αντικείμενο, μπορεί να είναι χρήσιμο να δημιουργηθεί ένα 
τρισδιάστατο μοντέλο χρησιμοποιώντας μία συγκεκριμένη περιοχή του 
αντικειμένου. Αυτό μπορεί να οδηγήσει στη βελτίωση της διαμόρφωσης του 
μοντέλου.   

Το 3DSOM Pro επιτρέπει την δημιουργία ενός  τρισδιάστατου μοντέλου με μία 
συγκεκριμένη περιοχή του αντικειμένου μέσω της μη-αυτόματης επεξεργασίας   
επιλεγμένων εντοπισμών φόντου.  

 

ΠΡΟΕΡΓΑΣΙΑ 
Εισάγονται οι φωτογραφίες του σύνθετου αντικειμένου. 

 
Βήμα 1  
Χρησιμοποιώντας τις εντολές αυτόματου εντοπισμού φόντου μπορεί πρώτα 
να δημιουργηθεί ένα σύνολο καλύψεων του σύνθετου αντικειμένου. Αυτο θα 
χρησιμοποιηθεί αργότερα για να βοηθήσει τη διαμόρφωση των εντοπισμών 
φόντου. 

 
Βήμα 2  
Το μεγαλύτερο ενδιαφέρον θα δοθεί στην διαμόρφωση της γεωμετρίας του 
μοντέλου. Για να γίνει αυτό θα πρέπει να επιλεγούν διαφορετικές εικόνες και 
να πραγματοποιηθεί ο εντοπισμός φόντου για κάθε μία ξεχωριστά, 
επιλέγοντας με αυτό τον τρόπο την περιοχή που θα χρησιμοποιηθεί στη 
συνέχεια για την μοντελοποίηση της. Οι εικόνες που θα επιλέγούν θα πρέπει 
να απεικονίζουν καθαρά την περιοχή αυτή, ώστε να επιτευχθούν καλύτερα 
αποτελέσματα.  

ΣΗΜΕΙΩΣΗ:Οι υπόλοιπες εικόνες θα πρέπει να συμπεριληφθούν για τον 
καθορισμό της  μορφής του μοντέλου. 

   

Βήμα 3  
Μόλις ολοκληρωθεί η διαδικασία εντοπισμού φόντου, οι εικόνες  
αποθηκεύονται σε ένα νέο project. Χρησιμοποιείται η εντολή File> Save as....  
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Βήμα 4  
Δημιουργείται η τριγωνική επιφάνεια του μοντέλου χρησιμοποιώντας το 
παράθυρο επιφάνειας που προωθείται με την επιλογή Generate surface.... 
Χρησιμοποιώντας  την εντολή "Generate  wireframe" θα παραχθεί ένα 
αρχικό wireframe. Αν είναι απαραίτητο το wireframe αυτό μπορεί έπειτα να 
βελτιωθεί.  Εάν το ενδιαφέρον εστιάζεται αποκλειστικά και μόνο στη μορφή 
του μοντέλου μπορεί να εξαχθεί για την περαιτέρω επεξεργασία του σε μια 
τρισδιάστατη εφαρμογή διαμόρφωσης. Επιπλέον μπορούν να επανεισαχθούν 
για την δημιουργία υφής από τις φωτογραφίες.   

Βήμα 5  
Το επόμενο βήμα είναι να δημιουργηθεί η υφή του μοντέλου. Απαιτείται 
προσοχή, δεδομένου ότι η μη-επιλεγμένη περιοχή της εικόνας δεν 
ενσωματώνεται στην υφή του.   

Επιλέγεται το υποσύνολο των εικόνων που επιθυμείται να χρησιμοποιηθεί στη 
υφή ενώ οι υπόλοιπες εικόνες απορρίπτονται.   

 

Βήμα 6  
Η δημιουργία υφής του μοντέλου γίνεται χρησιμοποιώντας την εντολή 
Generate texture map.Το τελικό αποτέλεσμα μπορεί να προωθηθεί σε 
εξωτερικές εφαρμογές τρισδιάστατης μοντελοποίησης. 
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ΚΕΦΑΛΑΙΟ 3: ΛΟΓΙΣΜΙΚΟ ΣΥΝΘΕΣΗΣ          

ΠΑΝΟΡΑΜΑΤΟΣ (PANOWEAVER) 
 
3.1. Λήψη των φωτογραφιών.    

3.1.1. Λήψη της πρώτης φωτογραφίας. 
   
Η φωτογραφική μηχανή θα πρέπει να τοποθετηθεί με τη βοήθεια ενός 
τρίποδου στο κέντρο του χώρου ενδιαφέροντος.  
 

3.1.2. Λήψη των επόμενων φωτογραφιών. 
   
Η σταθερότητα του τριπόδου θα πρέπει να υποβοηθάτε με το ένα χέρι του 
χρήστη ώστε να αποφευχθούν κραδασμοί που πιθανόν να επηρεάσουν το 
τελικό αποτέλεσμα της λήψης φωτογραφιών. Η φωτογραφική μηχανή 
στρέφεται τόσες μοίρες όσες απαιτούνται για την κάλυψη του χώρου και 
συνεχίζεται η λήψη. 

Προτείνεται η λήψη φωτογραφιών να πραγματοποιείται δεξιόστροφα 
ειδάλλως κατά την φόρτωση τους στον υπολογιστή θα πρέπει να 
αντιστραφεί η φορά τους. 

3.1.3. Λήψη των φωτογραφιών οροφής και πατώματος του χώρου 
λήψης. 
 
Η λήψη των φωτογραφιών που αναφέρονται στην οροφή και το πάτωμα του 
χώρου λήψης, προτείνεται να πραγματοποιείται μετά το τέλος της λήψης των 
υπόλοιπων φωτογραφιών, προκειμένου να μην υπάρξει αλλοίωση του 
αποτελέσματος κατά τη σύνθεση του πανοράματος. 

3.2. Άνοιγμα εικόνας. 
 

Επιλέγεται η εντολή  File > Open Image  ή  το εικονίδιο   από τη ράβδο 
εργαλείων ώστε να φορτωθούν στο πρόγραμμα οι εικόνες. Στο παράθυρο 
διαλόγου του " Open Image", επιλέγεται αρχικά ο κατάλληλος τύπος εικόνας 
και έπειτα καθορίζεται η θέση των εικόνων. Το λογισμικό Panoweaver 
υποστηρίζει τους παρακάτω τύπους αρχείων όπως *.jpeg, *.tiff, *.bmp, *.png 
and *.tga. 
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 3.2

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΠανόραμα τύπου Full Circular

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα α3.2

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΠανόραμα τύπου Drum

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα β3.2

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΠανόραμα τύπου Full Frame
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Σχήμα 3.2γ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανόραμα 
Cube Face

 

Σχήμα 3.2δ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Συμβατοί τύποι 
εικόνας του 
Panoweaver 

4,00

 

• Συμβατοί τύποι εικόνας:   
Πέντε τύποι εικόνας υποστηρίζονται από το Panoweaver 4,00:Circular, 
Drum, Full Frame 4+x, Full Frame 6+x και Cube Face. Για κάθε τύπο 
εικόνας, υπάρχουν οι ακόλουθες επιλογές:  
Circular: 2 ή 3 εικόνες fisheye  
Drum:  4, 4+T, 4+B ή 4+T+B  
Full Frame 4+x:  4, 4+T, 4+B ή 4+T+B   
Full Frame 6+x:  6, 6+T, 6+B ή 6+T+B  
Cube Face: 6  

 

 Το T αναφέρεται στην κορυφαία εικόνα (οροφή) που μπορεί να ληφθεί 
μέσω της περιστρεφόμενης φωτογραφικής μηχανής. Το B αναφέρεται στην 
κατώτατη εικόνα (πάτωμα) που μπορεί να ληφθεί μέσω της περιστρεφόμενης 
φωτογραφικής μηχανής.  

 
• Preview: Με την επιλογή   Preview  θα γίνει η παρουσίαση των 

επιλεγμένων εικόνων. Θα χρειαστεί αρκετός χρόνος για αυτό 
δεδομένου ότι το μέγεθος των εικόνων αυτών είναι πολύ μεγάλο. 

• Auto-select: Με την εντολή αυτή υπάρχει δυνατότητα να επιλεγούν 
όλες οι φωτογραφίες αυτόματα. Όταν επιλεχθεί η πρώτη εικόνα, το 
Panoweaver θα φορτώσει αυτόματα όλες τις άλλες εικόνες που 
σχετίζονται με αυτήν.  

• Rotate: Εάν οι φορτωμένες εικόνες δεν βρίσκονται στη σωστή 
κατεύθυνση, είναι δυνατή η περιστροφή της με την εντολή "Rotate ". 
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3.3. Επεξεργασία εικόνας. 
                                                                                        
Το Panoweaver 4,00 επιτρέπει στο χρήστη να επεξεργαστεί τις φορτωμένες 
εικόνες προκειμένου να δημιουργηθούν πανοράματα με ακρίβεια. Μόνο όταν 
οι εικόνες έχουν συγκεκριμένες παραμέτρους, μπορεί να γίνει η σύνθεση 
σωστά. 

Σχήμα 3.3

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Επεξεργασία 
εικόνων υπό 
συγκεκριμένες 
παραμέτρους

 

 

• Replace Image: Επιτρέπει την αντικατάσταση εικόνων σε περίπτωση 
που η σειρά με την οποία έχουν φορτωθεί στο πρόγραμμα δεν είναι η 
σωστή. Αυτό επιτυγχάνεται απλά επιλέγοντας το εικονίδιο από τη 
ράβδο εργαλείων .  
  
 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 3α3.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΑντικατάσταση εικόνων 

όταν η σειρά είναι τυχαία
 

 

• Τοποθέτηση ή όχι της κορυφής και του πατώματος του χώρου 
ενδιαφέροντος: Το λογισμικό Panoweaver επιτρέπει στο χρήστη να 
συγκρίνει τα αποτελέσματα σύνθεσης σε δύο περιπτώσεις, με ή χωρίς 
εικόνες οροφής και πατώματος. Μετά την εισαγωγή των φωτογραφιών 
συμπεριλαμβανομένων των εικόνων οροφής και πατώματος στο 
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Panoweaver, με την εντολή του εικονιδίου    θα τεθεί εκτός 
λειτουργίας η επιλεγμένη εικόνα οροφής και πατώματος. Με την εντολή 
του εικονιδίου  θα επιτραπεί η εισαγωγή των δύο αυτών εικόνων κατά 
τη σύνθεση του πανοράματος. 

3.4. Μεγέθυνση/Σμίκρυνση. 
 
Οι εικόνες που εισάγονται στο Panoweaver μπορούν να μεγεθυνθούν ή να 
γίνει σμίκρυνση αυτών ανάλογα με τις απαιτήσεις του θεατή.  

Τέσσερις τρόποι για μεγέθυνση/σμίκρυνση της επιλεγμένης εικόνας:  

1) Επιλογή CTRL + + για zoom in και CTRL + - για zoom out της εικόνας.  
2) Επιλογή των εντολών Image>View>Zoom in/zoom out.  
3) Μεταβολή της αξίας που εμφανίζεται στο παράθυρο της ράβδου εργαλείων 
μεταξύ 12,5 και 800. 
5) Επιλογή των εικονιδίων  και .  

Σχήμα 3.4

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Μεγέθυνση και 
σμίκρυνση εικόνων 
στο Panoweaver

 

 

3.5. Περιστροφή της εικόνας. 
 
Μερικές φορές είναι απαραίτητη η διόρθωση της κατεύθυνσης των 
εισαγόμενων εικόνων ώστε να μη παραχθεί ένα διαστρεβλωμένο πανόραμα. 
Με την επιλογή της εντολής Image>Rotate/Flip  ή με δεξί κλικ, η εικόνα μπορεί 
να περιστραφεί 90-μοίρες δεξιόστροφα ή αντίθετα με τη φορά των δεικτών του 
ρολογιού. Επιπλέον είναι δυνατή η αντιστροφή της εικόνας κατά  180 μοίρες 
οριζόντια ή κάθετα.  
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Σχήμα 3.5

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Εντολές 
περιστροφής 
εικόνων στο 
Panoweaver

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα α3.5

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕντολές περιστροφής 

εικόνων στο Panoweaver
 

 

3.6. Επεξεργασία εικόνας 

3.6.1. Ισορροπία χρώματος. 
  
Το Panoweaver επιτρέπει στο θεατή να αλλάξει τα επίπεδα χρωμάτων μέσα 
σε μια εικόνα.  Επιλέγεται η ακολουθία εντολών Image>Adjust>Color  ή δεξί 
κλικ του κέρσορα, ώστε να εμφανιστεί το παράθυρο διαλόγου ισορροπίας 
χρώματος που απεικονίζεται παρακάτω:  
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Σχήμα 3.6.1

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αλλαγή επιπέδων 
των χρωμάτων σε 

μια εικόνα

 

Οι τιμές "RGB" θα πρέπει να κυμαίνονται μεταξύ -100 και 100. 

3.6.2.Φωτεινότητα και αντίθεση. 
  
Το Panoweaver επιτρέπει στον χρήστη του προγράμματος να ρυθμίσει τη 
φωτεινότητα και την αντίθεση της εικόνας που επεξεργάζεται. Εάν μια εικόνα 
είναι πάρα πολύ φωτεινή ή πάρα πολύ σκοτεινή, μπορούν να 
χρησιμοποιηθούν οι εντολές ελέγχου φωτεινότητας και αντίθεσης ώστε να 
βελτιωθεί η εικόνα.  

Επιλέγεται η εντολή Image>Adjust>Brightness/Contrast  ή δεξί κλικ του 
κέρσορα, και το πλαίσιο διαλόγου φωτεινότητας/αντίθεσης θα εμφανιστεί:  

Σχήμα 3. 26.

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Αλλαγή 
φωτεινότητας και 
αντίθεσης σε μια 

εικόνα

 

Η ρύθμιση γίνεται είτε με την βοήθεια του κέρσορα είτε με την αλλαγή των 
τιμών στο πλαίσιο δεξιά.   

Οι τιμές  "Φωτεινότητας" and "Αντίθεσης" θα πρέπει να κυμαίνονται 
μεταξύ -100 και 100. 
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3.6.3. Χρώμα και κορεσμός. 
  
α)Η συγκεκριμένη παράμετρος αναφέρεται στα χρώματα βάσης μιας εικόνας. 

β)Ο κορεσμός της εικόνας αναφέρεται στην ένταση των χρωμάτων της.  

Επιλέγονται η εντολές Image>Adjust>Hue/Saturation  ή δεξί κλικ, ώστε το 
πλαίσιο διαλόγου χρώματος/κορεσμού να εμφανιστεί:  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 3.6.3

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΡύθμιση των χρωμάτων και των 

επιπέδων κορεσμού
 

Η ρύθμιση των χρωμάτων και των επιπέδων κορεσμού επιτυγχάνεται 
χρησιμοποιώντας τον κέρσορα ή με την αλλαγή των τιμών στο πλαίσιο δεξιά 
όπως φαίνεται παραπάνω.  

 Η τιμή "του χρώματος" πρέπει να κυμαίνεται μεταξύ -180 και 180,  

      Η τιμή "του κορεσμού" πρέπει να κυμαίνεται μεταξύ -100 και 100.  

3.7. Θολότητα και τραχύτητα.                                                                                    

3.7.1. Θολότητα. 
Με τη βοήθεια του ολισθαίνοντα ρυθμιστή για την θολότητα, μπορούν να 
εξομαλυνθούν ορισμένες περιοχές μιας εικόνας. Το εργαλείο αυτό μπορεί να 
απεικονίζει τις περιοχές μιας εικόνας να εμφανίζονται σαν ήταν εκτός πεδίου.  

Με την εντολή Image>Filter>Blur  ή με δεξί κλικ, θα εμφανιστεί το παράθυρο 
διαλόγου που απεικονίζεται παρακάτω: 
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Σχήμα 3.7.1

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Ο ολισθένοντας 
ρυθμιστής για 
την θολότητα

 

Η τιμή θολότητας θα πρέπει κυμαίνεται μεταξύ 0-100. 

3.7.2.Τραχύτητα 
  
Το εργαλείο Sharpen έχει ακριβώς αντίθετη λειτουργία από αυτή του 
εργαλείου θολότητας. Συγκεκριμένα επιτρέπει την δημιουργία τραχιάς 
επιφάνειας στις άκρες μιας εικόνας.  

Επιλέγεται Image>Filter>Sharpen  ή δεξί κλικ, ώστε να εμφανιστεί το 
παράθυρο διαλόγου Sharpen:  
 

 Η τιμή Sharpen πρέπει να είναι μεταξύ 0-100. 
 

Σχήμα 3.7.2

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Ο ολισθένοντας 
ρυθμιστής για τ

εργαλείο 
o 

Sharpen

 

3.8. Αποθήκευση των παραμέτρων σύνθεσης. 
 
Εάν το αποτέλεσμα πανοράματος που θα προκύψει είναι το επιθυμητό, τότε 
οι παράμετροι που χρησιμοποιήθηκαν είναι δυνατό να αποθηκευτούν , ώστε 
να μπορούν να χρησιμοποιηθούν περαιτέρω σε άλλες εφαρμογές.  

Επιλέγεται  Panorama>save stitching Parameter ή από το πληκτρολόγια 
CTRL + W για να αποθηκευτούν οι παράμετροι σύνθεσης.  
Εισάγετε ένα όνομα παραμέτρου και στη συνέχεια επιλέγεται η εντολή Save. 
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 3.8

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΑποθήκευση των 

παραμέτρων σύνθεσης
 

3.9. Επεξεργασία των παραμέτρων σύνθεσης. 
 
Το λογισμικό Panoweaver επιτρέπει στο χρήστη να μπορεί να διαχειριστεί 
όλες τις αποθηκευμένες παραμέτρους σύνθεσης. Με την επιλογή Panorama 
>Manage Stitching Parameter, μπορεί να γίνει επεξεργασία των 
αποθηκευμένων παραμέτρων σύνθεσης.  

• Import: Επιλέγεται μια παράμετρος, με δεξί κλικ ή με την επιλογή της 
εντολής Import. Εάν άλλοι έχουν κρατήσει αυτές τις παραμέτρους, και 
θέλετε να συνθέσετε εικόνες που έχουν ληφθεί με τον ίδιο εξοπλισμό, 
μπορούν να εισαχθούν οι παράμετροι τους σε Panoweaver, και να 
συνθέσετε τις εικόνες εκείνες με αυτήν την παράμετρο.  

• Export: Επιλέγεται μια παράμετρος, με δεξί κλικ ή με την εντολή  
Export  από το παράθυρο διαλόγου. Εάν επιτευχθεί το επιθυμητό 
αποτέλεσμα με μία παράμετρο, τότε αυτή μπορεί να εξαχθεί και να 
δημοσιευτεί σε τρίτους.  

• Delete: Επιλέγεται μια παράμετρος, με δεξί κλικ ή με την επιλογή 
Delete για να διαγραφούν οι παράμετροι.  

• Rename: Επιλέγεται μια παράμετρος, με δεξί κλικ ή την εντολή  
Rename για να μετονομαστεί μια παράμετρος.  

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 3.9

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕπεξεργασία των 

παραμέτρων σύνθεσης
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3.10. Σύνθεση με τις προηγούμενες παραμέτρους. 
 
Με την εντολή Panorama>Stitch with Former Parameters  θα γίνει σύνθεση 
των εικόνων με τις προηγούμενες παραμέτρους.  

Εάν οι εικόνες που εισάγονται στο πρόγραμμα έχουν ληφθεί με τον ίδιο 
εξοπλισμό και τις ίδιες τοποθετήσεις όπως τις προηγούμενες, τότε είναι 
δυνατό να εφαρμοστούν οι ίδιες παράμετροι σύνθεσης σε όλες ώστε να 
εξοικονομηθεί αρκετός χρόνος. 

 

Σχήμα 3.10

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Σύνθεση με τις 
προηγούμενες 
παραμέτρους

 

3.11. Προσθήκη οροφής και πατώματος. 
 
Είναι δυνατή η πρόσθεση των εικόνων οροφής και πατώματος σε ένα 
ολοκληρωμένο πανόραμα με τους παρακάτω τρόπους: 

1. Επιλέγεται το πάτωμα ή η οροφή από την λίστα, έπειτα  για να προστεθεί 
ή για να αφαιρεθεί η οροφή και αντίστοιχα για να προστεθεί ή  για να 
αφαιρέσει το πάτωμα.  

2. Διπλό κλίκ στην περιοχή εικόνων Ceiling/Floor,ώστε να εμφανιστεί το 
παράθυρο διαλόγου και να προστεθεί η οροφή ή το πάτωμα. Με διπλό κλίκ 
στην ίδια περιοχή θα αφαιρεθεί πάλι η οροφή ή το πάτωμα.  
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Σχήμα 3. α11

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Προσθήκη οροφής

 

Σχήμα 3. β11

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Προσθήκη 
πατώματος

 

Μετακινώντας τον ολισθαίνοντα ρυθμιστή ή εισάγοντας μια ορισμένη τιμή θα 
ρυθμιστεί το μέγεθος εικόνας της οροφής και του πατώματος. Η τιμή πρέπει 
να είναι μεταξύ "0" και "45". Εάν επιλεχθεί η "τελευταία-χρησιμοποιούμενη 
αξία" στις προηγμένες τοποθετήσεις, θα εφαρμόσει την τελευταία-
χρησιμοποιούμενη παράμετρο.  

 

3.12. Παρουσίαση πανοράματος.  
 
Η παρουσίαση ενός πανοράματος είναι διαθέσιμη μετά από την διαδικασία 
pre-stitch και stitch έτσι ώστε ο θεατής να μπορεί να επέμβει στη προσαρμογή 
του πανοράματος πριν από την δημοσίευσή του. 

Με την εντολή   File>Preview Panorama  ή   από την ράβδο εργαλείων το 
πανόραμα που έχει δημιουργηθεί , μπορεί να προβληθεί. 

 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  116

Σχήμα 3.12α

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Παρουσίαση 
παναράματος

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα .12β3

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΠλήκτρα για την παρουσίαση 

του πανοράματος
 

 

3.13. Pre-stitch. 
                                                                                       
Αφότου φορτωθούν οι εικόνες fisheye στο λογισμικό Panoweaver, 

επιλέγοντας την εντολή  Panorama>Pre-stitch  ή το εικονίδιο  . Δεδομένου 
ότι μπορεί να τεθεί ένα σχετικά μικρότερο μέγεθος για το προ-συντιθέμενο 
πανόραμα, θα χρειαστεί λιγότερος χρόνος από τη διαδικασία σύνθεσης. Εάν 
το αποτέλεσμα προ-σύνθεσης είναι το επιθυμητό, μπορεί να ακολουθήσει η 
διαδικασία σύνθεσης του πανοράματος. Σε αντίθετη περίπτωση, μπορούν να 
επεξεργαστούν οι εικόνες και να συντεθούν έπειτα ώστε να προκύψει 
καλύτερο αποτέλεσμα.  

Επιλέγοντας τις παρακάτω εντολές Tools>Advanced Settings>Pre-stitch 
Panoramic Image Size   είναι δυνατή η ρύθμιση του μεγέθους της pre-stitch 
πανοραμικής εικόνας. Όσο μικρότερο είναι το μέγεθος, τόσο γρηγορότερα θα 
γίνει η σύνθεση. Συνιστάται το μέγεθος της εικόνας να είναι 1400*700.  
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Σχήμα 3.13

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Ρύθμιση του 
μεγέθους της 

Προ-σύνθενσης

 

 

3.14. Σύνθεση (Stitch). 
 

Επιλέγεται η εντολή Panorama>Stitch  ή  από τη ράβδο εργαλείων για να 
συντεθεί το πανόραμα αυτόματα.  

 

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 143.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΣύνθεση ( ) της παναραμικής 

εικόνας
stitch  

 
 

3.15. Επεξεργασία της πανοραμικής εικόνας. 
 
Με την επιλογή  Image>Adjust/Filter  ή με δεξί κλικ και την εντολή ρύθμιση της 
ισορροπίας χρώματος, της φωτεινότητας και της αντίθεσης, του χρώματος και 
του κορεσμού χρώματος,  θολότητα ή τραχύτητα  είναι δυνατή η διόρθωση 
της πανοραμικής εικόνας όσον αφορά τις παραμέτρους αυτές.  

Επιλέγοντας την εντολή Image>Adjust>Overlap Blending  θα ρυθμιστεί το 
πλάτος των ραφών της εικόνας.  
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 13. 5

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΕπεξεργασία της παναραμικής 

εικόνας
 

Preview: Ενεργοποιήστε το τετραγωνίδιο Preview για να παρουσιαστεί το 
τελικό αποτέλεσμα επεξεργασίας.  

Apply to All: Εάν το τελικό αποτέλεσμα είναι το επιθυμητό, ενεργοποιώντας 
το τετραγωνίδιο Apply to All Stitching Seams θα εφαρμοστούν οι 
συγκεκριμένοι παράμετροι σε όλα τα ζευγάρια εικόνων.   

3.16. Αποθήκευση πανοραμικής εικόνας. 
 
Η αποθηκευμένη πανοραμική εικόνα μπορεί να χρησιμοποιηθεί σε περαιτέρω 
επεξεργασία, εκτύπωση, έκδοση είτε για την δημιουργία πανοράματος 
πολλαπλών εικόνων.  

Επιλέγοντας την εντολή  File > Save as  ή  από τη ράβδο εργαλείων θα 
αποθηκευτεί η πανοραμική εικόνα. Αρχικά θα πρέπει να συμπληρωθεί το 
όνομα καθώς επίσης και ο κατάλληλος τύπος αρχείου.  

Οι τύποι αρχείων που υποστηρίζει το λογισμικό Panoweaver είναι οι 
ακόλουθοι:   

 

JPEG Image Format (*. jpeg; *. Jpg) 

Tiff Image Format (*. tiff; *. tif) 

Bitmap (*. bmp) for Windows only and Pict (*.pict) for Macintosh only 

Portable Network Graphics (*. png) 

Targa Files (*. tga) 

Photoshop (*. psd) 
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Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ
Σχήμα 163.

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩΑποθήκευση της παναραμικής 

εικόνας
 

3.16.1 Ποιοτικός έλεγχος εικόνας JPΕG. 
  
Για τύπους αρχείων JPEG, μπορεί να ρυθμιστεί η ποιότητα JPEG με την 
επιλογή Options στο παραπάνω παράθυρο αποθήκευσης.  

Σχήμα 3.16.1

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Ρύθμιση ποιότητας 
JPEG

 

Με τη βοήθεια του  ολισθαίνοντα ρυθμιστή ή τα βέλη στο πληκτρολόγιο είναι 
δυνατό να επιτευχθεί αυτό. Η τελική εικόνα μπορεί να είναι ελαφρώς 
συμπιεσμένη σε σχέση με την αρχική. Η ποιότητα Jpeg μπορεί να επηρεάσει 
το μέγεθος της εικόνας πολύ, γι’ αυτό θα πρέπει να επιλεγεί μία τιμή βάσει του 
μεγέθους αρχείων και της ποιότητας εικόνας (γενικά συνιστάται η τιμή 75).  

3.17. Δημιουργία εικονικής περιήγησης σε Tourweaver. 
                                                                  
Για τους περισσότερους από τους χρήστες, το λογισμικό Panoweaver δεν 
είναι αρκετό. Συνήθως προτιμάται μία εικονική περιήγηση πολλαπλών 
σκηνών με διαλογικό χάρτη, κυριολεκτική περιγραφή, το λογότυπο 
επιχείρησης κ.λπ.  

Το Tourweaver, είναι ένα επαγγελματικό λογισμικό εικονικής περιήγησης 
Easypano, που μπορεί να ανταπεξέλθει στις απαιτήσεις αυτές. Απλά 
εισάγονται οι πανοραμικές εικόνες στο Tourweaver. 
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Σχήμα 3.17

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Δημιουργία 
εικονικής 

περιήγησης σε 
Tourweaver
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ΚΕΦΑΛΑΙΟ 4: ΕΦΑΡΜΟΓΗ-ΠΡΟΣΟΜΟΙΩΣΗ ΤΟΥ 
ΒΥΖΑΝΤΙΝΟΥ ΜΟΥΣΕΙΟΥ ΧΑΝΙΩΝ (SAN SALVATORE). 

 

4.1 Δημιουργία πανοραμικών εικόνων. 
 
Για την δημιουργία εικονικής περιήγησης του Βυζαντινού Μουσείου Χανίων 
απαιτήθηκε να δημιουργηθούν πέντε πανοραμικές εικόνες ώστε να καλυφθεί 
το σύνολο του χώρου εξωτερικά και εσωτερικά. 
 
Για κάθε πανοραμική εικόνα απαιτήθηκε η λήψη έξι εικόνων, 
συμπεριλαμβανομένων και αυτών της οροφής και του πατώματος με 
ευρυγώνιο φακό. Μερικές από τις φωτογραφίες που λήφθηκαν απεικονίζονται 
παρακάτω: 

Σχήμα 4.1.α

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 
φακό (πίσω όψη)

 
 

 

Σχήμα 4.1.β

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 

φακό (δεξιά πλάγια 
όψη)
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Σχήμα 4.1.γ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 
φακό (μπροστινή 

όψη)

 
 
 

Σχήμα 4.1.δ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 
φακό (αριστερή 
πλάγια όψη)

 
 
 

Σχήμα 4.1.ε

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 
φακό (οροφή)
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Σχήμα 4.1.ζ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
από ευρυγώνιο 
φακό (πάτος)

 

4.2. Δημιουργία πανοράματος. 
 
Οι παραπάνω φωτογραφίες εισήχθησαν στο λογισμικό δημιουργίας 
πανοράματος Panoweaver,ώστε να γίνει η σύνθεση των, όπως φαίνεται 
παρακάτω: 

 

Σχήμα 24.

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Σύνθεση των 
φωτογραφιών στο 

Panoweaver

 
 

4.3. Εικονική περιήγηση του Βυζαντινού Μουσείου San 
Salvatore. 
 
Το σύνολο των πανοραμικών εικόνων που δημιουργήθηκαν όπως και η 
κάτοψη του Βυζαντινού Μουσείου, εισήχθησαν στο λογισμικό εικονικής 
περιήγησης Tourweaver: 
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Σχήμα 4.3α

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
στο πρόγραμμα 

Tourweaver 

 
 

Σχήμα 4.3β

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
στο πρόγραμμα 

Tourweaver 

 
 

Σχήμα 4.3γ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
στο πρόγραμμα 

Tourweaver 

 
 
 



Δημιουργία Εικονικού Μουσείου και Τρισδιάστατη Μοντελοποίηση Εκθεμάτων  
 

ΤΕΙ ΚΡΗΤΗΣ – Εργαστήριο Σχεδιομελέτης και Κατεργασιών  125

Σχήμα 4.3δ

Τ.Ε.Ι ΚΡΗΤΗΣ
ΤΜΗΜΑ

ΦΥΣΙΚΩΝ ΠΟΡΩΝ & ΠΕΡΙΒΑΛΛΟΝΤΟΣ
ΕΡΓΑΣΤΗΡΙΟ

ΣΧΕΔΙΟΜΕΛΕΤΗΣ & ΚΑΤΕΡΓΑΣΙΩΝ

ΒΕΖΥΡΑΚΗ ΕΥΑΓΓΕΛΙΑ
ΚΑΝΤΑΡΤΖΗ ΗΡΩ

Πανοραμική εικόνα 
στο πρόγραμμα 

Tourweaver 

 
 
 
Σε συνδυασμό με την εικονική περιήγηση του χώρου, επιπλέον προστέθηκαν 
hotspots με τη βοήθεια των οποίων ο θεατής έχει την δυνατότητα: 

 να ‘’μελετήσει’’ κάθε ένα από τα εκθέματα χωριστά ως προς τα 
χαρακτηριστικά του, την χρονολογία και τον τόπο εύρεσής του, 

 να μεταβεί σε μία επόμενη ή προηγούμενη πανοραμική εικόνα, 

 να διακόψει ή να ξεκινήσει την εικονική περιήγηση, 

 να αλλάξει την κατεύθυνση κίνησης της περιήγησης, 

 να προσθέσει ήχο ή εικόνα, 

 να μεταβεί στην αντίστοιχη θέση του χάρτη που απεικονίζει τον 
συγκεκριμένο χώρο. 
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ΚΕΦΑΛΑΙΟ 5:         
                                   ΠΑΡΑΤΗΡΗΣΕΙΣ-ΣΥΜΠΕΡΑΣΜΑΤΑ 
 
 
Τα προηγούμενα τέσσερα έτη,  τα λογισμικά Panoweaver και Tourweaver που 
εξυπηρετούν στην δημιουργία μιας εικονικής περιήγησης έχει εξυπηρετήσει 
χιλιάδες επαγγελματικούς  φωτογράφους , σχεδιαστές Internet, και 
προγραμματιστές παγκοσμίως. Σχεδιαστές Ιντερνετ μπορούν να 
προσελκύσουν περισσότερους επισκέπτες στην ιστοσελίδα τους, ενώ 
επόπτες αρχιτεκτονικής μπορούν να κερδίσουν και χρόνο και ενέργεια 
 κατά τη τεκμηρίωση ενός κτηρίου καθώς το Easypano δεν βάζει κανέναν 
περιορισμό ως προς τον χρόνο χρήσης ή τον αριθμό εικονικών περιηγήσεων 
που θα δημιουργηθούν. 
 
Τα πλεονεκτήματα της μεθόδου αυτής είναι η ικανότητα σύνθεσης των 
εικόνων με μεγάλη ακρίβεια, η πλήρης αποτύπωση και επεξεργασία του 
χώρου που απεικονίζει, είναι αρκετά εύκολο πρόγραμμα και οικονομικό.  
 
Εκτός από την δημιουργία πανοραμικής εικόνας και εικονικής περιήγησης 
στην συγκεκριμένη εργασία, πραγματοποιήθηκε ταυτόχρονη τρισδιάστατη 
μοντελοποίηση ορισμένων από τα εκθέματα του βυζαντινού μουσείου. Με τον 
τρόπο αυτό μπορεί να γίνει λεπτομερή εξέταση αυτών, καθώς με τη μέθοδο 
αυτή αντιγράφονται πιστά τα πραγματικά αρχαιολογικά ευρήματα, 
ολοκληρώνοντας έτσι την περιήγηση του θεατή ως προς τον χώρο που 
εξετάζεται. 
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